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Alphabetical Listing of CorelCAD Commands and Functions
AddCmdPoint command (CAD)
AddLayerToLayerGroup command (CAD)
ApplyMaterial command (CAD)
ApplyName
Arc3Points command (CAD)
ArcAngle command (CAD)
ArcCSE command (CAD)
ArcEllipse command (CAD)
ArcRSE command (CAD)
ArrowLine command (CAD)

BezierSegment command (CAD)
BezierCurve command (CAD)
Box command (CAD)

Chamfer command (CAD)
ChamferEdge command (CAD)
ChangeColor command (CAD)
Circle3Points command (CAD)
CircleDiameter command (CAD)
CircleRadius command (CAD)



CircularArray command (CAD)
CircularSweep command (CAD)
CombineLines command (CAD)
Cone command (CAD)
ConeDiameter command (CAD)
CountObject
Curve command (CAD)
Cylinder command (CAD)
CylinderDiameter command (CAD)

DeleteSelection command (CAD)
DimensionAngle command (CAD)
DimensionBaseline command (CAD)
DimensionContinuous command (CAD)
DimensionDiameter command (CAD)
DimensionLinear command (CAD)
DimensionRadius command (CAD)
Duplicate command (CAD)

EditCopy command (CAD)
EditCut command (CAD)
EditPaste command (CAD)
Ellipse command (CAD)
EllipticalCylinder command (CAD)
EllipticalFrustum command (CAD)
EllipticalFrustum command (CAD)
EndAddCmdPoint command (CAD)
Extend command (CAD)
Extrude command (CAD)
ExtrudeNormal command (CAD)

FileClose command (CAD)
FileCreateTemplate command (CAD)
FileExit command (CAD)
FileExport command (CAD)
FileImport command (CAD)
FileNew command (CAD)
FileNewFromTemplate command (CAD)
FileOpen command (CAD)
FileSave command (CAD)
Fillet command (CAD)
FilletEdgeMitered command (CAD)
FilletEdgeRound command (CAD)
Frustum command (CAD)



FrustumDiameter command (CAD)

GetName
GetTotalNumberObjects
Group command (CAD)

Hemisphere command (CAD)
HemisphereDiameter command (CAD)
HideEntireView command (CAD)
HideSectionView command (CAD)
HideSelected command (CAD)

IntersectingLine command (CAD)

JoinLines command (CAD)

LayerSetColor command (CAD)
LayerSetDescription command (CAD)
LayerSetLineStyle command (CAD)
LayerSetName command (CAD)
LayerSetStatus command (CAD)
LineSegment command (CAD)
LinearArray command (CAD)
Loft command (CAD)

Mirror command (CAD)
MirrorXY command (CAD)
MirrorXZ command (CAD)
MirrorYZ command (CAD)
MirrorNormal command (CAD)
Move command (CAD)
MultiPlane command (CAD)

NewLayer command (CAD)
NewLayerGroup command (CAD)

Offset command (CAD)

Parallel command (CAD)
PerpendicularPlane command (CAD)
Plane command (CAD)
PolygonCenter command (CAD)
PolygonEdge command (CAD)
PolygonalCylinder command (CAD)
PolygonalFrustum command (CAD)
PolygonalPyramid command (CAD)



PolyLine command (CAD)

Rectangle command (CAD)
RectangularFrustum (CAD)
RectangularPyramid (CAD)
Redo command (CAD)
Rotate command (CAD)
RotateNormal command (CAD)
RotateXAxis command (CAD)
RotateYAxis command (CAD)
RotateZAxis command (CAD)

Scale command (CAD)
SelectAll command (CAD)
SelectNext
SelectPointAt command (CAD)
SelectPrevious
SelectObject
SelectWithinRegion command (CAD)
SetCurrentLayer command (CAD)
SetEdgeRefinement command (CAD)
SetLightOff command (CAD)
SetLightOn command (CAD)
SetPointXYZ command (CAD)
SetSurfaceRefinement command (CAD)
SetUnits command (CAD)
SetVisible command (CAD)
ShadeEntireView command (CAD)
ShadeSectionView command (CAD)
ShadeSelected command (CAD)
Skin command (CAD)
SlicePlane command (CAD)
SolidAdd command (CAD)
SolidDefine command (CAD)
SolidExplode command (CAD)
SolidIntersect command (CAD)
SolidSubtract command (CAD)
Sphere command (CAD)
SphereDiameter command (CAD)
SphericalArray command (CAD)
SpiralArray command (CAD)
StartAddCmdPoint command (CAD)
Stretch2D command (CAD)
Stretch3D command (CAD)



SpiralSweep command (CAD)

Text2D command (CAD)
Text3D command (CAD)
TextLeader command (CAD)
ThreeDArray command (CAD)
TwoDArray command (CAD)
ThreeDSection command (CAD)
ThreeDSlice command (CAD)
ThreeDTrim command (CAD)
Torus command (CAD)
Trim command (CAD)
TrimBoth command (CAD)

Undo command (CAD)
Ungroup command (CAD)

WireFrame command (CAD)

ZoomToAll command (CAD)
ZoomToSelected command (CAD)
ZoomPrevious command (CAD)
ZoomIn command (CAD)
ZoomOut command (CAD)





.AddCmdPoint (CAD)

.AddCmdPoint .X=double, .Y=double, .Z=double

This command adds a command point to an existing object. The .AddCmdPoint command must be in a 
contiguous block of one or more .AddCmdPoint commands. The first .AddCmdPoint command in the block 
must be preceded by the .StartAddCmdPoint command, and the last must be followed by the
.EndAddCmdPoint command.

Syntax Description
.X Specifies the X-coordinate for the command point in the document's default unit of

measurement.
.Y Specifies the Y-coordinate for the command point in the document's default unit of

measurement.
.Z Specifies the Z-coordinate for the command point in the document's default unit of

measurement.

Note
You can use the .AddCmdPoint command for an existing object with start and end points.
If you are adding more than one command point, you must set the number of points in the

.StartAddCmdPoint command.

Example
REM units in inches
.StartAddCmdPoint 3
.AddCmdPoint 20.0, 0.0, 0.0
.AddCmdPoint 25.0, 10.0, 0.0
.AddCmdPoint 40.0, 10.0, 0.0
.EndAddCmdPoint

{button ,AL(`CAD_AddCmdPoint_Menu;cad_point;;;;',0,"Defaultoverview",)} Related Topics



.AddLayerToLayerGroup (CAD)

.AddLayerToLayerGroup .LayerName=string, GroupName=string

This command adds a layer to a layer group.

Syntax Description
.LayerName Specifies the name of the existing layer. 
.GroupName Specifies the name of the layer group.

Note
The layer name specified for .LayerName must not be part of the .GroupName. 

Example
.AddLayerToLayerGroup "layer 2" "mygroup"
The above example adds the layer called "layer 2" to the layer group called "mygroup".

{button ,AL(`CAD_AddLayerToLayerGroup_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related 
Topics



.ApplyMaterial (CAD)

.ApplyMaterial .Category=string, .Material=string

This command applies materials to the selected object(s).

Syntax Description
.Category Specifies the material category as follows:

Glass
Jewel
Metallic
Mineral
Miscellaneous
Others
Plastics
Woods

.Material Specifies the material. Click on the category to display a list of materials.
Glass
Jewel
Metallic
Mineral
Miscellaneous
Others
Plastics
Woods

Note
This command corresponds to the Material Roll-Up command on the Tools menu. Click Tools, Material Roll-

Up.
You can only apply materials to solids and surfaces.

Example
REM units in inches
.Box -1, -33.2181, 14.6993, 0.0, 36.3049, -41.6133, 80.6979
.ApplyMaterial "Metallic", "Bronze"
The above example creates a box and then applys the Bronze material from the Metallic category.

{button ,AL(`CAD_ApplyMaterial_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related Topics



.ApplyName (CAD)

.ApplyName .Name=string

This command applies a name to the selected object(s).

Syntax Description
.Name Specifies the name of the selected object.

Note
Multiple objects can have the same name.
An object must be selected before using this command.

Example
REM units in inches
.Box -1, -33.2181, 14.6993, 0.0, 36.3049, -41.6133, 80.6979
.SelectPointAt -25.633, -41.2995, 80.6979, 0
.ApplyName "Canada"

{button ,AL(`CAD_ApplyName_Menu;cad_name;;;;',0,"Defaultoverview",)} Related Topics



.Arc3Points (CAD)

.Arc3Points .SaveAsFlag=Integer, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2
=double, .x3=double, .y3=double, .z3=double

This command draws an arc through three points.

Syntax Description
.SaveAsFlag Specifies whether the arc is saved as a wire, surface center, or surface end points. 

Set to 0 to save the arc as a wire; set to 1 to save the arc as a surface center and 
set to 2 to save the arc as surface end points.

.x1 Specifies the X-coordinate for the first (starting point) of the arc in the document's 
default unit of measurement.

.y1 Specifies the Y-coordinate for the first and (starting point) of the arc in the 
document's default unit of measurement.

.z1 Specifies the Z-coordinate for the first and (starting point) of the arc in the 
document's default unit of measurement.

.x2 Specifies the X-coordinate for the second point of the arc in the document's 
default unit of measurement.

.y2 Specifies the Y-coordinate for the second point of the arc in the document's default
unit of measurement.

.z2 Specifies the Z-coordinate for the second point of the arc in the document's 
default unit of measurement.

.x3 Specifies the X-coordinate for the third (end point) of the arc in the document's 
default unit of measurement.

.y3 Specifies the Y-coordinate for the third (end point) of the arc in the document's 
default unit of measurement.

.z3 Specifies the Z-coordinate for the third (end point) of the arc in the document's 
default unit of measurement.

Note
This command corresponds to the Arc through 3 points command on the Arc flyout of the Draw menu. Click

Draw, Arc, Arc through 3 points.

Example
REM units in inches
.Arc3Points 0, -13, 6.0, -9.0, 5.0, 0.0, -12.0, 2.0, 0.0

{button ,AL(`CAD_Arc3Points_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.ArcAngle (CAD)

.ArcAngle .SaveAsFlag=Integer, .angle=double, .x1=double, .y1=double, .z1=double, .x2=double, .y
2=double, .z2=double

This command draws an arc according to the specified angle and two points.

Syntax Description
.SaveAsFlag Specifies whether the arc is saved as a wire, surface center, or surface end points. 

Set to 0 to save the arc as a wire; set to 1 to save the arc as a surface center and 
set to 2 to save the arc as surface end points.

.angle Specifies the angle of the arc in degrees.

.x1 Specifies the X-coordinate for the arc's center point in the document's default unit 
of measurement.

.y1 Specifies the Y-coordinate for the arc's center point in the document's default unit 
of measurement.

.z1 Specifies the Z-coordinate for the arc's center point in the document's default unit 
of measurement.

.x2 Specifies the X-coordinate for the arc's starting point in the document's default 
unit of measurement.

.y2 Specifies the Y-coordinate for the arc's starting point in the document's default unit
of measurement.

.z2 Specifies the Z-coordinate for the arc's starting point in the document's default 
unit of measurement.

Note
This command corresponds to the Arc Center, Start, Angle command on the Arc flyout of the Draw menu. 

Click Draw, Arc, Arc Center, Start, Angle .

Example
REM units in inches
.ArcAngle 0, 60, -30.0, -10.0, 0.0, 0.0, -10.0, 0.0

{button ,AL(`CAD_ArcAngle_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.ArcCSE (CAD)

.ArcCSE .SaveAsFlag=integer, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=do
uble, .x3=double, .y3=double, .z3=double

This command draws an arc determined by three points.

Syntax Description
.SaveAsFlag Specifies whether the arc is saved as a wire, surface center, or a surface end 

points. Set to 0 to save the arc as a wire; set to 1 to save the arc as a surface 
center and set to 2 to save the arc as surface end points.

.x1 Specifies the X-coordinate for the arc's center point in the document's default unit 
of measurement.

.y1 Specifies the Y-coordinate for the arc's center point in the document's default unit 
of measurement.

.z1 Specifies the Z-coordinate for the arc's center point in the document's default unit 
of measurement.

.x2 Specifies the X-coordinate for the arc's start point in the document's default unit of
measurement.

.y2 Specifies the Y-coordinate for the arc's start point in the document's default unit of
measurement.

.z2 Specifies the Z-coordinate for the arc's start point in the document's default unit of
measurement.

.x3 Specifies the X-coordinate for the arc's end point in the document's default unit of 
measurement.

.y3 Specifies the Y-coordinate for the arc's end point in the document's default unit of 
measurement.

.z3 Specifies the Z-coordinate for the arc's end point in the document's default unit of 
measurement.

Note
This command corresponds to the Arc Center, Start, End command on the Arc flyout of the Draw menu. 

Click Draw, Arc, Arc Center, Start, End.

Example
REM units in inches
.ArcCSE 2, -6.0, 1.5, 0.0, -4.0, 4.5, 0.0, -3.0, 3.5, 0.0

{button ,AL(`CAD_ArcCSE_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.ArcEllipse (CAD)

.ArcEllipse .SaveAsFlag=Integer, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=
double, .x3=double, .y3=double, .z3=double, .x4=double, .y4=double, .z4=double, .x5=double, .y5=
double, .z5=double

This command creates an ellipse arc.

Syntax Description
.SaveAsFlag Specifies whether the arc is saved as a wire, surface center, or surface end points. 

Set to the following:
0 to save the arc as a wire 
1 to save the arc as a surface center 
2 to save the arc as surface end points.

.x1 Specifies the X-coordinate of the ellipse arc's center point in the document's 
default units of measurement.

.y1 Specifies the Y-coordinate of the ellipse arc's center point in the document's 
default units of measurement.

.z1 Specifies the Z-coordinate of the ellipse arc's center point in the document's 
default units of measurement.

.x2 Specifies the X-coordinate for the first point used to determine the ellipse arc's 
radius in the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the first point used to determine the ellipse arc's 
radius in the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the first point used to determine the ellipse arc's 
radius in the document's default unit of measurement.

.x3 Specifies the X-coordinate for the second point used to determine the ellipse arc's 
radius in the document's default unit of measurement.

.y3 Specifies the Y-coordinate for the second point used to determine the ellipse arc's 
radius in the document's default unit of measurement.

.z3 Specifies the Z-coordinate for the second point used to determine the ellipse arc's 
radius in the document's default unit of measurement.

.x4 Specifies the X-coordinate for the start point of the ellipse arc in the document's 
default unit of measurement.

.y4 Specifies the Y-coordinate for the start point of the ellipse arc in the document's 
default unit of measurement.

.z4 Specifies the Z-coordinate for the start point of the ellipse arc in the document's 
default unit of measurement.

.x5 Specifies the X-coordinate for the end point of the ellipse arc in the document's 
default unit of measurement.

.y5 Specifies the Y-coordinate for the end point of the ellipse arc in the document's 
default unit of measurement.

.z5 Specifies the Z-coordinate for the end point of the ellipse arc in the document's 
default unit of measurement.

Note
This command corresponds to the Elliptical Arc command on the Arc flyout of the Draw menu. Click Draw, 

Arc, Elliptical Arc.

Example
REM units in inches
.ArcEllipse 0, -10.0, 10.0, 0.0, 0.0, 10.0, 0.0, -10.0, 15.0, 0.0, 0.0, 10.0, 0.0, 
-10.0, 20.0, 0.0

{button ,AL(`CAD_ArcEllipse_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics





.ArcRSE (CAD)

.ArcRSE .SaveAsFlag=Integer, .radius=double, .x1=double, .y1=double, .z1=double, .x2=double, .y2
=double, .z2=double, .x3=double, .y3=double, .z3=double

This command draws an arc according to the specified radius, start point, and end point.

Syntax Description
.SaveAsFlag Specifies whether the arc is saved as a wire, surface center, or surface end points. 

Set to the following:
0 to save the arc as a wire 
1 to save the arc as a surface center 
2 to save the arc as surface end points.

.radius Specifies the radius of the arc.

.x1 Specifies the X-coordinate of the arc's start point in the document's default unit of 
measurement.

.y1 Specifies the Y-coordinate of the arc's start point in the document's default unit of 
measurement.

.z1 Specifies the Z-coordinate of the arc's start point in the document's default unit of 
measurement.

.x2 Specifies the X-coordinate of the arc's end point in the document's default unit of 
measurement.

.y2 Specifies the Y-coordinate of the arc's end point in the document's default unit of 
measurement.

.z2 Specifies the Z-coordinate of the arc's end point in the document's default unit of 
measurement.

.x3 Specifies the X-coordinate for the point which determines which side of the start 
and end points the arc is to be formed in the document's default unit of 
measurement.

.y3 Specifies the Y-coordinate for the point which determines which side of the start 
and end points the arc is to be formed in the document's default unit of 
measurement.

.z3 Specifies the Z-coordinate for the point which determines which side of the start 
and end points the arc is to be formed in the document's default unit of 
measurement.

Note
This command corresponds to the Arc Radius, End Points on the Arc flyout of the Draw menu. Click Draw, 

Arc, Arc Radius, End Points.

Example
REM units in inches
.ArcRSE 1, 5,-9.0, 2.0, 0.0, -4.5, 3.5, 0.0, -3.0, -8.0, 0.0

{button ,AL(`CAD_ArcRSE_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.ArrowLine (CAD)

.ArrowLine .ArrowSize=double, .ArrowHead=integer

This command creates a line through preset points with an arrow on the last point. 

Syntax Description
.ArrowSize Specifies the size of the arrowhead.
.ArrowHead Sets the type of arrowhead to one of four types (1, 2, 3, 4).

Note
You must precede this command with either .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint or .SetPointXYZ.
This command corresponds to the Arrow Line command on the Line flyout of the Draw menu. Click Draw 

Line, Arrow Line.

Example
REM units in inches
.SetPointXYZ -12.0, 4.5, 0.0
.SetPointXYZ -2.0, 1.0, 0.0
.SetPointXYZ -0.5, 0.5, 0.0
.ArrowLine 10, 4

REM units in inches
.StartAddCmdPoint 4
.AddCmdPoint -85.3, 52.3, 0.0
.AddCmdPoint -37.4, 45.5, 0.0
.AddCmdPoint -27.0, 1.0, 0.0
.AddCmdPoint 6.3, 6.8, 0.0
.EndAddCmdPoint
.ArrowLine 10, 4
The first example creates an arrow using the .SetPointXYZ command. The second example uses
.StartAddCmdPoint, .AddCmdPoint, and .EndAddCmdPoint.

{button ,AL(`CAD_Arrow_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.BezierSegment (CAD)

.BezierSegment .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double, .x3=dou
ble, .y3=double, .z3=double, .x4=double, .y4=double, .z4=double

This command creates a Bezier line segment.

Syntax Description
.x1 Specifies the X-coordinate for the Bezier line segment's starting point in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the Bezier line segment's starting point in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the bezier line segment's starting point in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the Bezier line segment's second point in the 

document's default unit of measurement.
.y2 Specifies the Y-coordinate for the Bezier line segment's second point in the 

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the Bezier line segment's second point in the 

document's default unit of measurement.
.x3 Specifies the X-coordinate for the Bezier line segment's third point in the 

document's default unit of measurement.
.y3 Specifies the Y-coordinate for the Bezier line segment's third point in the 

document's default unit of measurement.
.z3 Specifies the Z-coordinate for the Bezier line segment's third point in the 

document's default unit of measurement.
.x4 Specifies the X-coordinate for the Bezier line segment's end point in the 

document's default unit of measurement.
.y4 Specifies the Y-coordinate for the Bezier line segment's end point in the 

document's default unit of measurement.
.z4 Specifies the Z-coordinate for the Bezier line segment's end point in the 

document's default unit of measurement.

Note
This command corresponds to the Bezier Segments command on the Curve flyout of the Draw menu. Click 

Draw, Curve, Bezier Segments.

Example
REM units in inches
.BezierSegment -15.0, 6.0, -7.5, 2.0, 0.0, -7.5, -8.0, 0.0, 0.0, -10.0, 0.0

{button ,AL(`CAD_BezierSegemnt_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.BezierCurve (CAD)

.BezierCurve 

This command creates a Bezier curve object. You must precede this command with the .SetPointXYZ and/or the
.StartAddCmdPoint, .AddCmdPoint, and .EndAddCmdPoint commands to create the points for the Bezier 
curve.

Example
REM units in inches
.StartAddCmdPoint 4
.AddCmdPoint 0.0, -10.0, 0.0
.AddCmdPoint 5.0, 0.0, 0.0
.AddCmdPoint 20.0, 0.0, 0.0
.AddCmdPoint 20.0, 0.0, 0.0
.EndAddCmdPoint
.SetPointXYZ -10.0, -10.0, 0.0
.SetPointXYZ -10.0, 0.0, 0.0
.BezierCurve

{button ,AL(`CAD_BezierCurve_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.Box (CAD)

.Box .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double
, x3=double, y3=double, z3=double, x4=double, y4=double, z4=double

This command creates a box.

Syntax Description
.SaveAsSolid Specifies whether the box is saved as a solid or a surface. Set to TRUE (-1) to save 

the box as a solid; set to FALSE (0) to save the box as a surface. The default 
setting is TRUE.

.x1 Specifies the X-coordinate for the starting point of the box in the document's 
default unit of measurement.

.y1 Specifies the Y-coordinate for the starting point of the box in the document's 
default unit of measurement.

.z1 Specifies the Z-coordinate for the starting point of the box in the document's 
default unit of measurement.

.x2 Specifies the X-coordinate for the second point (opposite corner for a 2 point box, 
width for a three point box) in the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the second point (opposite corner for a 2 point box, 
width for a three point box) in the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the second point (opposite corner for a 2 point box, 
width for a three point box) in the document's default unit of measurement.

.x3 Specifies the X-coordinate for the third point (length of a 3 point box) of the box in 
the document's default unit of measurement.

.y3 Specifies the Y-coordinate for the third point (length of a 3 point box) in the 
document's default unit of measurement.

.z3 Specifies the Z-coordinate for the third point (length of a 3 point box) in the 
document's default unit of measurement.

.x4 Specifies the X-coordinate for the fourth point (depth of a 3 point box) of the box in
the document's default unit of measurement.

.y4 Specifies the Y-coordinate for the fourth point (depth of a 3 point box) in the 
document's default unit of measurement.

.z4 Specifies the Z-coordinate for the fourth point (depth of a 3 point box) in the 
document's default unit of measurement.

Note
The third and fourth points are optional. If only 2 points are specified, the box is a 2 point box. If all four 

points are specified, the box is a 3 point box.
.SaveAsSolid is optional. If not specified, it is set to TRUE.

Example
REM units in inches
.Box -1, -14.5, 4.0, -1.5, -13.5, 3.0, -2.5
.Box -1, -15.0, -5.5, -10.0, 7.5, -5.5, -11.0, 4.0, -5.5, -11.0, 4.0, -10.0
The first example creates a 2 point box, and the second example creates a 3 point box.

{button ,AL(`CAD_Box_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.Chamfer (CAD)

.Chamfer .firstDistance=double, .secondDistance=double, .x1=double, .y1=double, .z1=double, .x2
=double, .y2=double, .z2=double

This command chamfers 2D line corners.

Syntax Description
.firstDistance Specifies the first distance in inches.
.secondDistance Specifies the second distance in inches.
.x1 Specifies the X-coordinate for the point located on the first of two adjacent lines in 

the document's default unit of measurement.
.y1 Specifies the Y-coordinate for the point located on the first of two adjacent lines in 

the document's default unit of measurement.
.z1 Specifies the Z-coordinate for the point located on the first of two adjacent lines in 

the document's default unit of measurement.
.x2 Specifies the X-coordinate for the point located on the second of two adjacent lines

in the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the point located on the second of two adjacent lines

in the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the point located on the second of two adjacent 

lines in the document's default unit of measurement.

Note
You must have drawn a 2D object before using this command.
This command corresponds to the Chamfer command on the Fillet flyout of the Transform menu. Click 

Transform, Fillet, Chamfer.

Example
REM units in inches
.Rectangle -1, -59.688, 49.6767, -29.5, -52.157, 45.463, -29.5
.Chamfer 1, 1, -54.9577, 45.3767, -29.5, -52.2194, 46.8948, -29.5
The example above creates a rectangle and then chamfers a corner.

{button ,AL(`CAD_Chamfer_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.ChamferEdge (CAD)

.ChamferEdge .firstDistance=double, .secondDistance=double, x1=double, x1=double, z1=double, 
x2=double, y2=double, z3=double

This command chamfers the edge of the 3D object.

Syntax Description
.firstDistance Specifies the first distance in inches.
.secondDistance Specifies the second distance in inches.
.x1 Specifies the X-coordinate for the point on the edge to be chamfered in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the point on the edge to be chamfered in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the point on the edge to be chamfered in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the point which determines the face of the object to 

be associated with the first distance in the document's default unit of 
measurement. The second point is used only if the first and second distances are 
not equal.

.y2 Specifies the Y-coordinate for the point which determines the face of the object to 
be associated with the first distance in the document's default unit of 
measurement. The second point is used only if the first and second distances are 
not equal.

.z2 Specifies the Z-coordinate for the point which determines the face of the object to 
be associated with the first distance in the document's default unit of 
measurement. The second point is used only if the first and second distances are 
not equal.

Note
This command corresponds to the Chamfer Edge command on the Fillet flyout of the Transform menu. Click

Transform, Fillet, Chamfer Edge.

Example
REM units in inches
.Box -1, -34.0, 61.0, -58.5, -29.0, 57.5, -62.0
.ChamferEdge 3, 3, -32.5, 65.0, -62.0
.Box -1, -34.0, 61.0, -58.5, -29.0, 57.5, -62.0
.ChamferEdge 3, 2, -32.5, 61.5, -62.0, -32.5, 61.5, -62.0
The first example has the first and second distances equal and only one point. In the second example, the first 
and second distances are not equal and the command requires two points. 

{button ,AL(`CAD_ChamferEdge_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.ChangeColor (CAD)

.ChangeColor .Red=integer, .Green=integer, .Blue=integer

This command changes the color of a selected object(s).

Syntax Description
.Red Specifies the command's red setting (RGB color model). Valid values range from 0 

to 255. 
.Green Specifies the command's green setting (RGB color model). Valid values range from

0 to 255.
.Blue Specifies the command's blue setting (RGB color model). Valid values range from 0

to 255.

Note
You must have selected an object before using this command.

Example
.ChangeColor 255, 0, 0
This example sets the color to red.

{button ,AL(`CAD_ChangeColor_Menu;;;;;',0,"Defaultoverview",)} Related Topics



.Circle3Points (CAD)

.Circle3Points .SaveAsSurface=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=doub
le, .z2=double, .x3=double, .y3=double, .z3=double

This command creates a circle based on the coordinates of three points.

Syntax Description
.SaveAsSurface Specifies whether the circle is saved as a surface or a wire. Set to TRUE (-1) to 

save the circle as surface; set to FALSE (0) to save as a wire.
.x1 Specifies the X-coordinate for the first point of the circle in the document's default 

unit of measurement.
.y1 Specifies the Y-coordinate for the first point of the circle in the document's default 

unit of measurement.
.z1 Specifies the Z-coordinate for the first point of the circle in the document's default 

unit of measurement.
.x2 Specifies the X-coordinate for the second point of the circle in the document's 

default unit of measurement.
.y2 Specifies the Y-coordinate for the second point of the circle in the document's 

default unit of measurement.
.z2 Specifies the Z-coordinate for the second point of the circle in the document's 

default unit of measurement.
.x3 Specifies the X-coordinate for the third point of the circle in the document's default

unit of measurement.
.y3 Specifies the Y-coordinate for the third point of the circle in the document's default

unit of measurement.
.z3 Specifies the Z-coordinate for the third point of the circle in the document's default

unit of measurement.

Note
This command corresponds to the 3 Points command on the Circle flyout of the Draw menu. Click Draw, 

Circle, 3 Points.

Example
REM units in inches
.Circle3Points -1, -18.0, 26.0, -23.0, -14.5, 24.0, 23.0, -15.0, 23.5, -23.0

{button ,AL(`CAD_Circle3Points_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.CircleDiameter (CAD)

.CircleDiameter .SaveAsSurface=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=do
uble, .z2=double

This command creates a circle based on diameter.

Syntax Description
.SaveAsSurface Specifies whether the circle is saved as a surface or a wire. Set to TRUE (-1) to 

save the circle as surface; set to FALSE (0) to save as a wire.
.x1 Specifies the X-coordinate for the first point of the circle's diameter in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point of the circle's diameter in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point of the circle's diameter in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point of the circle's diameter in the 

document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point of the circle's diameter in the 

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point of the circle's diameter in the 

document's default unit of measurement.

Example
REM units in inches
.CircleDiameter TRUE, -18.0, 26.0, -23.0, -14.5, 24.0, 23.0

{button ,AL(`CAD_CircleDiameter_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.CircleRadius (CAD)

.CircleRadius .SaveAsSurface=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=doubl
e, .z2=double

This command creates a circle based on the center point and the radius.

Syntax Description
.SaveAsSurface Specifies whether the circle is saved as a surface or a wire. Set to TRUE (-1) to 

save the circle as surface; set to FALSE (0) to save as a wire.
.x1 Specifies the X-coordinate of the circle's center in the document's default unit of 

measurement.
.y1 Specifies the Y-coordinate of the circle's center in the document's default unit of 

measurement.
.z1 Specifies the Z-coordinate of the circle's center in the document's default unit of 

measurement.
.x2 Specifies the X-coordinate of the circle's radius in the document's default unit of 

measurement.
.y2 Specifies the Y-coordinate of the circle's radius in the document's default unit of 

measurement.
.z2 Specifies the Z-coordinate of the circle's radius in the document's default unit of 

measurement.

Note
This command corresponds to the Center and Radius command on the Circle flyout of the Draw menu. 

Click Draw, Circle, Center and Radius.

Example
REM units in inches
.CircleRadius -1, -18.0, 22.5, -23.0, -14.0, 21.5, -23.0

{button ,AL(`CAD_CircleRadius_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.CircularArray (CAD)

.CircularArray .Copies=long, .angle=double, .RotateObjects=Boolean, .x1=double, .y1=double, .z1=
double, .x2=double, .y2=double, .z2=double, x3=double, y3=double, z3=double

This command duplicates an object(s) along the path of a circle.

Syntax Description
.Copies Specifies the number of copies.
.angle Specifies the angle of the circle (in degrees) the objects will cover when 

duplicated. For example, if 180 degrees is specified, the copies of the object(s) are
placed on the circle clockwise from 0 to 180 degrees creating a semicircle. If -180 
degrees is specified, the copies of the object(s) are placed on the circle 
counterclockwise from 0 to -180 degrees. This will create a semicircle on the 
bottom.

.RotateObjects Specifies whether the object(s) is rotated. Set to TRUE (-1) to rotate the object; set
to FALSE (0) to not rotate the object. If .RotateObjects is set to TRUE, the 
number of points required is one. The second point is optional. If .RotateObjects 
is set to FALSE, the number of points required is two and the third point is optional.

.x1 If .RotateObjects=TRUE, specifies the X-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.
If .RotateObjects=FALSE, specifies the X-coordinate for the base point in the 
document's default unit of measurement.

.y1 If .RotateObjects=TRUE, specifies the Y-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.
If .RotateObjects=FALSE, specifies the Y-coordinate for the base point in the 
document's default unit of measurement.

.z1 If .RotateObjects=TRUE, specifies the Z-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.
If .RotateObjects=FALSE, specifies the Z-coordinate for the base point in the 
document's default unit of measurement.

.x2 If .RotateObjects=TRUE, specifies the X-coordinate for the point that defines the 
direction of the axis in the document's default unit of measurement. If you do not 
specify the second point, it is assumed to be perpendicular to the current view. For
example, if you are in Top View, the second point is perpendicular to the z axis. 
If .RotateObjects=FALSE, specifies the X-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.

.y2 If .RotateObjects=TRUE, specifies the Y-coordinate for the point that defines the 
direction of the axis in the document's default unit of measurement. If you do not 
specify the second point, it is assumed to be perpendicular to the current view. For
example, if you are in Top View, the second point is perpendicular to the z axis. 
If .RotateObjects=FALSE, specifies the Y-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.

.z2 If .RotateObjects=TRUE, specifies the Z-coordinate for the point that defines the 
direction of the axis in the document's default unit of measurement. If you do not 
specify the second point, it is assumed to be perpendicular to the current view. For
example, if you are in Top View, the second point is perpendicular to the z axis. 
If .RotateObjects=FALSE, specifies the Z-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.

.x3 Specifies the X-coordinate for the point that defines the direction of the axis in the 
document's default unit of measurement.

.y3 Specifies the Y-coordinate for the point that defines the direction of the axis in the 
document's default unit of measurement.

.z3 Specifies the Z-coordinate for the point that defines the direction of the axis in the 
document's default unit of measurement.

Note



You must have drawn an object before using this command.
If .RotateObjects=FALSE and you do not select a base point (.x1, .y1, z1) on the body of the object, the 

object is rotated relative to the base point.
This command corresponds to the Circular Array command on the Array flyout of the Edit menu. Click Edit, 

Array, Circular Array.

Example
REM units in inches
.Box -1, -36.0, 64.0, -64.0, -34.5, 63.0, -65.5
.CircularArray 20, 360, -1, -30.0, 65.0, -65.5, -32.0, 74.0, -65.5
.Box -1, -36.0, 64.0, -64.0, -34.5, 63.0, -65.5
.CircularArray 20, 360, 0, -36.0, 63.0, -65.5, -29.5, 64.0, -65.5, -31.5, 72.5, -65.5
These two examples illustrate the difference in the parameters when .RotateObjects is set to TRUE (first 
example) and when .RotateObjects is set to FALSE (second example). In the first example, there are 2 points. 
In the second example, there are 3 points.

{button ,AL(`CAD_CircularArray_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.CircularSweep (CAD)

.CircularSweep .Copies=integer, .angle=double, .x1=double, .y1=double, .z1=double, .x2=double, .
y2=double, .z2=double, .SweepType=integer

This command sweeps a 2D object around an axis in a circle creating a 3D object

Syntax Description
.Copies Specifies the number of copies of the object.
.angle Specifies the angle of rotation in degrees.
.x1 Specifies the X-coordinate for the first point defining the axis in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the first point defining the axis in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the first point defining the axis in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the second point defining the axis in the document's

default unit of measurement.
.y2 Specifies the Y-coordinate for the second point defining the axis in the document's 

default unit of measurement.
.z2 Specifies the Z-coordinate for the second point defining the axis in the document's

default unit of measurement.
.SweepType Specifies the sweep type. Set to 0 for Continuous, set to 1 for Discrete.

Note
You must select an object before using this command.
The object selected must be a 2D object.
This command corresponds to the Circular Sweep command on the Extrude flyout of the Draw menu. Click 

Draw, Extrude, Circular Sweep.

Example
REM units in inches
.Rectangle -1, -33.0, 68.0, -67.5, -30.0, 66.5, -67.5, -31.0, 65.0, -67.5
.CircularSweep 20, 360, -27.5, 68.0, -67.5, -27.5, 72.0, -67.5
The above example creates a rectangle and then sweeps 20 copies of the rectangle in a circle 360 degrees 
around the axis specified by the two points.

{button ,AL(`CAD_CircularSweep_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.CombineLines (CAD)

.CombineLines .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command combines two lines into one line. 

Syntax Description
.x1 Specifies the X-coordinate for the point that selects the first line in the document's

default unit of measurement.
.y1 Specifies the Y-coordinate for the point that selects the first line in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the point that selects the first line in the document's

default unit of measurement.
.x2 Specifies the X-coordinate for the point that selects the second line in the 

document's default unit of measurement.
.y2 Specifies the Y-coordinate for the point that selects the second line in the 

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the point that selects the second line in the 

document's default unit of measurement.

Note
The endpoints of the two lines must be at the same location.
This command corresponds to the Combine command on the Join Lines flyout of the Transform menu. Click 

Transform, Join Lines, Combine.

Example
REM units in inches
.SetPointXYZ -105.169, 33.0232, 0.0
.SetPointXYZ -47.8601, -16.9682, 0.0
.LineSegment
.SetPointXYZ -47.8601, -16.9682, 0.0
.SetPointXYZ -39.5749, 53.667, 0.0
.LineSegment
.CombineLines -69.3919, 2.25158, 0.0, -44.2062, 13.0848, 0.0
The above example creates two lines with end points at the same location and then combines the lines.

{button ,AL(`CAD_CombineLines_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Cone (CAD)

.Cone .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=do
uble, .x3=double, .y3=double, .z3=double

This command creates a cone based on the coordinates of the three points.

Syntax Description
.SaveAsSolid Specifies whether the cone is saved as a solid or a surface. Set to TRUE (-1) to 

save the cone as a solid; set to FALSE (0) to save the cone as a surface.
.x1 Specifies the X-coordinate for the center of the cone's base in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the center of the cone's base in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the center of the cone's base in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the edge of the cone in the document's default unit 

of measurement.
.y2 Specifies the Y-coordinate for the edge of the cone in the document's default unit 

of measurement.
.z2 Specifies the Z-coordinate for the edge of the cone in the document's default unit 

of measurement.
.x3 Specifies the X-coordinate for the height of the cone in the document's default unit

of measurement.
.y3 Specifies the Y-coordinate for the height of the cone in the document's default unit

of measurement.
.z3 Specifies the Z-coordinate for the height of the cone in the document's default unit

of measurement.

Note
This command corresponds to the Cone, Center and Radius command on the Solids flyout of the Draw 

menu. Click Draw, Solids, Cone, Center and Radius.

Example
REM units in inches
.Cone -1, -30.5, 68.5, -67.5, -28.5, 69.0, -67.5, -31.5, 78.0, -67.5

{button ,AL(`CAD_Cone_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.ConeDiameter (CAD)

.ConeDiameter .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=doubl
e, .z2=double, .x3=double, .y3=double, .z3=double

This command creates a cone based on the diameter set by two points and the height set by the third point.

Syntax Description
.SaveAsSolid Specifies whether the cone is saved as a solid or a surface. Set to TRUE (-1) to 

save the cone as a solid; set to FALSE (0) to save the cone as a surface.
.x1 Specifies the X-coordinate for the first point that determines the cone's diameter 

in the document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point that determines the cone's diameter in

the document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point that determines the cone's diameter 

in the document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point that determines the cone's 

diameter in the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point that determines the cone's 

diameter in the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point that determines the cone's 

diameter in the document's default unit of measurement.
.x3 Specifies the X-coordinate for the height of the cone in the document's default unit

of measurement.
.y3 Specifies the Z-coordinate for the height of the cone in the document's default unit

of measurement.
.z3 Specifies the Z-coordinate for the height of the cone in the document's default unit

of measurement.

Example
REM units in inches
.ConeDiameter 0, -29.0, 71.5, -67.5, 26.0, 72.5, -67.5, -28.0, 78.0, -67.5

{button ,AL(`CAD_ConeDiameter_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.CountObject (CAD)
ReturnValue& = .CountObject .Name=string

This command counts all of the objects with the specified name and returns the number of objects.

Syntax Description
ReturnValue& Specifies the numeric variable that is passed the return value corresponding to the

number of objects. This variable must be declared using a DIM statement or 
implicitly declared using a type-declaration suffix.

.Name Specifies the name of the objects to count.

Note
You must have named objects before using this command.

Example
REM units in inches
.Torus -1, -9.0, -0.5, 0.0, -7.0, -2.0, 0.0, -8.0, -1.0, 0.0, -7.5, -1.5, 0.0
.SelectPointAt -9.0, -0.5, 0.0
.ApplyName "Torusname"
CountTs& = .CountObject "Torusname"
This example creates a torus, selects a point on the torus and applies a name. The torus is then scaled; and a 
the scaled version is placed in a different location. A pyramid is drawn and finally all objects with name 
"Torusname" are selected.
The variable CountTs is passed the number of objects named "Torusname".

{button ,AL(`CAD_CountObject_Menu;cad_name;;;;',0,"Defaultoverview",)} Related Topics



.Curve (CAD)

.Curve 

This command creates a curve object. 

Note
This command must be preceded by the .StartAddCmdPoint, .AddCmdPoint, and .EndAddCmdPoint 

or .SetPointXYZ.
This command corresponds to the Curve command on the Curve flyout of the Draw menu. Click Draw, 

Curve, Curve.

Example
REM units in inches
.StartAddCmdPoint 4
.AddCmdPoint 0.0, -10.0, 0.0
.AddCmdPoint 5.0, 0.0, 0.0
.AddCmdPoint 20.0, 0.0, 0.0
.AddCmdPoint 20.0, 0.0, 0.0
.EndAddCmdPoint
.SetPointXYZ -10.0, -10.0, 0.0
.SetPointXYZ -10.0, 0.0, 0.0
.Curve

{button ,AL(`CAD_Curve_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.Cylinder (CAD)

.Cylinder .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=
double, .x3=double, .y3=double, .z3=double

This command creates a cylinder.

Syntax Description
.SaveAsSolid Specifies whether the cylinder is saved as a solid or a surface. Set to TRUE (-1) to 

save the cylinder as a solid; set to FALSE (0) to save the cylinder as a surface.
.x1 Specifies the X-coordinate for the center of the cylinder in the document's default 

unit of measurement.
.y1 Specifies the Y-coordinate for the center of the cylinder in the document's default 

unit of measurement.
.z1 Specifies the Z-coordinate for the center of the cylinder in the document's default 

unit of measurement.
.x2 Specifies the X-coordinate for the radius of the cylinder in the document's default 

unit of measurement.
.y2 Specifies the Y-coordinate for the radius of the cylinder in the document's default 

unit of measurement.
.z2 Specifies the Z-coordinate for the radius of the cylinder in the document's default 

unit of measurement.
.x3 Specifies the X-coordinate for the plane (height) of the cylinder in the document's 

default unit of measurement.
.y3 Specifies the Y-coordinate for the plane (height) of the cylinder in the document's 

default unit of measurement.
.z3 Specifies the Z-coordinate for the plane (height) of the cylinder in the document's 

default unit of measurement.

Note
This command corresponds to the Cylinder, Center and Radius command on the Solids flyout of the Draw 

menu. Click Draw, Solids, Cylinder, Center and Radius.

Example
REM units in inches
.Cylinder -1, -7.0, 1.5, 0.0, 3.5, 1.5, 0.0, -3.0, -6.0, 0.0

{button ,AL(`CAD_Cylinder_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.CylinderDiameter (CAD)

.CylinderDiameter .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=do
uble, .z2=double, .x3=double, .y3=double, .z3=double

This command creates a cylinder.

Syntax Description
.SaveAsSolid Specifies whether the cylinder is saved as a solid or a surface. Set to TRUE (-1) to 

save the cylinder as a solid; set to FALSE (0) to save the cylinder as a surface.
.x1 Specifies the X-coordinate for the first point that determines the diameter of the 

cylinder in the document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point that determines the diameter of the 

cylinder in the document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point that determines the diameter of the 

cylinder in the document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point that determines the diameter of 

the cylinder in the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point that determines the diameter of the

cylinder in the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point that determines the diameter of 

the cylinder in the document's default unit of measurement.
.x3 Specifies the X-coordinate for the plane (height) of the cylinder in the document's 

default unit of measurement.
.y3 Specifies the Y-coordinate for the plane (height) of the cylinder in the document's 

default unit of measurement.
.z3 Specifies the Z-coordinate for the plane (height) of the cylinder in the document's 

default unit of measurement.

Example
REM units in inches
.CylinderDiameter -1, -10.0, 5.0, 0.0, -7.5, 4.5, 0.0, -8.5, -1.0, 0.0

{button ,AL(`CAD_CylinderDiameter_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.DeleteSelection (CAD)

.DeleteSelection 

This command deletes the selected objects.

Note
You must have selected objects before using this command.
If you want to cut an object and place it on the clipboard, use .EditCut.

Example
REM units in inches
.Box -1, -14.5, 4.0, -1.5, -13.5, 3.0, -2.5
.Cylinder -1, -7.0, 1.5, 0.0, 3.5, 1.5, 0.0, -3.0, -6.0, 0.0
.SelectWithinRegion -16.0, 4.0, 0.0, 4.0, -9.5, 0.0
.DeleteSelection
If you create a script identical to the example, you will not be able to see the result. The objects will have been 
created, selected and deleted. To see how the command works, you should create two scripts. The first one 
containing the .Box and .Cylinder commands and the second one containing the .SelectWithinRegion and
.DeleteSelection commands.

{button ,AL(`CAD_DeleteSelection_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.DimensionAngle (CAD)

.DimensionAngle . .Dynamic=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double
, .z2=double, .x3=double, .y3=double, .z3=double, .x4=double, .y4=double, .z4=double

This command draws an angular dimension line determined by the position of four points

Syntax Description
.Dynamic Specifies whether the dimension line is dynamic or static. Set to TRUE (-1) to make

the dimension line dynamic, set to FALSE (0) to make the dimension line static.
.x1 Specifies the X-coordinate for the first point that, with points 2 and 3, determines 

the angle value in the document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point that, with points 2 and 3, determines 

the angle value in the document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point that, with points 2 and 3, determines 

the angle value in the document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point that, with points 1 and 3, 

determines the angle value in the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point that, with points 1 and 3, 

determines the angle value in the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point that, with points 1 and 3, 

determines the angle value in the document's default unit of measurement.
.x3 Specifies the X-coordinate for the third point that, with points 1 and 2, determines 

the angle value in the document's default unit of measurement.
.y3 Specifies the Y-coordinate for the third point that, with points 1 and 2, determines 

the angle value in the document's default unit of measurement.
.z3 Specifies the Z-coordinate for the third point that, with points 1 and 2, determines 

the angle value in the document's default unit of measurement.
.x4 Specifies the X-coordinate for the point that determines the dimension line's 

location in the document's default unit of measurement.
.y4 Specifies the Y-coordinate for the point that determines the dimension line's 

location in the document's default unit of measurement.
.z4 Specifies the Z-coordinate for the point that determines the dimension line's 

location in the document's default unit of measurement.

Note
This command corresponds to the Angle command on the Dimension menu. Click Dimension, Angle.

Example
REM units in inches
.DimensionAngle -1, -8.5, 5.0, 0.0, -4.0, 3.0, 0.0, -7.5, 1.0, 0.0, -7.5, 2.5, 0.0

{button ,AL(`CAD_DimensionAngle_Menu;cad_dimenmenu;;;;',0,"Defaultoverview",)} Related Topics



.DimensionBaseline (CAD)

.DimensionBaseline .Dynamic=Boolean, .Direction=integer

This command draws baseline dimension lines with spans of up to 200.

Syntax Description
.Dynamic Specifies whether the dimension line is dynamic or static. Set to TRUE (-1) to make

the dimension line dynamic; set to FALSE (0) to make the dimension line static.
.Direction Specifies the direction of the baseline dimension.

0 x direction
1 y direction
2 z direction

Note
Command points have to be set in advance using .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint. The last point specifies the location of the text.
This command corresponds to the Continuous Baseline command on the Dimension menu. Click 

Dimension, Continuous Baseline.

Example
REM units in inches
.StartAddCmdPoint 3
.AddCmdPoint -11.0, 5.0, 0.0
.AddCmdPoint -6.0, 2.5, 0.0
.AddCmdPoint -6.0, -1.0, 0.0
.EndAddCmdPoint
.DimensionBaseline -1, 0
The above example sets three command points and then creates a baseline dimension line. The text is displayed
at the last point.

{button ,AL(`CAD_DimensionBaseline_Menu;cad_dimenmenu;;;;',0,"Defaultoverview",)} Related 
Topics



.DimensionContinuous (CAD)

.DimensionContinuous .Dynamic=Boolean, .Direction=integer

This command draws continuous dimension lines.

Syntax Description
.Dynamic Specifies whether the dimension line is dynamic or static. Set to TRUE (-1) to make

the dimension line dynamic; set to FALSE (0) to make the dimension line static.
.Direction Specifies the direction of the continuous dimension.

0 x direction
1 y direction
2 z direction

Note
Command points have to be set in advance using .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint. The last point specifies the location of the text.
This command corresponds to the Continuous Linear command on the Dimension menu. Click Dimension, 

Continuous Linear.

Example
REM units in inches
.StartAddCmdPoint 3
.AddCmdPoint -9.5, 5.5, 0.0
.AddCmdPoint -5.0, 3.5, 0.0
.AddCmdPoint -5.0, -2.0, 0.0
.EndAddCmdPoint
.DimensionContinuous -1,0
The above example sets three command points and then creates a Continuous dimension line. The text is 
displayed at the last point.

{button ,AL(`CAD_DimensionContinuous_Menu;cad_dimenmenu;;;;',0,"Defaultoverview",)} Related 
Topics



.DimensionDiameter (CAD)

.DimensionDiameter .Dynamic=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=dou
ble, .z2=double

This command draws a dimension line along the diameter of a circle.

Syntax Description
.Dynamic Specifies whether the dimension line is dynamic or static. Set to TRUE (-1) to make

the dimension line dynamic; set to FALSE (0) to make the dimension line static.
.x1 Specifies the X-coordinate for the point lying on the circle edge in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the point lying on the circle edge in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the point lying on the circle edge in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the point that determines the location of the text in 

the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the point that determines the location of the text in 

the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the point that determines the location of the text in 

the document's default unit of measurement.

Note
You must have drawn a circle before using this command.
This command corresponds to the Diameter command on the Dimension menu. Click Dimension, Diameter

Example
REM units in inches
.CircleDiameter 0, -13.0, 12.0, -8.0, -9.0, 7.5, -12.5
.DimensionDiameter -1, -9.0, 7.5, -12.5, -8.0, 7.0, -12.5
This command creates a dimension line along the diameter of the circle. You do not have to use
.CircleDiameter command to create the circle. Any of the circle commands or CorelCAD tools can be used.

{button ,AL(`CAD_DimensionDiameter_Menu;cad_dimenmenu;;;;',0,"Defaultoverview",)} Related 
Topics



.DimensionLinear (CAD)

.DimensionLinear .Dynamic=Boolean, .Direction=integer, .x1=double, .y1=double, .z1=doueble, .x2
=double, .y2=double, .z2=double, .x3=double, .y3=double, .z3=double

This command draws linear dimension lines.

Syntax Description
.Dynamic Specifies whether the dimension line is dynamic or static. Set to TRUE (-1) to make

the dimension line dynamic; set to FALSE (0) to make the dimension line static.
.Direction Specifies the direction of the linear dimension.

0 x direction
1 y direction
2 z direction
3 freehand
4 ortho

.x1 Specifies the X-coordinate for the first point that determines the length of the 
dimension line in the document's default unit of measurement.

.y1 Specifies the Y-coordinate for the first point that determines the length of the 
dimension line in the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the first point that determines the length of the 
dimension line in the document's default unit of measurement.

.x2 Specifies the X-coordinate for the second point that determines the length of the 
dimension line in the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the second point that determines the length of the 
dimension line in the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the second point that determines the length of the 
dimension line in the document's default unit of measurement.

.x3 Specifies the X-coordinate that determines the location of the dimension line in the
document's default unit of measurement. 

.y3 Specifies the Y-coordinate that determines the location of the dimension line in the
document's default unit of measurement.

.z3 Specifies the Z-coordinate that determines the location of the dimension line in the
document's default unit of measurement.

Note
This command corresponds to the Free, X Linear, Y Linear, Z Linear and Ortho commands on the 

Dimension menu. The different settings for the .Direction parameter equate to the commands on the menu. 

Example
REM units in inches
.Box -1, -14.0, 15.5, -12.5, -10.0, 13.0, -16.5
.DimensionLinear -1, 3, -14.0, 15.5, -12.5, -14.0, 15.5, -14.5, -17.0, 15.0, -14.5
This example creates a linear dimension line. The .Direction parameter is set to Free (3) and corresponds to the
Free command on the Dimension menu.

.Box -1, -14.0, 15.5, -12.5, -10.0, 13.0, -16.5

.DimensionLinear -1, 0, -12.0, 15.5, -12.5, -12.5, -9.5, 18.0, -12.5
The .Direction parameter is set to X (0) and corresponds to the X Linear command on the Dimension menu.

{button ,AL(`CAD_DimensionLinear_Menu;cad_dimenmenu;;;;',0,"Defaultoverview",)} Related Topics



.DimensionRadius (CAD)

.DimensionRadius .Dynamic=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double
, .z2=double

This command draws a dimension line along the radius of a circle.

Syntax Description
.Dynamic Specifies whether the dimension line is dynamic or static. Set to TRUE (-1) to make

the dimension line dynamic; set to FALSE (0) to make the dimension line static.
.x1 Specifies the X-coordinate for the point lying on the circle edge in the document's 

default unit of measurement. 
.y1 Specifies the Y-coordinate for the point lying on the circle edge in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the point lying on the circle edge in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the point that determines the location of the text in 

the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the point that determines the location of the text in 

the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the point that determines the location of the text in 

the document's default unit of measurement.

Note
This command corresponds to the Radius command on the Dimension menu. Click Dimension, Radius.
You must have drawn a circle before using this command.

Example
REM units in inches
.Circle3Points 0, -16.0, 14.0, -12.5, -12.0, 13.0, -12.5, -12.0, 13.5, -12.5
.DimensionRadius -1, -16.0, 14.0, -12.5, -15.5, 12.0, -12.5
This command creates a dimension line along the radius of the circle. You do not have to use .Circle3Points 
command to create the circle. Any of the circle commands or CorelCAD tools can be used.

{button ,AL(`CAD_DimensionRadius_Menu;cad_dimenmenu;;;;',0,"Defaultoverview",)} Related 
Topics



.Duplicate (CAD)

.Duplicate 

This command duplicates selected objects.

Note
You must have selected an object(s) before running this command.
The duplicate is offset from the original at the distance specified in the Units & Angles dialog box. Click 

Tools, Layout, Units and Angle.
This command corresponds to the Duplicate command on the Edit menu. Click Edit, Duplicate.

Example
REM units in inches
.Box -1, -14.5, 4.0, -1.5, -13.5, 3.0, -2.5
.Cylinder -1, -7.0, 1.5, 0.0, 3.5, 1.5, 0.0, -3.0, -6.0, 0.0
.SelectWithinRegion -16.0, 4.0, 0.0, 4.0, -9.5, 0.0
.Duplicate
The above example creates a box and a cylinder, selects them and then duplicates them.

{button ,AL(`CAD_Duplicate_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.EditCopy (CAD)

.EditCopy 

This command copies the selected object(s) to the Clipboard.

Note
An object must be selected before using this command.
This command corresponds to the Copy command on the Edit menu. Click Edit, Copy.

Example
REM units in inches
.Box -1, -14.5, 4.0, -1.5, -13.5, 3.0, -2.5
.Cylinder -1, -7.0, 1.5, 0.0, 3.5, 1.5, 0.0, -3.0, -6.0, 0.0
.SelectWithinRegion -16.0, 4.0, 0.0, 4.0, -9.5, 0.0
.EditCopy
The above example creates a box and a cylinder, selects them, and copies them to the clipboard.

{button ,AL(`CAD_EditCopy_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.EditCut (CAD)

.EditCut 

This command cuts the selected object(s) from the document and copies it to the Clipboard.

Note
An object must be selected before using this command.
If you want to cut an object without placing it on the clipboard, use .DeleteSelection.
This command corresponds to the Cut command on the Edit menu. Click Edit, Cut.

Example
REM units in inches
.Box -1, -14.5, 4.0, -1.5, -13.5, 3.0, -2.5
.Cylinder -1, -7.0, 1.5, 0.0, 3.5, 1.5, 0.0, -3.0, -6.0, 0.0
.SelectWithinRegion -16.0, 4.0, 0.0, 4.0, -9.5, 0.0
.EditCut
The above example creates a box and a cylinder, selects them and then cuts them. The cut objects are placed 
on the clipboard.

{button ,AL(`CAD_EditCut_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.EditPaste (CAD)

.EditPaste .X=double, .Y=double, .Z=double

This command pastes the object(s) from the Clipboard to a location determined by the coordinates of one point. 

Syntax Description
.X Specifies the X-coordinate for the location point in the document's default unit of 

measurement.
.Y Specifies the Y-coordinate for the location point in the document's default unit of 

measurement.
.Z Specifies the Z-coordinate for the location point in the document's default unit of 

measurement.

Note
You must have used the .EditCopy command to copy object(s) to the Clipboard before using .EditPaste.
This command corresponds to the Paste command on the Edit menu. Click Paste, Copy.

Example
REM units in inches
.Box -1, -14.5, 4.0, -1.5, -13.5, 3.0, -2.5
.Cylinder -1, -7.0, 1.5, 0.0, 3.5, 1.5, 0.0, -3.0, -6.0, 0.0
.SelectWithinRegion -16.0, 4.0, 0.0, 4.0, -9.5, 0.0
.EditCut
.EditPaste 2.0, -0.5, 0.0
The above example creates a box and a cylinder, selects them and then cuts them. The cut objects are placed 
on the clipboard. Then the objects are pasted at the location specified by the coordinates.

{button ,AL(`CAD_EditPaste_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.Ellipse (CAD)

.Ellipse .SaveAsSurface=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2
=double, .x3=double, .y3=double, .z3=double

This command creates an ellipse based on the coordinates of three points.

Syntax Description
.SaveAsSurface Specifies whether the ellipse is saved as a surface or a wire. Set to TRUE (-1) to 

save as a surface; set to FALSE (0) to save as a wire.
.x1 Specifies the X-coordinate for the center of the ellipse in the document's default 

unit of measurement.
.y1 Specifies the Y-coordinate for the center of the ellipse in the document's default 

unit of measurement.
.z1 Specifies the Z-coordinate for the center of the ellipse in the document's default 

unit of measurement.
.x2 Specifies the X-coordinate for the first radius in the document's default unit of 

measurement.
.y2 Specifies the Y-coordinate for the first radius in the document's default unit of 

measurement.
.z2 Specifies the Z-coordinate for the first radius in the document's default unit of 

measurement.
.x3 Specifies the X-coordinate for the second radius in the document's default unit of 

measurement.
.y3 Specifies the Y-coordinate for the second radius in the document's default unit of 

measurement.
.z3 Specifies the Z-coordinate for the second radius in the document's default unit of 

measurement.

Note
This command corresponds to the Ellipse command on the Draw menu. Click Draw, Ellipse.

Example
REM units in inches
.Ellipse 0, -8.5, 3.0, 0.0, -2.5, 1.5, 0.0, -5.5, 1.5, 0.0

{button ,AL(`CAD_Ellipse_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.EllipticalCylinder (CAD)

.EllipticalCylinder .SaveAsSurface=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=d
ouble, .z2=double, .x3=double, .y3=double, .z3=double, x4=double, y4=double, z4=double

This command creates an elliptical cylinder.

Syntax Description
.SaveAsSolid Specifies whether the elliptical cylinder is saved as a solid or a surface. Set to 

TRUE (-1) to save as a solid; set to FALSE (0) to save as a surface.
.x1 Specifies the X-coordinate for the center of the base in the document's default unit

of measurement.
.y1 Specifies the Y-coordinate for the center of the base in the document's default unit

of measurement.
.z1 Specifies the Z-coordinate for the center of the base in the document's default unit

of measurement.
.x2 Specifies the X-coordinate for the first radius in the document's default unit of 

measurement.
.y2 Specifies the Y-coordinate for the first radius in the document's default unit of 

measurement.
.z2 Specifies the Z-coordinate for the first radius in the document's default unit of 

measurement.
.x3 Specifies the X-coordinate for the second radius in the document's default unit of 

measurement.
.y3 Specifies the Y-coordinate for the second radius in the document's default unit of 

measurement.
.z3 Specifies the Z-coordinate for the second radius in the document's default unit of 

measurement.
.x4 Specifies the X-coordinate for the height in the document's default unit of 

measurement.
.y4 Specifies the Y-coordinate for the height in the document's default unit of 

measurement.
.z4 Specifies the Z-coordinate for the height in the document's default unit of 

measurement.

Example
REM units in inches
.EllipticalCylinder -1, -9.0, 4.0, -1.5, -5.5, 3.5, -1.5, -5.5, 3.5, -2.5, -5.5, 8.0-2.5

{button ,AL(`CAD_EllipticalCylinder_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.EllipticalCone (CAD)

.EllipticalCone .SaveAsSurface=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=dou
ble, .z2=double, .x3=double, .y3=double, .z3=double, x4=double, y4=double, z4=double

This command creates an elliptical cone.

Syntax Description
.SaveAsSolid Specifies whether the elliptical cylinder is saved as a solid or a surface. Set to 

TRUE (-1) to save as a solid; set to FALSE (0) to save as a surface.
.x1 Specifies the X-coordinate for the center of the base in the document's default unit

of measurement.
.y1 Specifies the Y-coordinate for the center of the base in the document's default unit

of measurement.
.z1 Specifies the Z-coordinate for the center of the base in the document's default unit

of measurement.
.x2 Specifies the X-coordinate for the first radius in the document's default unit of 

measurement.
.y2 Specifies the Y-coordinate for the first radius in the document's default unit of 

measurement.
.z2 Specifies the Z-coordinate for the first radius in the document's default unit of 

measurement.
.x3 Specifies the X-coordinate for the second radius in the document's default unit of 

measurement.
.y3 Specifies the Y-coordinate for the second radius in the document's default unit of 

measurement.
.z3 Specifies the Z-coordinate for the second radius in the document's default unit of 

measurement.
.x4 Specifies the X-coordinate for the height in the document's default unit of 

measurement.
.y4 Specifies the Y-coordinate for the height in the document's default unit of 

measurement.
.z4 Specifies the Z-coordinate for the height in the document's default unit of 

measurement.

Example
REM units in inches
.EllipticalCone -1, -4.5, -17.0, 17.0, 0.5, -15.5, 17.0, 1.0, -17.0, 17.0, 1.0, -17.0, 24.5

{button ,AL(`CAD_EllipticalCone_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.EllipticalFrustum (CAD)

.EllipticalFrustum .SaveAsSurface=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=d
ouble, .z2=double, .x3=double, .y3=double, .z3=double, x4=double, y4=double, z4=double, 
x5=double, y5=double, z5=double

This command creates an elliptical frustum.

Syntax Description
.SaveAsSolid Specifies whether the elliptical frustum is saved as a solid or a surface. Set to 

TRUE (-1) to save as a solid; set to FALSE (0) to save as a surface.
.x1 Specifies the X-coordinate for the center of the base in the document's default unit

of measurement.
.y1 Specifies the Y-coordinate for the center of the base in the document's default unit

of measurement.
.z1 Specifies the Z-coordinate for the center of the base in the document's default unit

of measurement.
.x2 Specifies the X-coordinate for the first radius in the document's default unit of 

measurement.
.y2 Specifies the Y-coordinate for the first radius in the document's default unit of 

measurement.
.z2 Specifies the Z-coordinate for the first radius in the document's default unit of 

measurement.
.x3 Specifies the X-coordinate for the second radius in the document's default unit of 

measurement.
.y3 Specifies the Y-coordinate for the second radius in the document's default unit of 

measurement.
.z3 Specifies the Z-coordinate for the second radius in the document's default unit of 

measurement.
.x4 Specifies the X-coordinate for the height in the document's default unit of 

measurement.
.y4 Specifies the Y-coordinate for the height in the document's default unit of 

measurement.
.z4 Specifies the Z-coordinate for the height in the document's default unit of 

measurement.
.x5 Specifies the X-coordinate for the scale of top in the document's default unit of 

measurement.
.y5 Specifies the Y-coordinate for the scale of the top in the document's default unit of 

measurement.
.z5 Specifies the Z-coordinate for the scale of the top in the document's default unit of

measurement.

Example
REM units in inches
.EllipticalFrustum -1, -13.5, 11.5, -12.5, -11.0, 11.5, -12.5, -13.5, 15.5, -12.5, 
-12.0, 15.0, -12.5, -13.0, 17.5, -12.5

{button ,AL(`CAD_EllipticalFrustum_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.EndAddCmdPoint (CAD)

.EndAddCmdPoint 

This command specifies the end point for a group of set points. 

Note
This command must be preceded by the .StartAddCmdPoint, and .AddCmdPoint commands.

Example
REM units in inches
.StartAddCmdPoint 3
.AddCmdPoint -10.0, 0.0, 0.0
.AddCmdPoint -5.0, 10.0, 0.0
.AddCmdPoint 10.0, 10.0, 0.0
.EndAddCmdPoint

{button ,AL(`CAD_EndAddCmdPoint_Menu;cad_point;;;;',0,"Defaultoverview",)} Related Topics



.Extend (CAD)

.Extend .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command extends a line to the bounding line (the line which you want the extended line to meet).

Syntax Description
.x1 Specifies the X-coordinate for the point on the bounding line in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the point on the bounding line in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the point on the bounding line in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the point on the line to be extended in the 

document's default unit of measurement.
.y2 Specifies the Y-coordinate for the point on the line to be extended in the 

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the point on the line to be extended in the 

document's default unit of measurement.

Note
You must have already drawn a line and a bounding line before using the .Extend command.
This command corresponds to the Extend command on the Transform menu. Click Transform, Extend.

Example
REM units in inches
.SetPointXYZ -105.143, 3.18187, 0.0
.SetPointXYZ -56.5978, 18.5399, 0.0
.LineSegment
.SetPointXYZ -54.5165, 77.0873, 0.0
.SetPointXYZ -18.3887, -28.562, 0.0
.LineSegment
.Extend -35.8766, 22.1553, 0.0,-72.2746, 14.1379, 0.0
The above example creates two line segments. The second line segment is the bounding line. Points are selected
on the bounding line and the other line. Then the other line is extended to the bounding line.

{button ,AL(`CAD_Extend_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Extrude (CAD)

.Extrude .ProfileOrientation=short, .TaperAngle=double

This command extrudes an existing object to a specified scale.

Syntax Description
.ProfileOrientation Specifies type of extrusion. Set to 0 for Normal Extrude; and set to 1 for Rigid 

Extrude
.TaperAngle Specifies the amount (in degrees) by which the object becomes narrower at the 

top.

Note
You must have selected an object before using this command.
Points used to extrude the object must be set using the .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint commands.
This command corresponds to the Extrude command on the Extrude flyout of the Draw menu. Click Draw, 

Extrude, Extrude.

Example
REM units in inches
.Rectangle 1, -95.6901, 10.3969, 14.0229, -55.371, -21.6615, 14.0229
.StartAddCmdPoint 2
.AddCmdPoint -95.6901, -21.6615, 14.0229
.AddCmdPoint -95.4886, -21.5704, 58.4729
.EndAddCmdPoint
.Extrude 1, 45
The above example creates a rectangle, sets the command points, and then extrudes the object. 

{button ,AL(`CAD_Extrude_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.ExtrudeNormal (CAD)

.ExtrudeNormal .Height=double, .Scale=double, x1=double, y1=double, z2=double, x2=double, 
y2=double, z2=double

This command extrudes an existing object.

Syntax Description
.Height Specifies the height of the extruded object in inches. This parameter is optional.
.TaperAngle Specifies the amount (in degrees) by which the object becomes narrower atthe 

top.
.x1 If .Height is set, specifies the X-coordinate for the base point of the extruded 

object in the document's default unit of measurement. 
If .Height is not set, specifies the X-coordinate for the first of two points that 
determine the height of the extruded object in the document's default unit of 
measurement.

.y1 If .Height is set, specifies the Y-coordinate for the base point of the extruded object
in the document's default unit of measurement.
If .Height is not set, specifies the Y-coordinate for the first of two points that 
determine the height of the extruded object in the document's default unit of 
measurement.

.z1 If .Height is set, specifies the Z-coordinate for the base point of the extruded 
object in the document's default unit of measurement.
If .Height is not set, specifies the Z-coordinate for the first of two points that 
determine the height of the extruded object in the document's default unit of 
measurement.

.x2 Specifies the X-coordinate for the second of two points that determine the height 
of the extruded object in the document's default unit of measurement. This 
parameter is required only if .Height is not set.

.y2 Specifies the Y-coordinate for the second of two points that determine the height 
of the extruded object in the document's default unit of measurement. This 
parameter is required only if .Height is not set.

.z2 Specifies the Z-coordinate for the second of two points that determine the height 
of the extruded object in the document's default unit of measurement. This 
parameter is required only if .Height is not set.

Note
You must have already created and selected an 2D object before using this command.
This command corresponds to the Extrude Normal command on the Extrude flyout of the Draw menu. Click

Draw, Extrude, Extrude Normal.

Example
REM units in inches
.Rectangle 0, -210.1, 362.0, -331.2, -171.8, 330.7, -331.2
.ExtrudeNormal 5, 2, -161.0, 375.5, 331.2
The above example creates a rectangle and then extrudes it.

{button ,AL(`CAD_ExtrudeNormal_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.FileClose (CAD)

.FileClose 

This command closes the current document.

Note
If this command is not preceded by the .  FileSave   command, diagram changes will be lost.

Example
.FileClose
The above example closes the active CorelCAD document.

{button ,AL(`CAD_FileClose_Menu;cad_filemenu;;;;',0,"Defaultoverview",)} Related Topics



.FileCreateTemplate (CAD)

.FileCreateTemplate .FileName=string, .WithObjects=Boolean

This command creates a template from an open document.

Syntax Description
.FileName Specifies the name and path of the template.
.WithObjects Specifies whether objects from the document are to be included in the new 

template. Set to TRUE (-1) to include the objects, set to FALSE (0) to discard the 
objects. The default setting is FALSE (0).

Note
If the filename used already exists, this command does not overwrite it.
You must have a document open before using this command.

Example
.FileCreateTemplate "C:\CORELCAD\CAD\TEMPLATES\MYTEMP.CCT", -1
The above example creates a new CorelCAD template.

{button ,AL(`CAD_FileCreate_Menu;cad_filemenu;;;;',0,"Defaultoverview",)} Related Topics



 .FileExit (CAD)
.FileExit 

This command ends the CorelCAD session. 
Note

If this command is not preceded by the .  FileSave   command, diagram changes will be lost.

Example 
.FileExit
The above example ends the CorelCAD session.

{button ,AL(`CAD_File_Menu;cad_filemenu;;;;',0,"Defaultoverview",)} Related Topics



.FileExport (CAD)

.FileExport .FileName=string, .FilterID=long, .Width=long, .Height=long, .XResolution=long, .YResolution=lo
ng, .ImageType=long

This command saves the current document in a format that other programs can read.

Syntax Description
.FileName Specifies the new exported filename and path with an appropriate extension. If 

you do not specify a pathname, the file is saved to the last folder you used to save
a file. To export to an AutoCAD (.DWG) or (.DXF), Stereolithography (.STL), or an 
ACIS (.SAT), specify the file name and the extension.

.FilterID Specifies the type of file filter. If this parameter is omitted, the file is exported to 
AutoCAD (.DWG) or (.DXF), Stereolithography (.STL), or an ACIS (.SAT).
769 Windows Bitmap (BMP)
770 Paintbrush (PCX)
771 Targa Bitmap (TGA)
772 TIFF Bitmap (TIF)
773 CompuServe Bitmap (GIF)
774 JPEG Bitmaps (JPG)
776 Scitex CT Bitmap (SCT)
777 Wavelet Compressed Bitmap (WVL)
790 MACPaint Bitmap (MAC)
1792 Corel PHOTO-PAINT Image (CPT)

.Width Specifies the width of the image in pixels. If this parameter is omitted, the file is 
exported to AutoCAD (.DWG) or (.DXF), Stereolithography (.STL), or an ACIS (.SAT).

.Height Specifies the height of the image in pixels. If this parameter is omitted, the file is 
exported to AutoCAD (.DWG) or (.DXF), Stereolithography (.STL), or an ACIS (.SAT).

.XResolution Specifies the horizontal resolution of the image in dots per inch (dpi). If this 
parameter is omitted, the file is exported to AutoCAD (.DWG) or (.DXF), 
Stereolithography (.STL), or an ACIS (.SAT).

.YResolution Specifies the vertical resolution of the image in dots per inch (dpi). If this 
parameter is omitted, the file is exported to AutoCAD (.DWG) or (.DXF), 
Stereolithography (.STL), or an ACIS (.SAT).

.ImageType Specifies the image type. If this parameter is omitted, the file is exported to 
AutoCAD (.DWG) or (.DXF), Stereolithography (.STL), or an ACIS (.SAT).
1 Monochrome bitmap
3 8-bit paletted color bitmap
4 24-bit RGB color bitmap
6 32-bit CMYK bitmap
10 4-bit, 16 colors (standard VGA palette)

Example
.FileExport "C:\CORELCAD\TEMP1.BMP", 769, 320, 400, 72, 72, 4
The above example exports a CorelCAD file to a Windows bitmap named "TEMP1.BMP".

.FileExport "C:\CORELCAD\BEARINGS.DWF"
The above example exports a CorelCAD file to a AutoCAD (.DWF) file named BEARINGS.DWG.

{button ,AL(`CAD_FileExport_Menu;cad_filemenu;;;;',0,"Defaultoverview",)} Related Topics



.FileImport (CAD)

.FileImport .FileName=string

This command brings files from other programs into CorelCAD.

Syntax Description
.FileName Specifies the name of the file to import. 

Example
.FileNew
.FileImport "C:\COREL\CAD\TEMP1.WMF"
The above example imports a Windows Metafile named "TEMP1.WMF" into a new CorelCAD file.

{button ,AL(`CAD_FileImport_Menu;cad_filemenu;;;;',0,"Defaultoverview",)} Related Topics



.FileNew (CAD)

.FileNew 

This command creates a new CorelCAD document.

Note
If you execute a CorelCAD script while CorelCAD is closed, the first command after the 

WITHOBJECTCorelCAD command must be a .FileNew or .  FileOpen   command.

Example
.FileNew
This example creates a new CorelCAD document. It does not close drawings that are currently open.

{button ,AL(`CAD_FileNew_Menu;cad_filemenu;;;;',0,"Defaultoverview",)} Related Topics



.FileNewFromTemplate (CAD)

.FileNewFromTemplate .FileName=string, .WithObjects=Boolean

This command creates a new document from a template.

Syntax Description
.FileName Specifies the name and path of the template. 
.WithObjects Specifies whether objects from the template are to be included in the new 

document. Set to TRUE (-1) to include the objects, set to FALSE (0) to discard the 
objects. The default setting is FALSE (0).

Note
This command corresponds to the From Template command from the New flyout on the File menu. Click 

File, New, From Template.

Example
.FileNewFromTemplate "C:\CORELCAD\CAD\TEMPLATES\TEMPLATE.CCT", -1
The above example creates a new CorelCAD diagram using the template called TEMPLATE.CCT.

{button ,AL(`CAD_FileNewFromTemplate_Menu;cad_filemenu;;;;',0,"Defaultoverview",)} Related 
Topics



.FileOpen (CAD)

.FileOpen .FileName=string

This command loads a previously saved document into CorelCAD. You can also use this command to open 
CorelCAD templates.

Syntax Description
.FileName Specifies the name of the document to open. If you do not specify a pathname, 

the last folder you saved a file to is used.

Note
If you execute a CorelCAD script while CorelCAD is closed, the first command after the WITHOBJECT CAD 

command must be a .  FileNew   or .FileOpen command.
A diagram opened with the .FileOpen command becomes the active diagram.

Example
.FileOpen "C:\CORELCAD\MYFILES\TEST1.CCD"
The above example opens a CorelCAD diagram named TEST1.CCD.

.FileOpen "C:\CORELCAD\MYFILES\TEMPLATE1.CCT"
The above example opens a CorelCAD template named TEMPLATE1.CCT.

{button ,AL(`CAD_FileOpen_Menu;cad_filemenu;;;;',0,"Defaultoverview",)} Related Topics



.FileSave (CAD)

.FileSave .FileName=string

This command saves the current document to a specified file.

Syntax Description
.FileName Specifies the name and path of the file. If you do not specify a pathname, the file 

is saved to the folder last used to save a file.

Note
The filename must have the extension CCD.

Example
.FileSave "C:\Corel\CAD\Samples\mycaddoc.ccd"
The above example saves the current document to the samples folder.

{button ,AL(`CAD_FileSave_Menu;cad_filemenu;;;;',0,"Defaultoverview",)} Related Topics



.Fillet (CAD)

.Fillet .radius=double, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command fillets 2D line corners.

Syntax Description
.radius Specifies the corner radius in inches.
.x1 Specifies the X-coordinate for the point located on the first of two adjacent lines in 

the document's default unit of measurement.
.y1 Specifies the Y-coordinate for the point located on the first of two adjacent lines in 

the document's default unit of measurement.
.z1 Specifies the Z-coordinate for the point located on the first of two adjacent lines in 

the document's default unit of measurement.
.x2 Specifies the X-coordinate for the point located on the second of two adjacent lines

in the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the point located on the second of two adjacent lines

in the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the point located on the second of two adjacent 

lines in the document's default unit of measurement.

Note
This command corresponds to the Fillet command on the Fillet flyout of the Transform menu. Click 

Transform, Fillet, Fillet.

Example
REM units in inches
.Rectangle 0, -10.0, 5.5, 0.0, -4.0, 0.0, 0.0
.Fillet 3, -6.5, 5.5, 0.0, -4.0, 3.5, 0.0
The above example creates a rectangle and then fillets a corner of the rectangle.

{button ,AL(`CAD_Fillet_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.FilletEdgeMitered (CAD)

.FilletEdgeMitered .radius=double, .X=double, .Y=double, .Z=double, .Continuous=Boolean

This command fillets the edge of the 3D object with mitered corners.

Syntax Description
.radius Specifies the radius of the corner in inches.
.X Specifies the X-coordinate for the point on the edge of the object in the 

document's default unit of measurement.
.Y Specifies the Y-coordinate for the point on the edge of the object in the 

document's default unit of measurement.
.Z Specifies the Z-coordinate for the point on the edge of the object in the 

document's default unit of measurement.
.Continous Specifies whether the fillet being applied is continuous. Set to TRUE (-1) to apply a

continuous fillet, set to FALSE (0) to apply a non-continuous fillet. The default is 
FALSE. This parameter is optional.

Note
This command corresponds to the Fillet Edge command on the Fillet flyout of the Transform menu. Click 

Transform, Fillet, Fillet Edge.
This command fillets only one edge.
The .Continuous parameter is identical to holding the shift key down when picking your edges in the Fillet

Edge dialog box.

Example
REM units in inches
.Box -1, -12.5, 6.0, -4.0, -7.5, 3.0, -9.0
.FilletEdgeMitered 3, -11.0, 10.5, -9.0, 0
.FilletEdgeMitered 3, -9.0, 9.0, -9.0, 0.0
This example fillets two edges of a box with mitered corners.

{button ,AL(`CAD_FilletEdgeMitered_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.FilletEdgeRound (CAD)

.FilletEdgeRound .radius=double, .SetbackVal=double, .X=double, .Y=double, .Z=double, .Continuous
=Boolean

This command fillets the edge of the 3D object with round corners.

Syntax Description
.radius Specifies the radius of the corner in inches.
.SetbackVal Specifies the distance the original fillet edge is set back.
.X Specifies the X-coordinate for the point on the edge of the object in the 

document's default unit of measurement.
.Y Specifies the Y-coordinate for the point on the edge of the object in the 

document's default unit of measurement.
.Z Specifies the Z-coordinate for the point on the edge of the object in the 

document's default unit of measurement.
.Continuous Specifies whether the fillet being applied is continuous. Set to TRUE (-1) to apply a

continuous fillet, set to FALSE (0) to apply a non-continuous fillet. The default is 
FALSE. This parameter is optional.

Note
This command corresponds to the Fillet Edge command on the Fillet flyout of the Transform menu. Click 

Transform, Fillet, Fillet Edge.
This command fillets only one edge.
The .Continuous parameter is identical to holding the shift key down when picking your edges in the Fillet

Edge dialog box.

Example
REM units in inches
.Box -1, -18.0, 27.0, -23.0, -12.5, 23.5, -28.0
.FilletEdgeRound 4, 1, -14.0, 30.0, -29.0, 0
This example creates a box and then fillets a corner of the box with round edges.

{button ,AL(`CAD_FilletEdgeMitered_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Frustum (CAD)

.Frustum .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=
double, .x3=double, .y3=double, .z3=double, .x4=double, .y4=double, .z4=double

This command creates a frustum.

Syntax Description
.SaveAsSolid Specifies whether the frustum is saved as a solid or a surface. Set to TRUE (-1) to 

save the frustum as a solid; set to FALSE (0) to save the frustum as a surface.
.x1 Specifies the X-coordinate for the center of the frustum's base in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the center of the frustum's base in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the center of the frustum's base in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the radius of the frustum's base in the document's 

default unit of measurement.
.y2 Specifies the Y-coordinate for the radius of the frustum's base in the document's 

default unit of measurement.
.z2 Specifies the Z-coordinate for the radius of the frustum's base in the document's 

default unit of measurement.
.x3 Specifies the X-coordinate for the height of the frustum's second plane in the 

document's default unit of measurement.
.y3 Specifies the Y-coordinate for the height of the frustum's second plane in the 

document's default unit of measurement.
.z3 Specifies the Z-coordinate for the height of the frustum's second plane in the 

document's default unit of measurement.
.x4 Specifies the X-coordinate for the radius of the frustum's second plane in the 

document's default unit of measurement.
.y4 Specifies the Y-coordinate for the radius of the frustum's second plane in the 

document's default unit of measurement. 
.z4 Specifies the X-coordinate for the radius of the frustum's second plane in the 

document's default unit of measurement.

Note
This command corresponds the Frustum, Center and Radius command on the Solids flyout of the Draw 

menu. Click Draw, Solids, Frustum, Center and Radius.

Example
REM units in inches
.Frustum -1, -10.5, 0.0, 0.0, -8.5, 0.0, 0.0, -10.0, 7.5, 0.0, -10.0, 8.5, 0.0

{button ,AL(`CAD_Frustum_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.FrustumDiameter (CAD)

.FrustumDiameter .SaveAsSurface=Boolean, .NumberEdges=integer, .x1=double, .y1=double, .z1=d
ouble, .x2=double, .y2=double, .z2=double, .x3=double, .y3=double, .z3=double, .x4=double, .y4=d
ouble, z4=double

This command creates a circular two point frustum.

Syntax Description
.SaveAsSurface Specifies whether the frustum is saved as a solid or a surface. Set to TRUE (-1) to 

save the frustum as solid; set to FALSE (0) to save as a surface.
.NumberEdges Specifies the number of sides.
.x1 Specifies the X-coordinate for the center of the base in the document's default unit

of measurement.
.y1 Specifies the Y-coordinate for the center of the base in the document's default unit

of measurement.
.z1 Specifies the Z-coordinate for the center of the base in the document's default unit

of measurement.
.x2 Specifies the X-coordinate for the point on the vertex in the document's default 

unit of measurement.
.y2 Specifies the Y-coordinate for the point on the vertex in the document's default 

unit of measurement.
.z2 Specifies the Z-coordinate for the point on the vertex in the document's default 

unit of measurement.
.x3 Specifies the X-coordinate for the height in the document's default unit of 

measurement.
.y3 Specifies the Y-coordinate for the height in the document's default unit of 

measurement.
.z3 Specifies the Z-coordinate for the height in the document's default unit of 

measurement.
.x4 Specifies the X-coordinate for the scale of the top in the document's default unit of

measurement.
.y4 Specifies the Y-coordinate for the scale of the top in the document's default unit of 

measurement.
.z4 Specifies the Z-coordinate for the scale of the top in the document's default unit of

measurement. 

Example
REM units in inches
.FrustumDiameter -1, -17.0, 8.0, -12.5, -11.5, 9.0, -12.5, -13.5, 14.0, -12.5, -14.0, 15.0, -
12.5

{button ,AL(`CAD_FrustumDiameter_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.GetName (CAD)
ReturnValue$ = .GetName ( )

This function returns the name of the selected object.

Syntax Description
ReturnValue$ Specifies the string variable that is passed the return value corresponding to the 

name of the selected object. This variable must be declared using a DIM 
statement or implicitly declared using type-declaration suffix.

Note
If more than one object is selected and they all have the same name, the name of the selected objects is 

returned. If more than one object is selected and they do not have the same name, nothing is returned.
The object(s) must be selected before using this command.

Example
REM units in inches
.Frustum -1, -14.0, 2.0, 0.0, -12.0, 1.0, 0.0, -12.0, 4.5, 0.0, -11.5, 4.0, 0.0
.Sphere -1, -10.0, 0.5, 0.0, -8.5, -0.5, 0.0
.SelectWithinRegion -19.0, 7.5, 0.0, 1.0, 5.5, 0.0
.ApplyName "Canada"
ObjName$ = .GetName()
This example creates a frustum and a sphere. The object name "Canada" is applied to the two objects and then 
returns the name of the objects.

{button ,AL(`CAD_GetName_Menu;cad_name;;;;',0,"Defaultoverview",)} Related Topics



.GetTotalNumberObjects (CAD)
ReturnValue& = .GetTotalNumberObjects ( )

This function returns the number of objects in the active document.

Syntax Description
ReturnValue& Specifies the numeric variable that is passed the return value corresponding to the

number of objects. This variable must be declared using a DIM statement or 
implicitly declared using a type-declaration suffix.

Example
NumberObjs& = .GetTotalNumberObjects ()
This example counts all of the objects in the active document and returns the number of objects.

{button ,AL(`CAD_GetTotalNumberObjects_Menu;cad_name;;;;',0,"Defaultoverview",)} Related 
Topics



.Group (CAD)

.Group 

This command groups selected objects.

Note
The objects must be selected before using this command.
This command corresponds to the Group command on the Transform menu. Click Transform, Group.

Example
REM units in inches
.Frustum -1, -14.0, 2.0, 0.0, -12.0, 1.0, 0.0, -12.0, 4.5, 0.0, -11.5, 4.0, 0.0
.Sphere -1, -10.0, 0.5, 0.0, -8.5, -0.5, 0.0
.SetPointXYZ -8.5, 8.5, 0.0
.SetPointXYZ -4.5, -4.0, 0.0
.LineSegment
.SelectWithinRegion -19.0, 7.5, 0.0, 1.0, 5.5, 0.0
.Group
This command creates a frustum, sphere and a line, then selects all of the objects and groups them.

{button ,AL(`CAD_Group_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Hemisphere (CAD)

.Hemisphere .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .
z2=double, .x3=double, .y3=double, .z3=double

This command creates a hemisphere.

Syntax Description
.SaveAsSolid Specifies whether the hemisphere is saved as a solid or a surface. Set to TRUE (-1)

to save the hemisphere as a solid; set to FALSE (0) to save the hemisphere as a 
surface.

.x1 Specifies the X-coordinate for the center of the hemisphere in the document's 
default unit of measurement.

.y1 Specifies the Y-coordinate for the center of the hemisphere in the document's 
default unit of measurement.

.z1 Specifies the Z-coordinate for the center of the hemisphere in the document's 
default unit of measurement.

.x2 Specifies the X-coordinate for the radius of the hemisphere in the document's 
default unit of measurement.

.y2 Specifies the Y-coordinate for the radius of the hemisphere in the document's 
default unit of measurement.

.z2 Specifies the Z-coordinate for the radius of the hemisphere in the document's 
default unit of measurement.

.x3 Specifies the X-coordinate for the plane of the hemisphere in the document's 
default unit of measurement.

.y3 Specifies the Y-coordinate for the plane of the hemisphere in the document's 
default unit of measurement.

.z3 Specifies the Z-coordinate for the plane of the hemisphere in the document's 
default unit of measurement.

Note
This command corresponds to the Hemisphere, Center and Radius command on the Solids flyout of the 

Draw menu. Click Draw, Solids, Hemisphere, Center and Radius.

Example
REM units in inches
.Hemisphere –1, -10.0, 2.0, 0.0, -5.0, 3.0, 0.0, -6.0, 4.5, 0.0

{button ,AL(`CAD_Hemisphere_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.HemisphereDiameter (CAD)

.HemisphereDiameter .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2
=double, .z2=double, .x3=double, .y3=double, .z3=double

This command creates a hemisphere.

Syntax Description
.SaveAsSolid Specifies whether the hemisphere is saved as a solid or a surface. Set to TRUE (-1)

to save the hemisphere as a solid; set to FALSE (0) to save the hemisphere as a 
surface.

.x1 Specifies the X-coordinate for the first point that determines the diameter of the 
hemisphere in the document's default unit of measurement.

.y1 Specifies the Y-coordinate for the first point that determines the diameter of the 
hemisphere in the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the first point that determines the diameter of the 
hemisphere in the document's default unit of measurement.

.x2 Specifies the X-coordinate for the second    point that determines the diameter of 
the hemisphere in the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the second point that determines the diameter of the
hemisphere in the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the second point that determines the diameter of 
the hemisphere in the document's default unit of measurement.

.x3 Specifies the X-coordinate for the plane of the hemisphere in the document's 
default unit of measurement.

.y3 Specifies the Y-coordinate for the plane of the hemisphere in the document's 
default unit of measurement.

.z3 Specifies the Z-coordinate for the plane of the hemisphere in the document's 
default unit of measurement.

Example
REM units in inches
.HemisphereDiameter -1, -15.0, 13.0, -12.5, -6.0, 15.5, -12.5, -7.5, 20.0, -12.5

{button ,AL(`CAD_HemisphereDiameter_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.HideEntireView (CAD)

.HideEntireView .ShowText=Boolean, .ShowDimension=Boolean, .IsSihouette=Boolean, .IsAllViews=
Boolean

This command hides the hidden lines for the entire view.

Syntax Description
.ShowText Specifies whether the text is displayed. If set to TRUE (-1), the text is displayed; if 

set to FALSE (0) the text is not displayed.
.ShowDimension Specifies whether dimensions are displayed. If set to TRUE (-1), the dimensions are

shown; if set to FALSE (0), the dimensions are not displayed.
.IsSihouette Specifies whether the silhouette is displayed. If set to TRUE (-1), the silhouette is 

displayed; if set to FALSE (0), the silhouette is not displayed.
.IsAllViews Specifies whether the hidden lines in all views are displayed. If set to TRUE 

(-1), hidden lines are not displayed in all views; if set to FALSE (0), only the hidden 
lines in the active view are not displayed.

Note
This command corresponds to the Hide command on the View menu. Click View, Hide. 

Example
REM units in inches
.HideEntireView 0, -1, 0, 0
This example hides the hidden lines from only the active view. The text and silhouette are not displayed, but 
dimension lines are. 

{button ,AL(`CAD_HideEntireView_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.HideSectionView (CAD)

.HideSectionView .ShowText=Boolean, .ShowDimensions=Boolean, .IsSilhouette=Boolean, .x1=doub
le, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command hides the hidden lines in the view specified by the coordinates of two points.

Syntax Description
.ShowText Specifies whether the text is displayed. If set to TRUE (-1), the text is displayed; if 

set to FALSE (0) the text is not displayed.
.ShowDimension Specifies whether dimensions are displayed. If set to TRUE (-1), the dimensions are

shown; if set to FALSE (0), the dimensions are not displayed.
.IsSihouette Specifies whether the silhouette is displayed. If set to TRUE (-1), the silhouette is 

displayed; if set to FALSE (0), the silhouette is not displayed.
.x1 Specifies the X-coordinate for the first point (starting corner) of the region in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point (starting corner) of the region in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point (starting corner) of the region in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point (opposite corner) of the region in 

the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point (opposite corner) of the region in 

the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point (opposite corner) of the region in 

the document's default unit of measurement.

Note
This command corresponds to the Hide command on the View menu. Click View, Hide. 

Example
REM units in inches
.HideSectionView 0, 0, -1, -21.0, 21.0, -12.5, -1.5, 8.0, -12.5
This example hides the hidden lines in the region specified by the coordinates of the two points. Text and 
dimension lines are not displayed, but the silhouette is.

{button ,AL(`CAD_HideSectionView_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.HideSelected (CAD)

.HideSelected .ShowText=Boolean, .ShowDimension=Boolean, .IsSilhouette=Boolean

This command hides the hidden lines in the selected object.

Syntax Description
.ShowText Specifies whether the text is displayed. If set to TRUE (-1), the text is displayed; if 

set to FALSE (0) the text is not displayed.
.ShowDimension Specifies whether dimensions are displayed. If set to TRUE (-1), the dimensions are

shown; if set to FALSE (0), the dimensions are not displayed.
.IsSihouette Specifies whether the silhouette is displayed. If set to TRUE (-1), the silhouette is 

displayed; if set to FALSE (0), the silhouette is not displayed.

Note
The object must be selected before running this command.

Example
REM units in inches
.HemisphereDiameter -1, -15.0, 13.0, -12.5, -6.0, 15.5, -12.5, -7.5, 20.0, -12.5,
.HideSelected 0, 0, -1
This example hides the hidden lines of the selected object. Text and dimension lines are not displayed, but the 
silhouette is displayed.

{button ,AL(`CAD_HideSelected_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.IntersectingLine (CAD)

.IntersectingLine .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command draws an intersecting line between two surfaces. The two surfaces are determined by the 
coordinates of two points.

Syntax Description
.x1 Specifies the X-coordinate for the point on the first surface in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the point on the first surface in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the point on the first surface in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the point on the second surface in the document's 

default unit of measurement.
.y2 Specifies the Y-coordinate for the point on the second surface in the document's 

default unit of measurement.
.z2 Specifies the Z-coordinate for the point on the second surface in the document's 

default unit of measurement.

Note
You must have two surfaces that intersect before using the .IntersectingLine command.
The objects used can be either 2D or 3D; however, a 2D object must be a surface and a 3D object must be 

a solid.
This command corresponds to the Intersecting Line command on the Line flyout of the Draw menu. Click 

Draw, Line, Intersecting Line.

Example
REM units in inches
.Rectangle -1, -8.5, 2.0, 0.0, 0.0, -2.5, 0.0
.Rectangle -1, -4.0, 0.5, 2.0, -4.0, -3.0, -1.5
.IntersectingLine -8.5, 2.0, 0.0, -4.0, 0.5, 2.0
This example draws two rectangles and then creates an intersecting line between the two.

{button ,AL(`CAD_IntersectingLine_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.JoinLines (CAD)

.JoinLines .X=double, .Y=double, .Z=double

This command joins the end points of previously selected lines.

Syntax Description
.X Specifies the X-coordinate of the point determining where the lines will be joined in

the document's default unit measurement.
.Y Specifies the Y-coordinate of the point determining where the lines will be joined in

the document's default unit measurement.
.Z Specifies the Z-coordinate of the point determining where the lines will be joined in

the document's default unit measurement.

Note
The lines must be drawn and selected before using this command.
This command corresponds to the Join command on the Join Lines flyout of the Transform menu. Click 

Transform, Join Lines, Join.

Example
REM units in inches
.SetPointXYZ -103.535, 33.1608, 0.0
.SetPointXYZ -2.43662, -24.9533, 0.0
.LineSegment
.SetPointXYZ -38.6308, 60.9008, 0.0
.SetPointXYZ -62.3784, -42.9061, 0.0
.LineSegment
.JoinLines -51.7824, 3.41197, 0.0
This example creates two line segments and then joins them.

{button ,AL(`CAD_JoinLines_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.LayerSetColor (CAD)

.LayerSetColor .LayerName=string, .GroupName=string, .Red=short, .Green=short, .Blue=short

This command edits the color of a layer.

Syntax Description
.LayerName Specifies the name of the existing layer.
.GroupName Specifies the name of the layer group. If this parameter is omitted, the default 

group is All Layers.
.Red Specifies the red setting for layer color (RGB color model). Valid values range from 

0 to 255. This parameter works in conjunction with .Green and .Blue to 
determine the color of the layer. 

.Green Specifies the green setting for layer color (RGB color model). Valid values range 
from 0 to 255. This parameter works in conjunction with .Red and .Blue to 
determine the color of the layer. 

.Blue Specifies the blue setting for layer color (RGB color model). Valid values range 
from 0 to 255. This parameter works in conjunction with .Red and .Green to 
determine the color of the layer. 

Note
The layer specified for .LayerName must exist and belong to the specified group.
.GroupName is optional. If the .GroupName is provided, the name of the group must already exist.

Example
.LayerSetColor "mylayer", "mygroup", 255, 100, 100
The first example changes the color of the layer called "mylayer" in the group "mygroup. 

.LayerSetColor "mylayer",, 255, 100,100
The second example changes the color of the same layer, but the layer is in the group "All Layers" because the 
group name is not specified.

{button ,AL(`CAD_LayerSetColor_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related Topics



.LayerSetDescription (CAD)

.LayerSetDescription .LayerName=string, .Description=string

This command edits the description of a layer.

Syntax Description
.LayerName Specifies the name of the existing layer.
.Description Specifies the description of the layer.

Note
The layer specified for .LayerName must exist. 

Example
.LayerSetDesciption "mylayer", "this is a description of mylayer"

{button ,AL(`CAD_LayerSetDescription_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related 
Topics



.LayerSetLineStyle (CAD)

.LayerSetLineStyle .LayerName=string, .GroupName=string, .LineStyle=short

This command edits the line style of a layer.

Syntax Description
.LayerName Specifies the name of the existing layer.
.GroupName Specifies the group name for the layer. If this parameter is omitted, the default 

group name is All Layers.
.LineStyle Specifies the new line style used to draw objects on the layer. 

1 Solid (1 point)
2 Dashes
3 Dots
4 Dash, Dot
5 Dash, Dot, Dot
6 Solid (2 points)
7 Solid (3 points)
8 Solid (4 points)
9 Solid (5 points)
10 Solid (6 points)
11 Solid (7 points)

Note
The layer specified for .LayerName must exist and belong to the specified group.
.GroupName is optional. If the .GroupName is provided, the name of the group must already exist.

Example
.LayerSetLineStyle "mylayer", "mygroup", 8
The above example sets the lines style for the layer called "mylayer" in the group "mygroup. The group name is 
specified.

.LayerSetLineStyle "mylayer",, 8
The above example sets the ine style for the layer called "mylayer" in the default group All Layers.

{button ,AL(`CAD_LayerSetLineStyle_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related Topics



.LayerSetName (CAD)

.LayerSetName .LayerName=string, .NewName=string

This command edits the name of a layer.

Syntax Description
.LayerName Specifies the name of the existing layer.
.NewName Specifies the new name set for the layer.

Note
The layer specified for .LayerName must exist. 
If the new name already exists, this command is ignored.

Example
.LayerSetName "mylayer", "new name"

{button ,AL(`CAD_LayerSetName_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related Topics



.LayerSetStatus (CAD)

.LayerSetStatus .LayerName=string, .GroupName=string, .Visible=Boolean, .Printable=Boolean, .Locked=Bo
olean, .Override=Boolean

This command edits the status of a layer.

Syntax Description
.LayerName Specifies the name of the existing layer.
.GroupName Specifies the group    name for the layer. The default is All Layers.
.Visible Specifies whether the layer is visible. Set to TRUE (-1) to make the layer visible; 

set to FALSE (0) to make the layer invisible. 
.Printable Specifies whether objects on the layer are printable. Set to TRUE (-1) to print the 

layer; set to FALSE (0) to make the layer not printable. 
.Locked Specifies whether the layer is locked. Set to TRUE (-1) to lock the layer; set to 

FALSE to unlock the layer. 
.Override Specifies whether the color of the objects on the specified layer can be overriden. 

Set to TRUE (-1) to override the objects’ color with the layer’s color, set to FALSE 
(0) to keep the objects’ color.

Note
.GroupName .Visible, .Printable, .Locked, and .Override are optional. You can change only the 

properties that you want. For example, if you only want to make the layer invisible, set .Visible to FALSE and ignore
all other properties.

You cannot set the current layer as invisible and/or locked. If you do, the command is ignored.

Example
.LayerSetStatus "mylayer", "mygroup", 0, 0, -1, 0
The above example sets the all of the parameters for the layer called "mylayer".

.LayerSetStatus "mylayer", "mygroup", , ,-1, 0
The above example only locks the layer and the override color.

{button ,AL(`CAD_LayerSetStatus_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related Topics



.LineSegment (CAD)

.LineSegment 

This command creates a line segment.

Note
You must precede the .LineSegment command with either .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint or .SetPointXYZ.
This command corresponds to the Line Segments command on the Line flyout of the Draw menu. Click 

Draw, Line, Line Segments.

Example
REM units in inches
.SetPointXYZ -8.5, 8.5, 0.0
.SetPointXYZ -4.5, -4.0, 0.0
.LineSegment

{button ,AL(`CAD_LineUnconnected_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.LinearArray (CAD)

.LinearArray .DistanceMode=integer, .Copy=integer, .x1=double, .y1=double, .z1=double, .x2=doub
le, .y2=double, .z2=double

This command places copies of the selected object along a straight line.

Syntax Description
.DistanceMode Specifies the distance mode. Set to 0 for increment mode; set to 1 for overall 

mode. 
.Copy Specifies the number of copies.
.x1 Specifies the X-coordinate for one of two points that determine the linear direction 

and the distance between two copies.
.y1 Specifies the Y-coordinate for one of two points that determine the linear direction 

and the distance between two copies.
.z1 Specifies the Z-coordinate for one of two points that determine the linear direction 

and the distance between two copies.
.x2 Specifies the X-coordinate for one of two points that determine the linear direction 

and the distance between two copies.
.y2 Specifies the Y-coordinate for one of two points that determine the linear direction 

and the distance between two copies.
.z2 Specifies the Z-coordinate for one of two points that determine the linear direction 

and the distance between two copies.

Note
An object must be selected before using this command.
This command corresponds to the Linear Array command on the Array flyout of the Draw menu. Click 

Draw, Array, Linear Array.

Example
REM units in inches
.Box -1, -20.0, 9.0, -11.0, -17.5, 6.5, -13.5
.LinearArray 0, 3, -17.5, 8.5, -11.0, -17.5, 12.0, -11.0
This example creates a box and then places 20 copies of the box in a line. The distance mode is set to increment
and the direction of the line and the distance between copies is set by the coordinates of the two points.

{button ,AL(`CAD_LinearArray_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.Loft (CAD)

.Loft

This command creates a smooth surface between two or more existing lines. 

Note
The lines must be drawn before using the .Loft command. 
The points on the lines must be created using .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint and/or .SetPointXYZ.
This command corresponds to the Loft command on the Surfaces flyout of the Draw menu. Click Draw, 

Surfaces, Loft.

Example
REM units in inches
.StartAddCmdPoint 3
.AddCmdPoint 20.0, 0.0, 0.0
.AddCmdPoint 25.0, 10.0, 0.0
.AddCmdPoint 40.0, 10.0, 0.0
.EndAddCmdPoint
.PolyLine
.SetPointXYZ 20.0, 0.0, 0.0
.SetPointXYZ 10.0, 0.0, 0.0
.SetPointXYZ 10.0, -10.0, 0.0
.PolyLine
.Loft
This example creates two polylines and then applies a smooth surface between the two lines.

{button ,AL(`CAD_Loft_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.Mirror (CAD)

.Mirror .LeaveOriginal=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=
double, .x3=double, .y3=double, .z3=double

This command creates a mirror of the selected object.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is mirrored. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.x1 Specifies the X-coordinate for the first point that determines the plane for the 
mirrored object in the document's default unit of measurement.

.y1 Specifies the Y-coordinate for the first point that determines the plane for the 
mirrored object in the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the first point that determines the plane for the 
mirrored object in the document's default unit of measurement.

.x2 Specifies the X-coordinate for the second point that determines the plane for the 
mirrored object in the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the second point that determines the plane for the 
mirrored object in the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the second point that determines the plane for the 
mirrored object in the document's default unit of measurement.

.x3 Specifies the X-coordinate for the third point that determines the plane for the 
mirrored object in the document's default unit of measurement. This point is 
optional.

.y3 Specifies the Y-coordinate for the third point that determines the plane for the 
mirrored object in the document's default unit of measurement. This point is 
optional.

.z3 Specifies the Z-coordinate for the third point that determines the plane for the 
mirrored object in the document's default unit of measurement. This point is 
optional.

Note
If only two points are specified, the mirror is two-dimensional. If three points are specified, the mirror is 

three-dimensional.
An object must be selected before using the .Mirror command.
This command corresponds to the Mirror command on the Transform menu. Click Transform, Mirror.

Example
REM units in inches
.Box -1, -25.5, 25.0, -23.0, -22.0, 21.5, -26.5
.Mirror -1, -20.5, 25.0, -26.5, -19.5, 22.5, -26.5
This example creates a box and then creates a duplicate of the box which is mirrored. Because only two points 
are specified, the mirror is two-dimensional.

{button ,AL(`CAD_Mirror_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.MirrorXY (CAD)

.MirrorXY .LeaveOriginal=Boolean, .x1=double, .y1=double, .z1=double

This command creates a mirror of the selected object with respect to the XY plane.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is mirrored. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.x1 Specifies the X-coordinate for the point that determines the plane for the mirrored 
object in the document's default unit of measurement.

.y1 Specifies the Y-coordinate for the point that determines the plane for the mirrored 
object in the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the point that determines the plane for the mirrored 
object in the document's default unit of measurement.

Note
Only the Z-coordinate is significant.
An object must be selected before using the .MirrorXY command.

Example
REM units in inches
.Box -1, -25.5, 25.0, -23.0, -22.0, 21.5, -26.5
.MirrorXY -1, -18.0, 29.0, -26.5
This example creates a box, duplicates it, and mirrors the duplicate at the specified location along the Z axis.

{button ,AL(`CAD_MirrorXY_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.MirrorXZ (CAD)

.MirrorXZ .LeaveOriginal=Boolean, .x1=double, .y1=double, .z1=double

This command creates a mirror of the selected object with respect to the XZ plane.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is mirrored. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.x1 Specifies the X-coordinate for the point that determines the plane for the mirrored 
object in the document's default unit of measurement.

.y1 Specifies the Y-coordinate for the point that determines the plane for the mirrored 
object in the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the point that determines the plane for the mirrored 
object in the document's default unit of measurement.

Note
Only the Y-coordinate is significant.
An object must be selected before using the .MirrorXZ command.

Example
REM units in inches
.Box -1, -25.5, 25.0, -23.0, -22.0, 21.5, -26.5
.MirrorXZ -1, -17.0, 19.5, -26.5
This example creates a box, duplicates it, and mirrors the duplicate at the specified location along the Y axis.

{button ,AL(`CAD_MirrorXZ_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.MirrorYZ (CAD)

.MirrorYZ .LeaveOriginal=Boolean, .x1=double, .y1=double, .z1=double

This command creates a mirror of the selected object with respect to the YZ plane.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is mirrored. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.x1 Specifies the X-coordinate for the point that determines the plane for the mirrored 
object in the document's default unit of measurement.

.y1 Specifies the Y-coordinate for the point that determines the plane for the mirrored 
object in the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the point that determines the plane for the mirrored 
object in the document's default unit of measurement.

Note
Only the X-coordinate is significant.
An object must be selected before using the .MirrorYZ command.

Example
REM units in inches
.Box -1, -25.5, 25.0, -23.0, -22.0, 21.5, -26.5
.MirrorYZ -1, -20.5, 35.0, -26.5
This example creates a box, duplicates it, and mirrors the duplicate at the specified location along the X axis.

{button ,AL(`CAD_MirrorYZ_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.MirrorNormal (CAD)

.MirrorNormal .LeaveOriginal=Boolean, .x1=double, .y1=double, .z1=double, x2=double, 
y2=double, z2=double

This command creates a mirror of the selected object on the plane that is normal to the vector defined by two 
points.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is mirrored. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.x1 Specifies the X-coordinate for the first point that determines the vector for the 
mirrored object in the document's default unit of measurement.

.y1 Specifies the Y-coordinate for the first point that determines the vector for the 
mirrored object in the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the first point that determines the vector for the 
mirrored object in the document's default unit of measurement.

.x2 Specifies the X-coordinate for the second point that determines the vector for the 
mirrored object in the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the second point that determines the vector for the 
mirrored object in the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the second point that determines the vector for the 
mirrored object in the document's default unit of measurement.

Note
An object must be selected before using the .MirrorNormal command.

Example
REM units in inches
.Box -1, -25.5, 25.0, -23.0, -22.0, 21.5, -26.5
.MirrorNormal -1, -17.0, 25.0, -26.5, -15.0, 31.0, -26.5
This example creates a box, duplicates it and places the duplicate on the plane that is normal to the vector 
specifed by the coordinate of the two points.

{button ,AL(`CAD_MirrorXY_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Move (CAD)

.Move .LeaveOriginal=Boolean, .MoveType=integer, .x1=double, .y1=double, .z1=double, .x2=doubl
e, .y2=double, .z2=double

This command moves the selected object or its duplicate to a new location which is relative to the new base 
points.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is moved. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.MoveType Specifies the type of move:
0 Absolute 
1 Relative

.x1 If .MoveType is set to Absolute, specifies the X-coordinate for the first absolute 
point in the document's default unit of measurement. If .MoveType is set to 
Relative, specifies the X-coordinate for the base point in the document's default 
unit of measurement.

.y1 If .MoveType is set to Absolute, specifies the Y-coordinate for the first absolute 
point in the document's default unit of measurement. If .MoveType is set to 
Relative, specifies the Y-coordinate for the base point in the document's default 
unit of measurement.

.z1 If .MoveType is set to Absolute, specifies the Z-coordinate for the first absolute 
point in the document's default unit of measurement. If .MoveType is set to 
Relative, specifies the Z-coordinate for the base point in the document's default 
unit of measurement.

.x2 If .MoveType is set to Absolute, specifies the X-coordinate for the second absolute
point in the document's default unit of measurement. If .MoveType is set to 
Relative, specifies the X-coordinate for the second point relative to the first point 
in the document's default unit of measurement.

.y2 If .MoveType is set to Absolute, specifies the Y-coordinate for the second absolute
point in the document's default unit of measurement. If .MoveType is set to 
Relative, specifies the Y-coordinate for the second point relative to the first point in
the document's default unit of measurement.

.z2 If .MoveType is set to Absolute, specifies the Z-coordinate for the second absolute
point in the document's default unit of measurement. If .MoveType is set to 
Relative, specifies the Z-coordinate for the second point relative to the first point 
in the document's default unit of measurement.

Note
You must have selected an object before using this command.
This command corresponds to the Move command on the Transform menu. Click Transform, Move.

Example
REM units in inches
.Box -1, -25.5, 25.0, -23.0, -22.0, 21.5, -26.5
.Move -1, 0, -16.5, 32.5, -26.5, -11.0, 37.0, -26.5
This example creates a box, duplicates its, and places the duplicate at the location specified by the coordinates 
of two points. The type of move is absolute; therefore, the coordinates are relative to the origin (0,0,0). If
.MoveType had been set to 1, the second point's coordinates would have been relative the first point set.

{button ,AL(`CAD_Move_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.MultiPlane (CAD)

.MultiPlane .SaveAsSurface=Boolean, .IsConnected=Boolean

This command draws a multi plane determined by points set around the perimeter of a surface. 

Syntax Description
.SaveAsSurface Set to TRUE (-1) to save the multi plane as plane; set to FALSE (0) to save as a line

vector.
.IsConnected Set to TRUE (-1) to connect the points; set to FALSE (0) to leave the points 

unconnected.

Note
You must precede the .MultiPlane command with either .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint or .SetPointXYZ.
This command corresponds to the Multiple Planes command on the Surfaces flyout of the Draw menu. Click

Draw, Surfaces, Multiple Planes.

Example
REM units in inches
.SetPointXYZ -24.5, 30.5, -25.0
.SetPointXYZ -20.0, 27.5, -25.0
.SetPointXYZ -10.5, 26.5, -25.0
.SetPointXYZ -8.0, 33.5, -25.0
.MultiPlane -1, -1

{button ,AL(`CAD_MultiPlane_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.NewLayer (CAD)

.NewLayer .LayerName=string, .GroupName=string, .Visible=Boolean, .Printable=Boolean, .Locked=Boolean, .
Override=Boolean, .Red=short, .Green=short, .Blue=short, .LineStyle=short, .Description=string

This command creates a new layer.

Syntax Description
.LayerName Specifies the name of the new layer. If you do not enter a name, the name of the 

layer is created automatically. 
.GroupName Specifies the name of the layer group.
.Visible Specifies whether the layer is visible. Set to TRUE (-1) to make the layer visible; 

set to FALSE (0) to make the layer invisible. The default setting is TRUE (visible).
.Printable Specifies whether objects on the layer are printable. Set to TRUE (-1) to print the 

layer; set to FALSE (0) to make the layer not printable. The default setting is TRUE 
(printable).

.Locked Specifies whether the layer is locked. Set to TRUE (-1) to lock the layer; set to 
FALSE (0) to unlock the layer. The default setting is FALSE (unlocked).

.Override Specifies whether the color of the objects on the specified layer can be overriden. 
Set to TRUE (-1) to override the objects' color with the layer’s color, set to FALSE 
(0) to keep the objects' color.

.Red Specifies the red setting for layer color (RGB color model). Valid values range from 
0 to 255. This parameter works in conjunction with .Green and .Blue to 
determine the color of the layer. The default layer color is black (.Red=0,
.Green=0, .Blue=0).

.Green Specifies the green setting for layer color (RGB color model). Valid values range 
from 0 to 255. This parameter works in conjunction with .Red and .Blue to 
determine the color of the layer. The default layer color is black (.Red=0,
.Green=0, .Blue=0).

.Blue Specifies the blue setting for layer color (RGB color model). Valid values range 
from 0 to 255. This parameter works in conjunction with .Red and .Green to 
determine the color of the layer. The default layer color is black (.Red=0,
.Green=0, .Blue=0).

.LineStyle Specifies the line style used to draw objects on the layer. For example, if you 
select a solid line for the layer, all objects (rectangles, frustums, etc) are drawn 
with a solid line. 
1 Solid (1 point)
2 Dashes
3 Dots
4 Dash, Dot
5 Dash, Dot, Dot
6 Solid (2 points)
7 Solid (3 points)
8 Solid (4 points)
9 Solid (5 points)
10 Solid (6 points)
11 Solid (7 points)

.Description Text string describing the layer.

Note
All of the parameters are optional. 
If you specify .GroupName, the name entered must exist as a group name.

Example
.NewLayer "mylayer", , -1, 0, 0, 0, 255, 255, 100, 3, "second layer"
This example does not specify a group name.

{button ,AL(`CAD_NewLayer_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related Topics





.NewLayerGroup (CAD)

.NewLayerGroup .GroupName=string, .Description=string, .LayerName=string

This command creates a new layer group.

Syntax Description
.GroupName Specifies the name of the new layer group.
.Description Text string describing the layer.
.LayerName Specifies the name of the existing layer. 

Note
.Desciption is an optional parameter. 
You must specify an existing layer for the .LayerName parameter because an empty layer group cannot 

be created.
You can add more layers to the group using the .AddLayerToLayerGroup command

Example
.NewLayerGroup "mygroup", "first layer group", "mylayer"

{button ,AL(`CAD_NewLayerGroup_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related Topics



Offset (CAD)
.Offset .OffsetDist=double, .NumberofCopies=integer, .x1=double, .y1=double, .z1=double, .x2=do
uble, .y2=double, .z2=double

This command draws a line(s) parallel to an existing line.

Syntax Description
.OffsetDist Specifies the distance between the existing line and the new line(s) in the 

document's default unit of measurement.
.NumberofCopies Specifies the number of new parallel lines to be offset from the original.
.x1 Specifies the X-coordinate for the point on the original line in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the point on the original line in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the point on the original line in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the point that determines on which side of the 

original line the new lines will be placed in the document's default unit of 
measurement.

.y2 Specifies the Y-coordinate for the point that determines on which side of the 
original line the new lines will be placed in the document's default unit of 
measurement.

.z2 Specifies the Z-coordinate for the point that determines on which side of the 
original line the new lines will be placed in the document's default unit of 
measurement.

Note
You must have drawn a line before using this command.
This command corresponds to the Offset command on the Transform menu. Click Transform, Offset.

Example
REM units in inches
.SetPointXYZ -12.0, 4.5, 0.0
.SetPointXYZ -2.0, 1.0, 0.0
.SetPointXYZ -0.5, 0.5, 0.0
.LineSegment
.Offset 1, 1, -7, 2.75, -5.0, 7.75, 0.0
This example creates a line segment and then offsets one copy one inch at a location specified by the 
coordinates of the two points.

{button ,AL(`CAD_Offset_Menu;cad_transmenu;;;',0,"Defaultoverview",)} Related Topics



.Parallel (CAD)

.Parallel .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command draws one line or curve parallel to an existing line or curve.

Syntax Description
.x1 Specifies the X-coordinate for the point on the existing line in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the point on the existing line in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the point on the existing line in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the point that determines the location of the new 

line or curve in the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the point that determines the location of the new 

line or curve in the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the point that determines the location of the new 

line or curve in the document's default unit of measurement.

Note
You must have drawn a curve or line before using the .Parallel command.
This command corresponds to the Parallel command on the Transform. Click Transform, Parallel.

Example
REM units in inches
.SetPointXYZ -14.0, 4.0, 0.0
.SetPointXYZ -11.0, 6.0, 0.0
.SetPointXYZ -8.0, 0.0, 0.0
.SetPointXYZ -4.5, 5.0, 0.0
.BezierCurve
.Parallel -11.0, 1.0, 0.0, -10.0, 4.0, 0.0
This example creates a Bezier Curve and draws another bezier curve parallel to the original at a location 
specified by the coordinates of two points.

{button ,AL(`CAD_Parallel_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.PerpendicularPlane (CAD)

.PerpendicularPlane .width=double, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .
z2=double

This command draws a plane perpendicular to an existing line.

Syntax Description
.width Specifies the width of the plane.
.x1 Specifies the X-coordinate of the point on the existing line in the document's 

default unit of measurement. The plane will be perpendicular to the line specified 
by this point.

.y1 Specifies the Y-coordinate of the point on the existing line in the document's 
default unit of measurement. The plane will be perpendicular to the line specified 
by this point.

.z1 Specifies the Z-coordinate of the point on the existing line in the document's 
default unit of measurement. The plane will be perpendicular to the line specified 
by this point.

.x2 Specifies the X-coordinate for the second point that determines the location of the 
plane in the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the second point that determines the location of the 
plane in the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the second point that determines the location of the 
plane in the document's default unit of measurement.

Note
You must have drawn a line before using the .PerpendicularPlane command.
This command corresponds to the Perpendicular Plane command on the Surfaces flyout of the Draw menu. 

Click Draw, Surfaces, Perpendicular Plane.

Example
REM units in inches
.SetPointXYZ -10.0, -0.5, 0.0
.SetPointXYZ -2.5, 2.0, 0.0
.LineSegment
.PerpendicularPlane 30, -7.0, 0.5, 0.0, -2.5, 2.0, 0.0
This example creates a line segment and then creates a perpendicular plane 30 inches wide at a location 
specified the coordinates of two points.

{button ,AL(`CAD_PerpendicularPlane_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related 
Topics



.Plane (CAD)

.Plane .SaveAsSurface=Boolean

This command creates a plane. 

Syntax Description
.SaveAsSurface Specifies whether the plane is saved as a surface or as a wire. Set to TRUE 

(-1) to save the plane as surface; set to FALSE (0) to save as a wire.

Note
You must precede the command with .StartAddCmdPoint, .AddCmdPoint, and .EndAddCmdPoint 

and/or .SetPointXYZ to set the command points.
This command corresponds to the Free Form command on the Surfaces flyout of the Draw menu. Click 

Draw, Surfaces, Free Form

Example
REM units in inches
.SetPointXYZ -16.0, 4.5, 0.0
.SetPointXYZ -11.0, 9.0, 0.0
.SetPointXYZ -6.0, 4.5, 0.0
.SetPointXYZ -11.5, -4.0, 0.0
.SetPointXYZ -22.0, 8.0, 0.0
.Plane -1
This example sets 5 command points and then creates a surface plane.

{button ,AL(`CAD_Plane_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.PolygonCenter (CAD)

.PolygonCenter .SaveAsSurface=Boolean, .NumberEdges=integer, .x1=double, .y1=double, .z1=dou
ble, .x2=double, .y2=double, .z2=double 

The command creates a polygon.

Syntax Description
.SaveAsSurface Specifies whether the rectangle is saved as a surface or a wire. Set to TRUE (-1) to 

save the rectangle as surface; set to FALSE (0) to save as a wire.
.NumberEdges Specifies the number of sides.
.x1 Specifies the X-coordinate for the center point of the polygon in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the center point of the polygon in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the center point of the polygon in the document's 

default unit of measurement.
.x2 Specifies the X-coordinate for the corner of two adjacent edges of the polygon in 

the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the corner of two adjacent edges of the polygon in 

the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the corner of two adjacent edges of the polygon in 

the document's default unit of measurement.

Note
This command corresponds to the Center and Vertex command on the Polygon flyout of the Draw menu. 

Click Draw, Polygon, Center and Vertex.

Example
REM units in inches
.PolygonCenter -1, -9.5, 6.5, 0.0, -8.5, 2.0, 0.0, 6

{button ,AL(`CAD_PolygonCenter_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.PolygonEdge (CAD)

.PolygonEdge .SaveAsSurface=Boolean, .NumberEdges=integer, .x1=double, .y1=double, .z1=doubl
e, .x2=double, .y2=double, .z2=double

This command creates a polygon based on the edge set by two points.

Syntax Description
.SaveAsSurface Specifies whether the rectangle is saved as a surface or a wire. Set to TRUE (-1) to 

save the rectangle as surface; set to FALSE (0) to save as a wire.
.NumberEdges Specifies the number of sides.
.x1 Specifies the X-coordinate for the first point of the edge in the document's default 

unit of measurement.
.y1 Specifies the Y-coordinate for the first point of the edge in the document's default 

unit of measurement.
.z1 Specifies the Z-coordinate for the first point of the edge in the document's default 

unit of measurement.
.x2 Specifies the X-coordinate for the second point of the edge in the document's 

default unit of measurement.
.y2 Specifies the Y-coordinate for the second point of the edge in the document's 

default unit of measurement.
.z2 Specifies the Z-coordinate for the second point of the edge in the document's 

default unit of measurement.

Note
The center of the polygon is on the right of the first edge.
This command corresponds to the 2 Points command on the Polygon flyout of the Draw menu. Click Draw, 

Polygon, 2 Points. 

Example
REM units in inches
.PolygonEdge 0, -9.0, 2.0, 0.0, -4.5, -1.0, 0.0, 6

{button ,AL(`CAD_PolygonEdge_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.PolygonalCylinder (CAD)

.PolygonalCylinder .SaveAsSurface=Boolean, .NumberEdges=integer, .x1=double, .y1=double, .z1=
double, .x2=double, .y2=double, .z2=double, .x3=double, .y3=double, .z3=double

This command creates a polygonal cylinder.

Syntax Description
.SaveAsSurface Specifies whether the cylinder is saved as a solid or a surface. Set to TRUE 

(-1) to save the rectangle as cylinder; set to FALSE (0) to save as a surface.
.NumberEdges Specifies the number of sides.
.x1 Specifies the X-coordinate for the center of the base in the document's default unit

of measurement.
.y1 Specifies the Y-coordinate for the center of the base in the document's default unit

of measurement.
.z1 Specifies the Z-coordinate for the center of the base in the document's default unit

of measurement.
.x2 Specifies the X-coordinate for the point on the vertex in the document's default 

unit of measurement.
.y2 Specifies the Y-coordinate for the point on the vertex in the document's default 

unit of measurement.
.z2 Specifies the Z-coordinate for the point on the vertex in the document's default 

unit of measurement.
.x3 Specifies the X-coordinate for the height in the document's default unit of 

measurement.
.y3 Specifies the Y-coordinate for the height in the document's default unit of 

measurement.
.z3 Specifies the Z-coordinate for the height in the document's default unit of 

measurement.

Example
REM units in inches
.PolygonalCylinder -1, 18, -6.5, -0.5, 0.0, -5.0, 0.0, 0.0, -6.5, 4.0, 0.0

{button ,AL(`CAD_PolygonalCylinder_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.PolygonalFrustum (CAD)

.PolygonalFrustum .SaveAsSurface=Boolean, .NumberEdges=integer, .x1=double, .y1=double, .z1=
double, .x2=double, .y2=double, .z2=double, .x3=double, .y3=double, .z3=double, .x4=double, .y4=
double, z4=double

This command creates a polygonal frustum.

Syntax Description
.SaveAsSurface Specifies whether the frustum is saved as a solid or a surface. Set to TRUE (-1) to 

save the frustum as solid; set to FALSE (0) to save as a surface.
.NumberEdges Specifies the number of sides.
.x1 Specifies the X-coordinate for the center of the base in the document's default unit

of measurement.
.y1 Specifies the Y-coordinate for the center of the base in the document's default unit

of measurement.
.z1 Specifies the Z-coordinate for the center of the base in the document's default unit

of measurement.
.x2 Specifies the X-coordinate for the point on the vertex in the document's default 

unit of measurement.
.y2 Specifies the Y-coordinate for the point on the vertex in the document's default 

unit of measurement.
.z2 Specifies the Z-coordinate for the point on the vertex in the document's default 

unit of measurement.
.x3 Specifies the X-coordinate for the height in the document's default unit of 

measurement.
.y3 Specifies the Y-coordinate for the height in the document's default unit of 

measurement.
.z3 Specifies the Z-coordinate for the height in the document's default unit of 

measurement.
.x4 Specifies the X-coordinate for the scale of the top in the document's default unit of

measurement.
.y4 Specifies the Y-coordinate for the scale of the top in the document's default unit of 

measurement.
.z4 Specifies the Z-coordinate for the scale of the top in the document's default unit of

measurement. 

Example
REM units in inches
.PolygonalFrustum -1, 16, -6.0, 1.0, 0.0, -3.5, -0.5, 0.0, -3.5, 4.5, 0.0, -3.0, 4.5, 0.0

{button ,AL(`CAD_PolygonalFrustum_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.PolygonalPyramid (CAD)

.PolygonalPyramid .SaveAsSurface=Boolean, .NumberEdges=integer, .x1=double, .y1=double, .z1=
double, .x2=double, .y2=double, .z2=double, .x3=double, .y3=double, .z3=double

This command creates a polygonal pyramid.

Syntax Description
.SaveAsSurface Specifies whether the pyramid is saved as a solid or a surface. Set to TRUE (-1) to 

save the rectangle as solid; set to FALSE (0) to save as a surface.
.NumberEdges Specifies the number of sides.
.x1 Specifies the X-coordinate for the center of the base in the document's default unit

of measurement.
.y1 Specifies the Y-coordinate for the center of the base in the document's default unit

of measurement.
.z1 Specifies the Z-coordinate for the center of the base in the document's default unit

of measurement.
.x2 Specifies the X-coordinate for the point on the vertex in the document's default 

unit of measurement.
.y2 Specifies the Y-coordinate for the point on the vertex in the document's default 

unit of measurement.
.z2 Specifies the Z-coordinate for the point on the vertex in the document's default 

unit of measurement.
.x3 Specifies the X-coordinate for the height in the document's default unit of 

measurement.
.y3 Specifies the Y-coordinate for the height in the document's default unit of 

measurement.
.z3 Specifies the Z-coordinate for the height in the document's default unit of 

measurement.

Example
REM units in inches
.PolygonalPyramid -1, 10, -6.0, -1.5, 0.0, -3.0, -0.5, 0.0, -7.5, 9.0, 0.0

{button ,AL(`CAD_PolygonalPyramid_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.PolyLine (CAD)

.PolyLine 

This command creates a polyline. 

Note
You must precede the .PolyLine command with either .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint or .SetPointXYZ.

Example
REM units in inches
.SetPointXYZ -12.0, 6.0, 0.0
.SetPointXYZ -6.5, 5.5, 0.0
.SetPointXYZ -4.0, -0.5, 0.0
.SetPointXYZ 2.5, -1.5, 0.0
.SetPointXYZ 2.5, -1.5, 0.0
.PolyLine
This example creates a polyline using .SetPointXYZ.

REM units in inches
.StartAddCmdPoint 5
.AddCmdPoint -12.0, 6.0, 0.0
.AddCmdPoint -6.5, 5.5, 0.0
.AddCmdPoint -4.0, -0.5, 0.0
.AddCmdPoint 2.5, -1.5, 0.0
.AddCmdPoint 2.5, -1.5, 0.0
.EndAddCmdPoint
.PolyLine
This example creates a polyline using .StartAddCmdPoint, AddCmdPoint, and .EndAddCmdPoint.

{button ,AL(`CAD_Line_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.Rectangle (CAD)

. 
Rectangle .SaveAsSurface=Boolean,.x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .
z2=double, .x3=double, y3=double, .z3=double

This command draws either a two-point rectangle or a three-point rectangle.

Syntax Description
.SaveAsSurface Specifies whether the rectangle is saved as a surface or a wire. Set to TRUE (-1) to 

save the rectangle as a surface; set to FALSE (0) to save it as a wire.
.x1 Specifies the X-coordinate for the starting point of the rectangle in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the starting point of the rectangle in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the starting point of the rectangle in the document's

default unit of measurement.
.x2 Specifies the X-coordinate for the second point of the rectangle in the document's 

default unit of measurement.
.y2 Specifies the Y-coordinate for the second point (opposite corner for a 2 point 

rectangle, width for a three point rectangle) of the rectangle in the document's 
default unit of measurement.

.z2 Specifies the Z-coordinate for the second point (opposite corner for a 2 point 
rectangle, width for a three point rectangle) of the rectangle in the document's 
default unit of measurement.

.x3 Specifies the X-coordinate for the third point (length) of the rectangle in the 
document's default unit of measurement.

.y3 Specifies the Y-coordinate for the third point (length) of the rectangle in the 
document's default unit of measurement.

.z3 Specifies the Z-coordinate for the third point (length) of the rectangle in the 
document's default unit of measurement.

Note
.SaveAsSurface, is optional. If this parameter is not specified, the default (TRUE) is used.
The third point is optional. If you do not specify the third point, a 2 point rectangle is created. If you specify

the third point, a 3 point rectangle is created.

Example
REM units in inches
.Rectangle 0, -12.0, 3.0, 0.0, -5.0, -1.0, 0.0
This example creates a two-point rectangle.

{button ,AL(`CAD_Rectangle_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



RectangularFrustum (CAD)
.RectangularFrustum .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=
double, .z2=double, .x3=double, .y3=double, .z3=double, .x4=double, .y4=double, .z4=double, .x5=
double, .y5=double, .z5=double

This command creates a either a two-point or a three-point rectangular frustum.

Syntax Description
.SaveAsSolid Specifies whether the box is saved as a solid or a surface. Set to TRUE (-1) to save 

the frustum as a solid; set to FALSE (0) to save the frustum as a surface. The 
default setting is TRUE.

.x1 Specifies the X-coordinate for the starting point of the frustum in the document's 
default unit of measurement.

.y1 Specifies the Y-coordinate for the starting point of the frustum in the document's 
default unit of measurement.

.z1 Specifies the Z-coordinate for the starting point of the frustum in the document's 
default unit of measurement.

.x2 Specifies the X-coordinate for the second point (opposite corner for a 2 point 
frustum, width for a three point frustum) in the document's default unit of 
measurement.

.y2 Specifies the Y-coordinate for the second point (opposite corner for a 2 point 
frustum, width for a three point frustum) in the document's default unit of 
measurement.

.z2 Specifies the Z-coordinate for the second point (opposite corner for a 2 point 
frustum, width for a three point frustum) in the document's default unit of 
measurement.

.x3 Specifies the X-coordinate for the third point (height of a 2 point frustum, length of
a 3 point frustum) in the document's default unit of measurement. If you are 
creating a 2 point frustum, the third point must be positioned above or below the 
center of the base.

.y3 Specifies the Y-coordinate for the third point (height of a 2 point frustum, length of 
a 3 point frustum) in the document's default unit of measurement. If you are 
creating a 2 point frustum, the third point must be positioned above or below the 
center of the base.

.z3 Specifies the Z-coordinate for the third point (height of a 2 point frustum, length of
a 3 point frustum) in the document's default unit of measurement. If you are 
creating a 2 point frustum, the third point must be positioned above or below the 
center of the base.

.x4 Specifies the X-coordinate for the fourth point (width of the second plane of a 2 
point frustum, height of a 3 point frustum) in the document's default unit of    
measurement.

.y4 Specifies the Y-coordinate for the fourth point (width of the second plane of a 2 
point frustum, height of a 3 point frustum) in the document's default unit of 
measurement.

.z4 Specifies the Z-coordinate for the fourth point (width of the second plane of a 2 
point frustum, height of a 3 point frustum) in the document's default unit of 
measurement.

.x5 Specifies the X-coordinate for the fifth point, which determines the width of the 
second plane for a 3 point frustum in the document's default unit of measurement.

.y5 Specifies the Y-coordinate for the fifth point, which determines the width of the 
second plane for a 3 point frustum in the document's default unit of measurement.

.z5 Specifies the Z-coordinate for the fifth point, which determines the width of the 
second plane for a 3 point frustum in the document's default unit of measurement.

Note
The fifth point is optional. If only four points are specified, a 2 point frustum is created. If all five points are 

specified, a 3 point frustum is created.



If you are creating a 2 point frustum, the fourth point must be positioned above or below the center of the 
base.

.SaveAsSolid is optional. If not specified, the default setting (TRUE) is used.

Example
REM units in inches
.RectangularFrustum -1, -5.0, -9.0, 5.5, 0.5, -9.0, 5.5, 0.0, -5.0, 5.5, 0.0, -5.0, 13.0, -2.0,
-6.5, 13.0
This example creates a 3-point rectangular frustum.

{button ,AL(`CAD_RectangularFrustum_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



RectangularPyramid (CAD)
.RectangularPyramid .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=
double, .z2=double, .x3=double, .y3=double, .z3=double, .x4=double, .y4=double, .z4=double

This command creates a two-point or three-point pyramid with four sides.

Syntax Description
.SaveAsSolid Specifies whether the box is saved as a solid or a surface. Set to TRUE (-1) to save 

the pyramid as a solid; set to FALSE (0) to save the pyramid as a surface. The 
default setting is TRUE.

.x1 Specifies the X-coordinate for the starting point of the pyramid in the document's 
default unit of measurement.

.y1 Specifies the Y-coordinate for the starting point of the pyramid in the document's 
default unit of measurement.

.z1 Specifies the Z-coordinate for the starting point of the pyramid in the document's 
default unit of measurement.

.x2 Specifies the X-coordinate for the second point (opposite corner for a 2 point 
pyramid, width for a three point pyramid) in the document's default unit of 
measurement.

.y2 Specifies the Y-coordinate for the second point (opposite corner for a 2 point 
pyramid, width for a three point pyramid) in the document's default unit of 
measurement.

.z2 Specifies the Z-coordinate for the second point (opposite corner for a 2 point 
pyramid, width for a three point pyramid) in the document's default unit of 
measurement.

.x3 Specifies the X-coordinate for the third point (height of a 2 point pyramid, length of
a 3 point pyramid) in the document's default unit of measurement. If you are 
creating a 2 point pyramid, the third point must be positioned above or below the 
center of the base.

.y3 Specifies the Y-coordinate for the third point (height of a 2 point pyramid, length of
a 3 point pyramid) in the document's default unit of measurement. If you are 
creating a 2 point pyramid, the third point must be positioned above or below the 
center of the base.

.z3 Specifies the Z-coordinate for the third point (height of a 2 point pyramid, length 
of a 3 point pyramid) in the document's default unit of measurement. If you are 
creating a 2 point pyramid, the third point must be positioned above or below the 
center of the base.

.x4 Specifies the X-coordinate for the fourth point (height of a 3 point pyramid) in the 
document's default unit of measurement.

.y4 Specifies the Y-coordinate for the fourth point (height of a 3 point pyramid) in the 
document's default unit of measurement.

.z4 Specifies the Z-coordinate for the fourth point (height of a 3 point pyramid) in the 
document's default unit of measurement.

Note
The fourth point is optional. If only 3 points are specified, a 2 point pyramid is created. If all four points are 

specified, a 3 point pyramid is created.
If you are creating a 2 point pyramid, the third point must be positioned above or below the center of the 

base.
.SaveAsSolid is optional. If not specified, the default setting (TRUE) is used.

Example
REM units in inches
.RectangularPyramid -1, -7.5, -4.0, 0.0, -2.0, -1.0, 0.0, -2.0, -1.0, 9.5
This example creates a 2 point rectangular pyramid.

{button ,AL(`CAD_RectangularPyramid_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics





.Redo (CAD)

.Redo 

This command restores changes reversed by the .Undo command.

Note
This command corresponds to the Redo command on the Edit menu. Click Edit, Redo.

Example
.Redo

{button ,AL(`CAD_Redo_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.Rotate (CAD)

.Rotate .LeaveOriginal=Boolean, .angle=double, .x1=double, .y1=double, .z1=double, .x2=double, .y2
=double, .z2=double

This command rotates the selected object through the specified angle along the axis determined by one two 
points.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is rotated. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.angle Specifies the angle of the rotation in degrees.

.x1 Specifies the X-coordinate for the first point in the document's default unit of 
measurement.

.y1 Specifies the Y-coordinate for the first point in the document's default unit of 
measurement.

.z1 Specifies the Z-coordinate for the first point in the document's default unit of 
measurement.

.x2 Specifies the X-coordinate for the second point in the document's default unit of 
measurement. This point is optional. If not specified, the rotation of the object is 
determined by one point.

.y2 Specifies the Y-coordinate for the second point in the document's default unit of 
measurement. This point is optional. If not specified, the rotation of the object is 
determined by one point.

.z2 Specifies the Z-coordinate for the second point the in document's default unit of 
measurement. This point is optional. If not specified, the rotation of the object is 
determined by one point.

Note
An object must be selected before using this command.
This command corresponds to the Rotate command on the Transform menu. Click Transform, Rotate.

Example
REM units in inches
.RectangularPyramid -1, -7.5, -4.0, 0.0, -2.0, -1.0, 0.0, -2.0, -1.0, 9.5
.Rotate -1, 90, 0.0, 0.0, 0.0
This example rotates the pyramid 90 degrees along the axis determined by one point.

REM units in inches
.RectangularPyramid -1, -7.5, -4.0, 0.0, -2.0, -1.0, 0.0, -2.0, -1.0, 9.5
.Rotate -1, 180, -1.5, -6.0, 0.0, -10.5, -2.5, 0.0
This example rotates the pyramid 180 degrees along an axis determined by two points.

{button ,AL(`CAD_Rotate_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.RotateNormal (CAD)

.RotateNormal .LeaveOriginal=Boolean, .angle=double, .x1=double, .y1=double, .z1=double, .x2=d
ouble, .y2=double, .z2=double, .x3=double, .y3=double, .z3=double, .x4=double, .y4=double, .z4=d
ouble

This command rotates the selected object through the specified angle along the axis defined by a normal to a 
plane.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is rotated. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.angle Specifies the angle of the rotation in degrees.

.x1 Specifies the X-coordinate for the first point that defines the plane in the 
document's default unit of measurement.

.y1 Specifies the Y-coordinate for the first point that defines the plane in the 
document's default unit of measurement.

.z1 Specifies the Z-coordinate for the first point that defines the plane in the 
document's default unit of measurement.

.x2 Specifies the X-coordinate for the second point that defines the plane in the 
document's default unit of measurement.

.y2 Specifies the Y-coordinate for the second point that defines the plane in the 
document's default unit of measurement.

.z2 Specifies the Z-coordinate for the second point that defines the plane the in 
document's default unit of measurement.

.x3 Specifies the X-coordinate for the    third point that defines the plane in the 
document's default unit of measurement.

.y3 Specifies the Y-coordinate for the    third point that defines the plane in the 
document's default unit of measurement.

.z3 Specifies the Z-coordinate for the third point that defines the plane in the 
document's default unit of measurement.

.x4 Specifies the X-coordinate for the fourth point that defines the location of the axis 
in the document's default unit of measurement.

.y4 Specifies the Y-coordinate for the fourth point that defines the location of the axis 
in the document's default unit of measurement.

.z4 Specifies the Z-coordinate for the fourth point that defines the location of the axis 
the in document's default unit of measurement.

Note
An object must be selected before using this command.
This command corresponds to the Rotate command on the Transform menu. Click Transform, Rotate.

Example
REM units in inches
.RectangularPyramid -1, -7.5, -4.0, 0.0, -2.0, -1.0, 0.0, -2.0, -1.0, 9.5
.RotateNormal -1, 180, -2.0, -1.0, 0.0, -1.5, 2.5, 0.0, 1.0, 0.0, 0.0, 2.5, -4.0, 0.0
This example creates a rectangular pyramid, and then creates a duplicate of the object. The duplicate is rotated 
180 degrees and placed on the plane specified by the coordinates of the first three points at the location of the 
axis specified by the fourth point.

{button ,AL(`CAD_RotateNormal_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.RotateXAxis (CAD)

.RotateXaxis .LeaveOriginal=Boolean, .angle=double, .x1=double, .y1=double, .z1=double

This command rotates the selected object through the specified angle along the X-axis.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is rotated. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.angle Specifies the angle of the rotation in degrees.

.x1 Specifies the X-coordinate for the point that determines the center of rotation in 
the document's default unit of measurement. This parameter is optional.

.y1 Specifies the Y-coordinate for the point that determines the center of rotation in 
the document's default unit of measurement. This parameter is optional.

.z1 Specifies the Z-coordinate for the point that determines the center of rotation in 
the document's default unit of measurement. This parameter is optional.

Note
An object must be selected before using this command.
The parameters for the coordinates of the point are optional. If you do not specify a point, the object is 

rotated about the X-axis at its current location. If you specify a point, the object is rotated about the X-axis in the 
new location.

This command corresponds to the Rotate command on the Transform menu. Click Transform, Rotate.

Example
REM units in inches
.RectangularPyramid -1, -7.5, -4.0, 0.0, -2.0, -1.0, 0.0, -2.0, -1.0, 9.5
.RotateXAxis -1, 180, -0.5, 3.0, 0.0
This example creates a rectangular pyramid, and then creates a duplicate of the object. The duplicate is rotated 
180 degrees around the X-axis. The center of rotation is determined by the coordinates of one point. If the center
of rotation was not specified, the object would be rotated at its current location.

{button ,AL(`CAD_RotateXAxis_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.RotateYAxis (CAD)

.RotateYAxis .LeaveOriginal=Boolean, .angle=double, .x1=double, .y1=double, .z1=double

This command rotates the selected object through the specified angle along the Y-axis.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is rotated. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.angle Specifies the angle of the rotation in degrees.

.x1 Specifies the X-coordinate for the point that determines the center of rotation in 
the document's default unit of measurement. This parameter is optional.

.y1 Specifies the Y-coordinate for the point that determines the center of rotation in 
the document's default unit of measurement. This parameter is optional.

.z1 Specifies the Z-coordinate for the point that determines the center of rotation in 
the document's default unit of measurement. This parameter is optional.

Note
An object must be selected before using this command.
The parameters for the coordinates of the point are optional. If you do not specify a point, the object is 

rotated about the Y-axis at its current location. If you specify a point, the object is rotated about the Y-axis in the 
new location.

This command corresponds to the Rotate command on the Transform menu. Click Transform, Rotate.

Example
REM units in inches
.RectangularPyramid -1, -7.5, -4.0, 0.0, -2.0, -1.0, 0.0, -2.0, -1.0, 9.5
.RotateYAxis -1, 180, 0.0, -1.0, 0.0
This example creates a rectangular pyramid, and then creates a duplicate of the object. The duplicate is rotated 
180 degrees around the Y-axis. The center of rotation is determined by the coordinates of one point. If the center
of rotation was not specified, the object would be rotated at its current location.

{button ,AL(`CAD_YAxis_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.RotateZAxis (CAD)

.RotateZAxis .LeaveOriginal=Boolean, .angle=double, .x1=double, .y1=double, .z1=double

This command rotates the selected object through the specified angle along the Z-axis.

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is rotated. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.angle Specifies the angle of the rotation in degrees.

.x1 Specifies the X-coordinate for the point that determines the center of rotation in 
the document's default unit of measurement. This parameter is optional.

.y1 Specifies the Y-coordinate for the point that determines the center of rotation in 
the document's default unit of measurement. This parameter is optional.

.z1 Specifies the Z-coordinate for the point that determines the center of rotation in 
the document's default unit of measurement. This parameter is optional.

Note
An object must be selected before using this command.
The parameters for the coordinates of the point are optional. If you do not specify a point, the object is 

rotated about the Z-axis at its current location. If you specify a point, the object is rotated about the Z-axis in the 
new location.

Example
REM units in inches
.RectangularPyramid -1, -7.5, -4.0, 0.0, -2.0, -1.0, 0.0, -2.0, -1.0, 9.5
.RotateZAxis -1, 180, -1.5, 1.0, 0.0
This example creates a rectangular pyramid, and then creates a duplicate of the object. The duplicate is rotated 
180 degrees around the Z-axis. The center of rotation is determined by the coordinates of one point. If the center
of rotation was not specified, the object would be rotated at its current location.

{button ,AL(`CAD_RotateZAxis_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Scale (CAD)

.Scale .LeaveOriginal=Boolean, .Factor=double, .X=double, .Y=double, .Z=double

This command scales the selected object(s).

Syntax Description
.LeaveOriginal Specifies whether a duplicate of the object is created when the object is scaled. 

Set to TRUE (-1) to duplicate the object; set to FALSE (0) to not duplicate the 
object.

.Factor Specifies the scaling factor in the document's default unit of measurement. 

.X Specifies the X-coordinate for the base point in the document's default unit of 
measurement.

.Y Specifies the Y-coordinate for the base point in the document's default unit of 
measurement.

.Z Specifies the Z-coordinate for the base point in the document's default unit of 
measurement.

Note
This command corresponds to the Scale command on the Transform menu. Click Transform, Scale.

Example
REM units in inches
.Torus -1, -9.0, -0.5, 0.0, -7.0, -2.0, 0.0, -8.0, -1.0, 0.0, -7.5, -1.5, 0.0
.Scale -1, 1.5, -8.0, -13.0, 0.0
This example creates a torus, creates a duplicate and then scales it by a factor of 1.5. The duplicate is placed at 
the location specified by the coordinates of one point.

{button ,AL(`CAD_Scale_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.SelectAll (CAD)

.SelectAll 

This command selects all of the objects in the current document.

Note
This command corresponds to the Select All command on the Edit menu. Click Edit, Select All.

Example
REM units in inches
.Torus -1, -9.0, -0.5, 0.0, -7.0, -2.0, 0.0, -8.0, -1.0, 0.0, -7.5, -1.5, 0.0
.Scale -1, 1.5, -8.0, -13.0, 0.0
.SelectAll
This example creates a torus, creates a scaled version of the torus in another location and then selects both 
objects.

{button ,AL(`CAD_SelectAll_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.SelectNext (CAD)

.SelectNext

This command selects the next object in the current document.
Note

The objects are selected in the order they are created; therefore this command selects the object created 
after the currently selected object. 

Example
REM units in inches
.Rectangle 0, -65.5365, 28.402, -6.31773, -58.35, 23.0614, -6.31773
.Sphere -1, -49.9314, 31.7953, -6.31773, -48.1257, 28.334, -6.31773
.Box -1, -53.0743, 21.6508, -6.31773, -45.9882, 17.2436, -10.2424
.SelectPointAt -54.7808, 39.875, -10.2424, 0
.SelectNext
This example creates three objects and then selects the sphere using .SelectPointAt. The .SelectNext 
command selects the box which is the object created after the sphere. To see this command work, you should 
create two scripts. The first script should contain the commands to create the objects and select the sphere. The 
second script should contain only the .SelectNext command. This will demonstrate the order of selection used 
by the .SelectNext command.

{button ,AL(`CAD_SelectNext_Menu;cad_select;;;;',0,"Defaultoverview",)} Related Topics



.SelectObject (CAD)

.SelectObject .Name=string

This command selects all of the objects in the current document with the same name.

Syntax Description
.Name Specifies the name of the objects to select.

Note
You must have named objects before using this command.

Example
REM units in inches
.Torus -1, -9.0, -0.5, 0.0, -7.0, -2.0, 0.0, -8.0, -1.0, 0.0, -7.5, -1.5, 0.0
.ApplyName "Canada"
.RectangularPyramid -1, -7.5, -4.0, 0.0, -2.0, -1.0, 0.0, -2.0, -1.0, 9.5
.ApplyName "Canada"
.SelectObject "Canada"
This example creates a torus and a pyramid and applies the same name to both. All objects with the name 
"Torusname" are selected.

{button ,AL(`CAD_SelectObject_Menu;cad_name;;;;',0,"Defaultoverview",)} Related Topics



.SelectPointAt (CAD)
Command:
.SelectPointAt .X=double, .Y=double, .Z=double, Flag=integer

Function:
ReturnValue =.SelectPointAt .X=double, .Y=double, .Z=double, Flag=integer

This command selects the object at the specified point.

Syntax Description
ReturnValue .SelectPointAt can also be used as a function. This parameter specifies the 

variable that is passed the return value corresponding to whether the command 
has selected a point. It is passed TRUE (-1) if a point has been selected; otherwise 
FALSE (0). This variable must be declared using a DIM statement.

.X Specifies the X-coordinate for the selected point in the document's default unit of 
measurement.

.Y Specifies the Y-coordinate for the selected point in the document's default unit of 
measurement.

.Z Specifies the Z-coordinate for the selected point in the document's default unit of 
measurement.

.Flag Specifies whether 1 or more points is to be selected. Set <=0 to do a single 
selection (any previous selection is canceled). Set >0 to do a multiple selection 
(previous selections are still selected).

Example
REM units in inches
.SetPointXYZ -14.0, 5.5, 0.0
.SetPointXYZ -8.0, 4.5, 0.0
.SetPointXYZ -9.0, -1.5, 0.0
.SetPointXYZ -1.5, 1.0, 0.0
.SetPointXYZ -1.5, -3.0, 0.0
.LineSegment
.SelectPointAt -8.0, 4.5, 0.0. 0
TThis example creates a line segment and then selects it by selecting a point on the line segment. To see how 
the .SelectPointAt command works, you should create two scripts. The first script should create the line 
segment. Ensure that after you have created the line segment, it is deselected. Then create a second script that 
selects a point on the line segment. 

REM units in inches
.SetPointXYZ -14.0, 5.5, 0.0
.SetPointXYZ -8.0, 4.5, 0.0
.SetPointXYZ -9.0, -1.5, 0.0
.SetPointXYZ -1.5, 1.0, 0.0
.SetPointXYZ -1.5, -3.0, 0.0
.LineSegment
ReturnValue=.SelectPointAt -8.0, 4.5, 0.0. 0
This example demonstrates .SelectPointAt being used as a function.

{button ,AL(`CAD_SelectPointAt_Menu;cad_select;;;;',0,"Defaultoverview",)} Related Topics



.SelectPrevious (CAD)

.SelectPrevious

This command selects the previous object in the current document.
Note

The objects are selected in the order they are created. 

Example
REM units in inches
.Torus -1, -9.0, -0.5, 0.0, -7.0, -2.0, 0.0, -8.0, -1.0, 0.0, -7.5, -1.5, 0.0
.Box -1, -14.5, 4.0, -1.5, -13.5, 3.0, -2.5
.Box -1, -15.0, -5.5, -10.0, 7.5, -5.5, -11.0, 4.0, -5.5, -11.0, 4.0, -10.0
.SelectPrevious
This example creates a torus and two boxes and selects the first box. 

{button ,AL(`CAD_SelectPrevious_Menu;cad_select;;;;',0,"Defaultoverview",)} Related Topics



.SelectWithinRegion (CAD)
Command:
.SelectWithinRegion .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

Function:
ReturnValue 
=.SelectWithinRegion .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command selects all objects within the specified region.

Syntax Description
ReturnValue .SelectWithinRegion can also be used as a function. This parameter specifies 

the variable that is passed the return value corresponding to whether the 
command has selected an object. It is passed TRUE (-1) if objects have been 
selected; otherwise FALSE (0). This variable must be declared using a DIM 
statement.

.x1 Specifies the X-coordinate for the first point (starting corner) of the region in the 
document's default unit of measurement.

.y1 Specifies the Y-coordinate for the first point (starting corner) of the region in the 
document's default unit of measurement.

.z1 Specifies the Z-coordinate for the first point (starting corner) of the region in the 
document's default unit of measurement.

.x2 Specifies the X-coordinate for the second point (opposite corner) of the region in 
the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the second point (opposite corner) of the region in 
the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the second point (opposite corner) of the region in 
the document's default unit of measurement.

Example
REM units in inches
.Cone -1, -12.5, 4.0, 0.0, -10.5, 4.5, 0.0, -12.5, 9.0, 0.0
.Box -1, -14.0, 0.5, 0.0, -10.0, -2.0, -4.0
.SelectWithinRegion -19.0, 11.5, -4.0, -8.0, -2.0, -4.0
This example creates a cone and a box and then selects both by determining a region specified by the 
coordinates of two points. 

REM units in inches
.Cone -1, -12.5, 4.0, 0.0, -10.5, 4.5, 0.0, -12.5, 9.0, 0.0
.Box -1, -14.0, 0.5, 0.0, -10.0, -2.0, -4.0
ReturnValue = .SelectWithinRegion -19.0, 11.5, -4.0, -8.0, -2.0, -4.0
This example demonstrates .SelectWithinRegion being used as a function.

{button ,AL(`CAD_SelectWithinRegion_Menu;cad_select;;;;',0,"Defaultoverview",)} Related Topics



.SetCurrentLayer (CAD)

.SetCurrentLayer .LayerName=string, .GroupName=string

This command sets the current layer and layer group.

Syntax Description
.LayerName Specifies the name of the layer. 
.GroupName Specifies the name of the layer group. The default layer group is "All Layers".

Note
.GroupName is an optional parameter. 
If .LayerName refers to a non-existing layer and .GroupName refer to non-existing group, nothing 

occurs.
This command corresponds to the Set Current Layer and Set Current Group commands on the Layers flyout

of the Tools menu.

Example
.NewLayer "mylayer", , -1, 0, 0, 0, 0, 0, 1, "second layer"
.NewLayer "my2layer", , -1, 0, 0, 0, 0, 0, 1, "third layer"
.SetCurrentLayer "mylayer"
This example creates two new layers and sets the current layer to "mylayer" and sets the layer group to "All 
Layers".

{button ,AL(`CAD_NewLayerGroup_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related Topics



.SetEdgeRefinement (CAD)

.SetEdgeRefinement .nView=integer, .nValue=integer

This command sets the edge refinement for a specified view.

Syntax Description
.nView Specifies view type. 

0 rendered 
1 hidden line 
2 model

.nValue Specifies edge refinement. The values are 0 to 10. Smaller values cause coarser 
edge refinement.

Note
This command corresponds to the Refinements command on the View menu. Click View, Refinements.

Example
.SetEdgeRefinement 0, 8

{button ,AL(`CAD_SetEdgeRefinement_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related 
Topics



.SetLightOff (CAD)

.SetLightOff .LightNo=integer

This command turns off the specified light.

Syntax Description
.LightNo Specifies the light to be turned off. The lights are numbered 0 to 7.

Note
This command corresponds to the Shade command on the View menu. Click View, Shade, Lights.

Example
.SetLightOff 3

{button ,AL(`CAD_SetLightOff_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.SetLightOn (CAD)

.SetLightOn .LightNo=integer, .Intensity=double, .HorizontalAngle=double, .VerticalAngle=double, .
Red=integer, .Green=integer, .Blue=integer

This command turns the specified light on and determines the intensity, the horizontal and vertical angles, and 
color of the light. You can only turn one light on each time you use the command. If you want to turn another 
light on, use .SetLightOn again. 

Syntax Description
.LightNo Specifies the location of the light source. The lights are numbered 0 to 7.
.Intensity Specifies the intensity of the light source. The values are 0 to 10.
.HorizontalAngle Specifies the horizontal angle of the light source relative to the object. The values 

are -180 to 180.
.VerticalAngle Specifies the vertical angle of the light source relative to the object. The values 

are -90 to 90.
.Red Specifies the red setting for light color (RGB color model). Valid values range from 

0 to 255. This parameter works in conjunction with .Green and .Blue to 
determine the color of the light. 

.Green Specifies the green setting for light color (RGB color model). Valid values range 
from 0 to 255. This parameter works in conjunction with .Red and .Blue to 
determine the color of the light. 

.Blue Specifies the blue setting for light color (RGB color model). Valid values range from
0 to 255. This parameter works in conjunction with .Red and .Green to determine
the color of the light. 

Note
This command corresponds to the Shade command on the View menu. Click View, Shade, Lights.

Example
.SetLightOn 3, 25.0, -70, -45. 255, 0, 255

{button ,AL(`CAD_SetLightOn_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.SetPointXYZ (CAD)

.SetPointXYZ .X=double, .Y=double, .Z=double

This command sets a point at the specified X, Y, and Z-coordinates.

Syntax Description
.X Specifies the X-coordinate for the point in the document's default unit of 

measurement.
.Y Specifies the Y-coordinate for the point in the document's default unit of 

measurement.
.Z Specifies the Z-coordinate for the point in the document's default unit of 

measurement.

Example
REM units in inches
.SetPointXYZ -12.0, 4.5, 0.0
.SetPointXYZ -2.0, 1.0, 0.0
.SetPointXYZ -0.5, 0.5, 0.0
.ArrowLine 10, 4
This example sets three points and then creates a line with an arrow. 

{button ,AL(`CAD_SetPointXYZ_Menu;cad_point;;;;',0,"Defaultoverview",)} Related Topics



.SetSurfaceRefinement (CAD)

.SetSurfaceRefinement .nView=integer, .nValue=integer

This command sets the surface refinement for a specified view.

Syntax Description
.nView Specifies view type. 

0 rendered 
1 hidden line 
2 model

.nValue Specifies surface refinement. The values are 0 to 10. Smaller values cause coarser
surface refinement.

Note
This command corresponds to the Refinements command on the View menu. Click View, Refinements.

Example
.SetSurfaceRefinement 2, 5

{button ,AL(`CAD_SetSurfaceRefinement_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related 
Topics



.SetUnits (CAD)

.SetUnits .Units=integer

This command sets the active document's default unit of measurement and sets the measurement unit used in 
CorelCAD application commands. You should include a .SetUnits command at the beginning of all of your 
CorelCAD scripts. This command ensures that your CorelCAD scripts are executed using the correct unit of 
measurement for those commands that use measurement parameters.

Syntax Description
.Units Specifies the unit of measurement as follows

0 inches
1 millimeters
2 centimeters
3 feet
4 miles
5 meters
6 kilometers

Note:
This command changes only the active document's default unit of measurement settting.
This command cannot be recorded.

Example
.SetUnits 2

{button ,AL(`CAD_SetUnits_Menu;cad_toolsmenu;;;;',0,"Defaultoverview",)} Related Topics



.SetVisible (CAD)

.SetVisible .Visible=Boolean

This command makes the CorelCAD application visible or hidden on your Windows desktop. When CorelCAD is 
hidden, it runs in the Windows background and is not visible on screen. Running as a hidden application can 
make a CorelCAD script run faster since it does not have to redraw a diagram when changes are applied to it.

Syntax Description
.Visible Specifies whether CorelCAD is visible or hidden. Set to TRUE (-1) to show the 

CorelCAD application. Set to FALSE (0) to hide the application.
Note

By clicking CTRL+ALT+DELETE on the Windows desktop, you can find all of the applications Windows is 
running, both visible and hidden.

This command is cannot be recorded.

Example
.SetVisible -1
The above example shows the CorelCAD application.

{button ,AL(`CAD_SetUnits_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.ShadeEntireView (CAD)

.ShadeEntireView .ShowText=Boolean, .ShowDimension=Boolean, .ShadeType=integer, .IsAllViews=
Boolean

This command shades the entire view.

Syntax Description
.ShowText Specifies whether the text is displayed. If set to TRUE (-1), the text is displayed; if 

set to FALSE (0) the text is not displayed.
.ShowDimension Specifies whether dimensions are displayed. If set to TRUE (-1), the dimensions are

displayed; if set to FALSE (0), the dimensions are not displayed.
.ShadeType Specifies the shading type. The values are as follows:

0 Flat Shading
1 Gouraud Shading
2 Phong Shading
3 Preview
4 Full Render
5 Ray-traced preview
6 Ray-traced full render

.IsAllViews Specifies whether all views are shaded. If set to TRUE (-1), all views are shaded; if 
set to FALSE (0), only the active view is shaded.

Note
This command corresponds to the Shade command on the View menu. Click View, Shade.

Example
.ShadeEntireView -1, -1, 1, -1

{button ,AL(`CAD_ShadeEntireView_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.ShadeSectionView (CAD)

.ShadeSectionView .ShowText=Boolean, .ShowDimensions=Boolean, .ShadeType=integer, .x1=doubl
e, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command shades a view determined by the coordinates of two points.

Syntax Description
.ShowText Specifies whether the text is displayed. If set to TRUE (-1), the text is displayed; if 

set to FALSE (0) the text is not displayed.
.ShowDimension Specifies whether dimensions are displayed. If set to TRUE (-1), the dimensions are

displayed; if set to FALSE (0), the dimensions are not displayed.
.ShadeType Specifies the shading type. The values are as follows:

0 Flat Shading
1 Gouraud Shading
2 Phong Shading
3 Preview
4 Full Render
5 Ray-traced preview
6 Ray-traced full render

.x1 Specifies the X-coordinate for the first point (starting corner) of the region in the 
document's default unit of measurement.

.y1 Specifies the Y-coordinate for the first point (starting corner) of the region in the 
document's default unit of measurement.

.z1 Specifies the Z-coordinate for the first point (starting corner) of the region in the 
document's default unit of measurement.

.x2 Specifies the X-coordinate for the second point (opposite corner) of the region in 
the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the second point (opposite corner) of the region in 
the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the second point (opposite corner) of the region in 
the document's default unit of measurement.

Note
This command corresponds to the Shade command on the View menu. Click View, Shade.

Example
.Box -1, -14.0, 7.0, -5.0, -8.5, 5.0, -10.0
.ShadeSectionView -1, -1, 1, -18.0, 13.0, -10.0, -6.0, 4.0, -10.0
This example creates a box and then shades the section that contains the box. Text and dimension lines are 
displayed. The shade type is Flat Shading. The region is specified by the coordinates of two points.

{button ,AL(`CAD_ShadeSectionView_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.ShadeSelected (CAD)

.ShadeSelected .ShowText=Boolean, .ShowDimension=Boolean, .ShadeType=integer

This command shades the currently selected object.

Syntax Description
.ShowText Specifies whether the text is displayed. If set to TRUE (-1), the text is displayed; if 

set to FALSE (0), the text is not displayed.
.ShowDimension Specifies whether dimensions are displayed. If set to TRUE (-1), the dimensions are

displayed; if set to FALSE (0), the dimensions are not displayed.
.ShadeType Specifies the shading type. The values are as follows:

0 Flat Shading
1 Gouraud Shading
2 Phong Shading
3 Preview
4 Full Render
5 Ray-traced preview
6 Ray-traced full render

Note
You must select the object before running this command.

Example
REM units in inches
.Box -1, -14.5, 13.0, -10.0, -10.5, 10.0, -14.5
.ChangeColor 255, 0, 204
.ShadeSelected -1, -1, 4
This example creates a box, changes the color of the box and then shades it. Text and Dimension lines are 
displayed. The shade type is Full Render. 

{button ,AL(`CAD_ShadeSelected_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.Skin (CAD)

.Skin

This command creates a surface between two or more existing lines. 

Note
The lines must be drawn before using the Skin command. 
The points on the lines must be created using .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint and/or .SetPointXYZ.
This command corresponds to the Skin command on the Surfaces flyout of the Draw menu. Click Draw, 

Surfaces, Skin.

Example
REM units in inches
.SetPointXYZ -17.5, 19.0, -11.5
.SetPointXYZ -17.5, 19.0, -22.5
.LineSegment
.SetPointXYZ -16.0, 27.0, -22.5
.SetPointXYZ -16.0, 27.0, -33.0
.LineSegment
.SetPointXYZ -16.0, 43.0, -33.0
.SetPointXYZ -16.0, 43.0, -43.5
.LineSegment
.SelectAll
.Skin
This example creates three line segments, selects all of the lines, and then creates a surface between the lines.

{button ,AL(`CAD_Skin_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.SlicePlane (CAD)

.SlicePlane .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command slices a plane with a line or curve whose two end points intersect with the plane's edge.

Syntax Description
.x1 Specifies the X-coordinate for the point lying on the cutting line in the document's 

default unit of measurement.
.y1 Specifies the Y-coordinate for the point lying on the cutting line in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the point lying on the cutting line in the document's 

default unit of measurement. 
.x2 Specifies the X-coordinate for the point which lies on the plane in the document's 

unit of measurement.
.y2 Specifies the Y-coordinate for the point which lies on the plane in the document's 

default unit of measurement.
.z2 Specifies the Z-coordinate for the point which lies on the plane in the document's 

default unit measurement.

Note
The plane and the line must already exist before using the .SlicePlane command.
This command corresponds to the Slice Plane command on the Slice flyout of the Transform menu. Click 

Transform, Slice, Slice Plane.

Example
REM units in inches
.SetPointXYZ -24.5, 30.5, -25.5
.SetPointXYZ -20.0, 27.5, -25.5
.SetPointXYZ -10.5, 26.5, -25.5
.SetPointXYZ -8.0, 33.5, -25.5
.Multiplane -1, -1
.SetPointXYZ -16.5, 32.0, -25.5
.SetPointXYZ -21.5, 21.0, -25.5
.LineSegment
.SlicePlane -19.62, 25.635, -25.5, -17.635, 28.264, -25.5
This example creates a multiplane and a line segment. The multiplane is then sliced with the line segment.

{button ,AL(`CAD_SlicePlane_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.SolidAdd (CAD)

.SolidAdd 

This command adds solid objects to other solid objects to create a new object. 

Note
You must precede this command with either .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint or .SetPointXYZ to select the objects.
This command corresponds to the Add command on the Boolean flyout of the Transform menu. Click 

Transform, Boolean, Add.

Example
REM units in inches
.Box -1, 115.0, 43.8, -42.5, -94.6, 21.1, -72.5
.Box -1, -112.0, 81.3, -72.5, -83.0, 48.3, -99.7
.SetPointXYZ -104.8, 43.8, -42.6
.SetPointXYZ -112.0, 81.3, -72.5
.SolidAdd
This example creates two boxes.Both boxes are then selected. To select both boxes, the first box is selected 
using .SetPointXYZ. The last box is already selected because it has just been created. The first box is then 
added to the second box to create a new object.

{button ,AL(`CAD_SolidAdd_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.SolidDefine (CAD)

.SolidDefine 

This command creates a solid object from the selected objects.

Note
You must have objects selected before using this command.
This command corresponds to the Define Object command on the Transform menu. Click Transform, Define

Object.

Example
REM units in inches
.Rectangle 0, 128.9, 91.6, -72.5, -69.8, 54.2, -72.5
.Rectangle 0, -95.9, 105.4, -72.5, -39.7, 41.5, -72.5
.SelectWithinRegion -171.6, 126.8, -72.5, 23.3, 32.0, -72.5
.SolidDefine
This example creates two rectangles.Both rectangles are then selected using .SelectWithinRegion. Then the 
objects are combined to create a new solid object

{button ,AL(`CAD_SolidDefine_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.SolidExplode (CAD)

.SolidExplode 

This command breaks the selected object into its component parts (planes, surface meshes, and lines).

Note
You must have objects selected before using this command.
This command corresponds to the Explode Object command on the Transform menu. Click Transform, 

Explode Object.

Example
REM units in inches
.Box -1, -151.4, 95.9, -72.5, -108.9, 63.8, -105.0
.SolidExplode
This example creates a box and then breaks the box into its component parts.

{button ,AL(`CAD_SolidExplode_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.SolidIntersect (CAD)

.SolidIntersect 

This command creates a new solid object from the overlapped section of existing solid objects. 

Note
You must precede this command with either .StartAddCmdPoint, .AddCmdPoint, and

.EndAddCmdPoint or .SetPointXYZ to select the objects.
This command corresponds to the Intersect command on the Boolean flyout of the Transform menu.

Example
REM units in inches
.Box -1, -156.6, 3.9, 0.0, -105.3, 40.4, -26.6
.Sphere -1, -156.6, 22.1, -26.6, -153.9, 16.1, -26.6
.SetPointXYZ -130.954, 3.86937, 0.0
.SetPointXYZ -156.6, 22.1127, -26.6011
.SolidIntersect
This example creates a box and a sphere and then selects both. A new object is created from the overlapping 
section of the two objects.

{button ,AL(`CAD_SolidIntersect_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.SolidSubtract (CAD)

.SolidSubtract

This command subtracts objects from the first selected object.

Note
This command corresponds to the Intersect command on the Boolean flyout of the Transform menu. Click 

Transform, Boolean, Intersect.
The objects must be selected using either .StartAddCmdPoint, .AddCmdPoint, and .EndAddCmdPoint

or .SetPointXYZ commands to select the objects.

Example
REM units in inches
.Box -1, -214.6, 166.5, -160.6, -176.0, 144.0, -205.3
.Box -1, -214.6, 166.5, -160.6, -191.6, 113.6, -205.5
.SetPointXYZ -191.6, 113.6, -160.6
.SetPointXYZ -176.0, 155.276, -160.6
.SolidSubtract
This example creates two boxes and then selects both. The second box is subtracted from the first.

{button ,AL(`CAD_SolidSubtract_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Sphere (CAD)

.Sphere .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=d
ouble

This command creates a sphere based on coordinates which specify the center and the radius of the sphere.

Syntax Description
.SaveAsSolid Specifies whether the sphere is saved as a solid or a surface. Set to TRUE (-1) to 

save the sphere as a solid; set to FALSE (0) to save the sphere as a surface.
.x1 Specifies the X-coordinate for the center of the sphere in the document's default 

unit of measurement.
.y1 Specifies the Y-coordinate for the center of the sphere in the document's default 

unit of measurement.
.z1 Specifies the Z-coordinate for the center of the sphere in the document's default 

unit of measurement.
.x2 Specifies the X-coordinate for the radius of the sphere in the document's default 

unit of measurement.
.y2 Specifies the Y-coordinate for the radius of the sphere in the document's default 

unit of measurement.
.z2 Specifies the Z-coordinate for the radius of the sphere in the document's default 

unit of measurement.

Note
This command corresponds to the Sphere, Center and Radius command on the Solids flyout of the Draw 

menu. Click Draw, Solids, Sphere, Center and Radius.

Example
REM units in inches
.Sphere -1, -191.3, 168.0, -160.6, -179.4, 151.7, -160.0

{button ,AL(`CAD_Sphere_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.SphereDiameter (CAD)

.SphereDiameter .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=dou
ble, .z2=double

This command creates a sphere based on coordinates that specify the diameter of the sphere.

Syntax Description
.SaveAsSolid Specifies whether the sphere is saved as a solid or a surface. Set to TRUE (-1) to 

save the sphere as a solid; set to FALSE (0) to save the sphere as a surface.
.x1 Specifies the X-coordinate for the first point that determines the diameter in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point that determines the diameter in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point that determines the diameter in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point that determines the diameter in 

the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point that determines the diameter in the

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point that determines the diameter in 

the document's default unit of measurement.

Example
REM units in inches
.SphereDiameter -1, -200.0, 141.6, -160.6, -175.2, 150.0, -160.6

{button ,AL(`CAD_SphereDiameter_Menu;cad_solid;;;;',0,"Defaultoverview",)} Related Topics



.SphericalArray (CAD)

.SphericalArray .CopiesEquator=long, .CopiesPoles=long, . 
Rows=long, .RotateObjects=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z
2=double, .x3=double, .y3=double, .z3=double

This command duplicates the selected object(s) along a sphere. 

Syntax Description
.CopiesEquator Specifies the number of copies of the selected object created at the equator.
.CopiesPoles Specifies the number of copies of the selected object created at the poles (north 

and south).
.Rows Specifies the number of rows.
.RotateObjects Specifies whether the object(s) is rotated. Set to TRUE (-1) to rotate the object; set

to FALSE (0) to not rotate the object. If .RotateObjects is set to TRUE, the 
number of points required is one. The second point is optional. If .RotateObjects 
is set to FALSE, the number of points required is two and the third point is optional.

.x1 If .RotateObjects=TRUE, specifies the X-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.
If .RotateObjects=FALSE, specifies the X-coordinate for the base point in the 
document's default unit of measurement.

.y1 If .RotateObjects=TRUE, specifies the Y-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.
If .RotateObjects=FALSE, specifies the Y-coordinate for the base point in the 
document's default unit of measurement.

.z1 If .RotateObjects=TRUE, specifies the Z-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.
If .RotateObjects=FALSE, specifies the Z-coordinate for the base point in the 
document's default unit of measurement.

.x2 If .RotateObjects=TRUE, specifies the X-coordinate for the point that defines the 
direction of the axis in the document's default unit of measurement. If you do not 
specify the second point, it is assumed to be perpendicular to the current view. For
example, if you are in Top View, the second point is perpendicular to the z axis. 
If .RotateObjects=FALSE, specifies the X-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.

.y2 If .RotateObjects=TRUE, specifies the Y-coordinate for the point that defines the 
direction of the axis in the document's default unit of measurement. If you do not 
specify the second point, it is assumed to be perpendicular to the current view. For
example, if you are in Top View, the second point is perpendicular to the z axis. 
If .RotateObjects=FALSE, specifies the Y-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.

.z2 If .RotateObjects=TRUE, specifies the Z-coordinate for the point that defines the 
direction of the axis in the document's default unit of measurement. If you do not 
specify the second point, it is assumed to be perpendicular to the current view. For
example, if you are in Top View, the second point is perpendicular to the z axis. 
If .RotateObjects=FALSE, specifies the Z-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.

.x3 Specifies the X-coordinate for the point that defines the direction of the axis in the 
document's default unit of measurement.

.y3 Specifies the Y-coordinate for the point that defines the direction of the axis in the 
document's default unit of measurement.

.z3 Specifies the Z-coordinate for the point that defines the direction of the axis in the 
document's default unit of measurement.

Note
You must have drawn an object before using this command.



If .RotateObjects=FALSE and you do not select a base point (.x1, .y1, z2) on the body of the object, the 
object is rotated relative to the base point.

This command corresponds to the Spherical Array command on the Array flyout of the Edit menu. Click 
Edit, Array, Spherical Array.

Example
REM units in inches
.Cylinder -1, 98.2, -0.6, -151.3, --90.3, -0.6, -151.3, -88.9, 53.7, -151.3
.SphericalArray 10, 3, 5, -1, -90.3, -0.6, -151.3, -90.3, 53.7, -151.3
This command creates a cylinder and then duplicates the cylinder along a sphere. Ten copies of the object are 
placed in the middle of the sphere (equator). Three copies of the object are placed at the top and bottom (poles) 
of the sphere. .RotateObjects is set to TRUE; however the second optional point is used. The first point 
determines the center of the axis of rotation and the second point determines the direction of the axis.

{button ,AL(`CAD_SphericalArray_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.SpiralArray (CAD)

.SpiralArray .Copies=long, .Revolutions=double, .Offset=Boolean, .RotateObjects=Boolean, .x1=doubl
e, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double, .x3=double, .y3=double, .z3=double

This command duplicates the selected object(s) along the path of a spiral.

Syntax Description
.Copies Specifies the number of copies.
.Revolutions Specifies the number of revolutions. The revolutions are the number of times the 

copies of the object revolve around the axis.
.Offset Specifies the amount each copy of the object is offset. The value entered will be 

the measurement of the entire array. If .Offset is not specified, this parameter is 
not used and the objects are not offset in the spiral array.

.RotateObjects Specifies whether the object(s) is rotated. Set to TRUE (-1) to rotate the object; set
to FALSE (0) to not rotate the object. If .RotateObjects is set to TRUE, the 
number of points required is one. The second point is optional. If .RotateObjects 
is set to FALSE, the number of points required is two and the third point is optional.

.x1 If .RotateObjects=TRUE, specifies the X-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.
If .RotateObjects=FALSE, specifies the X-coordinate for the base point in the 
document's default unit of measurement.

.y1 If .RotateObjects=TRUE, specifies the Y-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.
If .RotateObjects=FALSE, specifies the Y-coordinate for the base point in the 
document's default unit of measurement.

.z1 If .RotateObjects=TRUE, specifies the Z-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.
If .RotateObjects=FALSE, specifies the Z-coordinate for the base point in the 
document's default unit of measurement.

.x2 If .RotateObjects=TRUE, specifies the X-coordinate for the point that defines the 
direction of the axis in the document's default unit of measurement. If you do not 
specify the second point, it is assumed to be perpendicular to the current view. For
example, if you are in Top View, the second point is perpendicular to the z axis. 
If .RotateObjects=FALSE, specifies the X-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.

.y2 If .RotateObjects=TRUE, specifies the Y-coordinate for the point that defines the 
direction of the axis in the document's default unit of measurement. If you do not 
specify the second point, it is assumed to be perpendicular to the current view. For
example, if you are in Top View, the second point is perpendicular to the z axis. 
If .RotateObjects=FALSE, specifies the Y-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.

.z2 If .RotateObjects=TRUE, specifies the Z-coordinate for the point that defines the 
direction of the axis in the document's default unit of measurement. If you do not 
specify the second point, it is assumed to be perpendicular to the current view. For
example, if you are in Top View, the second point is perpendicular to the z axis. 
If .RotateObjects=FALSE, specifies the Z-coordinate for the point that is the 
center of the axis of rotation in the document's default unit of measurement.

.x3 Specifies the X-coordinate for the point that defines the direction of the axis in the 
document's default unit of measurement.

.y3 Specifies the Y-coordinate for the point that defines the direction of the axis in the 
document's default unit of measurement.

.z3 Specifies the Z-coordinate for the point that defines the direction of the axis in the 
document's default unit of measurement.

Note



You must have drawn an object before using this command.
If .RotateObjects=FALSE and you do not select a base point (.x1, .y1, z1) on the body of the object, the 

object is rotated relative to the base point.
This command corresponds to the Spiral Array command on the Array flyout of the Edit menu. Click Edit, 

Array, Spiral Array.

Example
REM units in inches
.Sphere -1, -103.8, 1.4, 0.0, -97.9, -2.0, 0.0
.SpiralArray 20, 5, 1, -1, -62.9, -13.0, 0.0, -64.2, 26.8, 0.0
This command creates a sphere and then places twenty copies of the sphere along a the path of a spiral. The 
copies of the sphere are offset by 5 inches. .RotateObjects is set to TRUE; however the second optional point is
used. The first point determines the center of the axis of rotation and the second point determines the direction 
of the axis.

{button ,AL(`CAD_SpiralArray_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.StartAddCmdPoint (CAD)

.StartAddCmdPoint .pointNumber=integer

This commands sets the number of command points to be added. The .StartAddCmdPoint command is 
followed by .AddCmdPoint and .EndAddCmdPoint commands.

Syntax Description
.pointNumber Specifies the number of command points.

Note
The .AddCmdPoint command is repeated according to the number specified by the .pointNumber 

parameter.

Example
REM units in inches
.StartAddCmdPoint 3
.AddCmdPoint 20.0, 0.0, 0.0
.AddCmdPoint 25.0, 10.0, 0.0
.AddCmdPoint 40.0, 10.0, 0.0
.EndAddCmdPoint
.PolyLine
This example adds 4 command points and creates a polyline.

{button ,AL(`CAD_StartAddCmdPoint_Menu;cad_point;;;;',0,"Defaultoverview",)} Related Topics



.Stretch2D (CAD)

.Stretch2D .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double, .x3=double, .
y3=double, .z3=double, .x4=double, .y4=double, .z4=double

This command performs a 2D stretch on an object.

Syntax Description
.x1 Specifies the X-coordinate for the first point that determines the bounding box in 

the document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point that determines the bounding box in 

the document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point that determines the bounding box in 

the document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point that determines the bounding box 

in the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point that determines the bounding box 

in the document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point that determines the bounding box 

in the document's default unit of measurement.
.x3 Specifies the X-coordinate for the first point that determines the displacement in 

the document's default unit of measurement.
.y3 Specifies the Y-coordinate for the first point that determines the displacement in 

the document's default unit of measurement.
.z3 Specifies the Z-coordinate for the first point that determines the displacement in 

the document's default unit of measurement.
.x4 Specifies the X-coordinate for the second point that determines the displacement 

in the document's default unit of measurement.
.y4 Specifies the Y-coordinate for the second point that determines the displacement 

in the document's default unit of measurement.
.z4 Specifies the Z-coordinate for the second point that determines the displacement 

in the document's default unit of measurement.

Note
An object must be selected before using this command.
This command corresponds to the 2D Stretch command on the Transform menu. Click Transform, 2D 

Stretch. 

Example
REM units in inches
.Rectangle 0.0, -94.1, 9.1, 0.0, -43.6, -18.0
.Stretch2D -43.6, 9.1, 0.0, -43.7, 9.2, 0.0-43.6, 9.1, 0.0, -43.7, -68.7, 0.0
This example creates a box and then stretches it two-dimensionally. 

{button ,AL(`CAD_Stretch2D_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Stretch3D (CAD)

.Stretch3D .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double, .x3=double, .
y3=double, .z3=double, .x4=double, .y4=double, .z4=double, .distance=double

This command stretches an object starting from a plane determined by three points.

Syntax Description
.x1 Specifies the X-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.x3 Specifies the X-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.y3 Specifies the Y-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.z3 Specifies the Z-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.x4 Specifies the X-coordinate for the point that determines which side of the object is 

being stretched in the document's default unit of measurement.
.y4 Specifies the Y-coordinate for the point that determines which side of the object is 

being stretched in the document's default unit of measurement.
.z4 Specifies the Z-coordinate for the point that determines which side of the object is 

being stretched in the document's default unit of measurement.
.distance Specifies the distance the object is being stretched in the document's default unit 

of measurement.

Note
An object must be selected before using this command.
This command corresponds to the 3D Stretch command on the Transform menu. Click Transform, 3D 

Stretch. 

Example
REM units in inches
.Box -1, 126.7, 106.6, -101.9, -93.9, 74.8, -125.4
.Stretch3D -110.3, 106.6, -101.9, -110.3, 74.8, -125.4, -110.3, 74.8, -101.9, -71.4, 74.1, -
101.9, 32.5
This example creates a box and then stretches three-dimensionally.

{button ,AL(`CAD_Stretch3D_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.SpiralSweep (CAD)

.SpiralSweep .Revolutions=double, .Offset=double, .Steps=long, .x1=double, .y1=double, .z1=doubl
e, .x2=double, .y2=double, .z2=double

This command sweeps a 2D object around an axis with an offset creating a 3D object.

Syntax Description
.Revolutions Specifies the number of revolutions. The revolutions are the number of times the 

copies of the object (.steps) revolve around the axis at the specified distance 
apart (.offset).

.Offset Specifies the distance between the copies of the object.

.Steps Specifies the number of copies of the object.

.x1 Specifies the X-coordinate for the first point defining the axis in the document's 
default unit of measurement.

.y1 Specifies the Y-coordinate for the first point defining the axis in the document's 
default unit of measurement.

.z1 Specifies the Z-coordinate for the first point defining the axis in the document's 
default unit of measurement.

.x2 Specifies the X-coordinate for the second point defining the axis in the document's
default unit of measurement.

.y2 Specifies the Y-coordinate for the second point defining the axis in the document's 
default unit of measurement.

.z2 Specifies the Z-coordinate for the second point defining the axis in the document's
default unit of measurement.

Note
An object must be selected before using this command.
The object selected must be a 2D object.
This command corresponds to the Spiral Sweep command on the Extrude flyout of the Draw menu. Click 

Draw, Extrude, Spiral Sweep.

Example
REM units in inches
.Rectangle 0, -117.9, 77.5, -68.3, -79.8, 46.6, -68.3
.SpiralSweep 1, 0.35, 20, -49.6, 44.9, -68.3, -14.0, 66.9, -68.3
This example creates a rectangle, duplicates it and then sweeps the copies around the specified axis. The copies 
are offset by 0.35 inches. The coordinate of the two points define the axis.

{button ,AL(`CAD_SpiralSweep_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.Text2D (CAD)

.Text2D .Text=string, .Font=string, .Size=double, .Justification=integer, .Style=integer, .Angle=doubl
e, .x1=double, .y1=double, .z1=double, x2=double, y2=double, z2=double

This command draws 2D text at the location specified by the coordinates of one point.

Syntax Description
.Text Specifies the text string. 
.Font Specifies the font. The font must be installed on your system. For a list of fonts 

installed on your system, see the font drop-down list box in your CorelCAD 
application.

.Size Specifies the text size in inches.

.Justification Specifies the type of justification to use:
0 right
1 center
2 left

.Style Specifies the style of the text:
0 regular
1 bold
2 italic
3 bold italic
4 underline
5 bold underline
6 italic underline

.Angle Specifies the angle of the text in degrees. This parameter is optional. If you do not 
enter a value for .angle, you must set two points.

.x1 Specifies the X-coordinate for the point, that determines the location of the text in 
the document's default unit of measurement.

.y1 Specifies the Y-coordinate for the point, that determines the location of the text in 
the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the point, that determines the location of the text in 
the document's default unit of measurement.

.x1 Specifies the X-coordinate for the angle of the text in the document's default unit 
of measurement. This parameter is optional and used only if a value is not set for 
the .angle parameter.

.y2 Specifies the Y-coordinate for the angle of the text in the document's default unit 
of measurement. This parameter is optional and used only if a value is not set for 
the .angle parameter.

.z2 Specifies the Z-coordinate for the angle of the text in the document's default unit 
of measurement. This parameter is optional and used only if a value is not set for 
the .angle parameter.

Note
This command corresponds to the Text2D command on the Text menu. Click Text, Text2D.

Example
REM units in inches
.Text2D "yourname" "Arial", 1, 0, 0, 45, -7.0, 0.5, 0.0
REM units in inches
.Text2D "yourname" "Arial", 1,0,4,, 1.0, -3.0, 0.0, 0.0, -3.0, 2.0
The first example demonstrates the command syntax when the .Angle parameter has a value and the second 
example demonstrates the command syntax when the .Angle parameter does not have a value.

{button ,AL(`CAD_Text2D_Menu;cad_textmenu;;;;',0,"Defaultoverview",)} Related Topics



.Text3D (CAD)

.Text3D .Text=string, .Font=string, .Size=double, .Justification=integer, .Style=integer, .Angle=doubl
e, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double, .x3=double, y3=double, 
z3=double

This command draws 3D text at a location specified by the coordinates of one point. 

Syntax Description
.Text Specifies the text string. 
.Font Specifies the font. The font must be installed on your system. For a list of fonts 

installed on your system, see the font drop-down list box in your CorelCAD 
application.

.Size Specifies the text size in inches.

.Justification Specifies the type of justification to use:
0 right
1 center
2 left

.Style Specifies the style of the text:
0 regular
1 bold
2 italic
3 bold italic
4 underline
5 bold underline
6 italic underline

.Angle Specifies the angle of the text in degrees. This parameter is optional. If you do not 
enter a value for .angle, you must set three points.

.x1 Specifies the X-coordinate for the point that determines the location of the text in 
the document's default unit of measurement. 

.y1 Specifies the Y-coordinate for the point that determines the location of the text in 
the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the point that determines the location of the text in 
the document's default unit of measurement. 

.x2 Specifies the X-coordinate for the point that determines the angle of the text in the
document's default unit of measurement. This parameter is optional and used only
if a value is not set for the .angle parameter.

.y2 Specifies the Y-coordinate for the point that determines the angle of the text in the
document's default unit of measurement. This parameter is optional and used only
if a value is not set for the .angle parameter.

.z2 Specifies the Z-coordinate for the point that determines the angle of the text in the
document's default unit of measurement. This parameter is optional and used only
if a value is not set for the .angle parameter.

.x3 Specifies the X-coordinate for the point that determines the orientation of the text 
in the document's default unit of measurement. This parameter is optional and 
used only if a value is not set for the .angle parameter.

.y3 Specifies the Y-coordinate for the point that determines the orientation of the text 
in the document's default unit of measurement. This parameter is optional and 
used only if a value is not set for the .angle parameter.

.z3 Specifies the Z-coordinate for the point that determines the orientation of the text 
in the document's default unit of measurement. This parameter is optional and 
used only if a value is not set for the .angle parameter.

Note
If you use the .Angle parameter and one point, the text is only placed on the XY plane.
This command corresponds to the Text3D command on the Text menu. Click Text, Text3D.

Example
REM units in inches



.Text3D "yourname", "Arial", 1, 0, 4, 90, -1.5, 1.0, 0.0
REM units in inches
.Text3D "yourname", "Arial", 1, 0, 0,, -8.0, 1.5, 0.0, -1.0, 4.0, 0.0, -1.5, 5.5, 0.0
The first example demonstrates the command syntax when the .Angle parameter has a value and the second 
example demonstrates the command syntax when the .Angle parameter does not have a value.

{button ,AL(`CAD_Text3D_Menu;cad_textmenu;;;;',0,"Defaultoverview",)} Related Topics



.TextLeader (CAD)

.TextLeader .Text=string, .Font=string, .Size=double, .Style=integer, .x1=double, .y1=double, .z1=d
ouble, .x2=double, .y2=double, .z2=double, .x3=double, y3=double, z3=double

This command draws 3D text with a leader line. 

Syntax Description
.Text Specifies the text string. 
.Font Specifies the font. The font must be installed on your system. For a list of fonts 

installed on your system, see the font drop-down list box in your CorelCAD 
application.

.Size Specifies the text size in inches.

.Style Specifies the style of the text:
0 regular
1 bold
2 italic
3 bold italic
4 underline
5 bold underline
6 italic underline

.x1 Specifies the X-coordinate for the point that determines the position of the    leader
line's arrow in the document's default unit of measurement. 

.y1 Specifies the Y-coordinate for the point that determines the position of the leader 
line's arrow in the document's default unit of measurement.

.z1 Specifies the Z-coordinate for the point that determines the position of the leader 
line's arrow in the document's default unit of measurement. 

.x2 Specifies the X-coordinate for the point that determines the end of the leader line 
in the document's default unit of measurement.

.y2 Specifies the Y-coordinate for the point that determines the end of the leader line 
in the document's default unit of measurement.

.z2 Specifies the Z-coordinate for the point that determines the end of the leader line 
in the document's default unit of measurement.

.x3 Specifies the X-coordinate for the point that determines the location and 
orientation of the text in the document's default unit of measurement. 

.y3 Specifies the Y-coordinate for the point that determines the location and 
orientation of the text in the document's default unit of measurement. 

.z3 Specifies the Z-coordinate for the point that determines the location and 
orientation of the text in the document's default unit of measurement. 

Note
This command corresponds to the Leader command on the Text menu. Click Text, Leader.

Example
REM units in inches
.TextLeader "yourname", "Arial", 1, 0, -8.0, 1.5, 0.0, -1.0, 4.0, 0.0, -1.5, 5.5, 0.0

{button ,AL(`CAD_Text3D_Menu;cad_textmenu;;;;',0,"Defaultoverview",)} Related Topics



.ThreeDArray (CAD)

.ThreeDArray .DistanceMode=integer, .Copy1=integer, .Copy2=integer, .Copy3=integer, .x1=double
, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double, .x3=double, .y3=double, .z3=double
, .x4=double, .y4=double, .z4=double

This command creates copies of the selected object along three directional paths.

Syntax Description
.DistanceMode Specifies the distance mode. Set to 0 for increment mode; set to 1 for overall 

mode. 
.Copy1 Specifies the number of copies along the first path.
.Copy2 Specifies the number of copies along the second path.
.Copy3 Specifies the number of copies along the third path.
.x1 Specifies the X-coordinate for the point that, with the second, third, and fourth 

points, determines the direction and the distance between copies 
.y1 Specifies the Y-coordinate for the point that, with the second, third, and fourth 

points, determines the direction and the distance between copies
.z1 Specifies the Z-coordinate for the point that, with the second, third, and fourth 

points, determines the direction and the distance between copies
.x2 Specifies the X-coordinate for the second point that, with the first point, 

determines the direction of the first path and the distance between copies.
.y2 Specifies the Y-coordinate for the second point that, with the first point, 

determines the direction of the first path and the distance between copies.
.z2 Specifies the Z-coordinate for the second point that, with the first point, 

determines the direction of the first path and the distance between copies.
.x3 Specifies the X-coordinate for the third point that, with the first point, determines 

the direction of the second path and the distance between copies.
.y3 Specifies the Y-coordinate for the third point that, with the first point, determines 

the direction of the second path and the distance between copies.
.z3 Specifies the Z-coordinate for the third point that, with the first point, determines 

the direction of the second path and the distance between copies.
.x4 Specifies the X-coordinate for the fourth point that, with the first point, determines

the direction of the third path and the distance between copies.
.y4 Specifies the Y-coordinate for the fourth point that, with the first point, determines 

the direction of the third path and the distance between copies.
.z4 Specifies the Z-coordinate for the fourth point that, with the first point, determines

the direction of the third path and the distance between copies.

Note
An object must be selected before using this command.
This command corresponds to the 3 Directional command on the Array flyout of the Edit menu. Click Edit, 

Array, 3 Directional.

Example
REM units in inches
.Box 1.0, 8.5 -34.0, 10.0, 6.0,-40.0, 30.0
.ThreeDArray 1, 2, 2, 2, 23.5, 26.0, -41.0, 28.0, 37.0, -41.0, 36.0, 28.0, -41.0, 30.0, 15.0, -
41.0
This example creates a box, duplicates it and places the copies along three paths. 

{button ,AL(`CAD_ThreeDArray_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.TwoDArray (CAD)

.TwoDArray .DistanceMode=integer, .Copy1=integer, .Copy2=integer, .x1=double, .y1=double, .z1=
double, .x2=double, .y2=double, .z2=double, .x3=double, .y3=double, .z3=double

This command creates copies of the selected object along two directional paths.

Syntax Description
.DistanceMode Specifies the distance mode. Set to 0 for increment mode; set to 1 for overall 

mode. 
.Copy1 Specifies the number of copies along the first path.
.Copy2 Specifies the number of copies along the second path.
.x1 Specifies the X-coordinate for the point that, with the second and third points, 

determines the direction and the distance between copies 
.y1 Specifies the Y-coordinate for the point that, with the second and third points, 

determines the direction and the distance between copies
.z1 Specifies the Z-coordinate for the point that, with the second and third points, 

determines the direction and the distance between copies
.x2 Specifies the X-coordinate for the second point that, with the first point, 

determines the direction of the first path and the distance between copies.
.y2 Specifies the Y-coordinate for the second point that, with the first point, 

determines the direction of the first path and the distance between copies.
.z2 Specifies the Z-coordinate for the second point that, with the first point, 

determines the direction of the first path and the distance between copies.
.x3 Specifies the X-coordinate for the third point that, with the first point, determines 

the direction of the second path and the distance between copies.
.y3 Specifies the Y-coordinate for the third point that, with the first point, determines 

the direction of the second path and the distance between copies.
.z3 Specifies the Z-coordinate for the third point that, with the first point, determines 

the direction of the second path and the distance between copies.

Note
An object must be selected before running this command.
This command corresponds to the 2 Directional command on the Array flyout of the Edit menu. Click Edit, 

Array, 2 Directional.

Example
REM units in inches
.Box 1.0, 8.5 -34.0, 10.0, 6.0,-40.0, 30.0
.TwoDArray 1, 2, 2, 24.0, -40.0, 40.0, 38.5, -41.0, 38.0, 1.5, -41.0
This example creates a box, duplicates it and places the copies along two paths. 

{button ,AL(`CAD_TwoDArray_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.ThreeDSection (CAD)

.ThreeDSection .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double, .x3=dou
ble, .y3=double, .z3=double

This command draws the section of a 3D object at the plane determined by three points. 

Syntax Description
.x1 Specifies the X-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.x3 Specifies the X-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.y3 Specifies the Y-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.z3 Specifies the Z-coordinate for the third point that determines the plane in the 

document's default unit of measurement.

Note
A 3D object has to be selected before using this command.
This command corresponds to the Section command on the Slice flyout of the Transform menu. Click 

Transform, Slice, Section.

Example
REM units in inches
.Box -1, -17.0, 73.5, -46.1, -11.7, 70.4, -50.7
.ThreeDSection -14.4, 73.5, -46.1, -14.4, 70.4, -46.1, -14.4, 70.4, -50.7

{button ,AL(`CAD_ThreeDSection_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.ThreeDSlice (CAD)

.ThreeDSlice .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double, .x3=double,

.y3=double, .z3=double

This command slices a 3D object at the plane determined by 3 points.

Syntax Description
.x1 Specifies the X-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.x3 Specifies the X-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.y3 Specifies the Y-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.z3 Specifies the Z-coordinate for the third point that determines the plane in the 

document's default unit of measurement.

Note
A 3D object has to be selected before using this command.
This command corresponds to the 3D Slice command on the Slice flyout of the Transform menu. Click 

Transform, Slice, 3D Slice.

Example
REM units in inches
.Box -1, -96.1, 10.0, 0.0, -66.4, -17.5, -25.9
.ThreeDSlice -81.3, 10.0, -81.3, -17.5, 0.0, -81.3, -17.5, -25.9

{button ,AL(`CAD_ThreeDSlice_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.ThreeDTrim (CAD)

.ThreeDTrim .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double, .x3=double,

.y3=double, .z3=double, .x4=double, .y4=double, .z4=double

This command trims a 3D object at the plane determined by three points

Syntax Description
.x1 Specifies the X-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first point that determines the plane in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second point that determines the plane in the 

document's default unit of measurement.
.x3 Specifies the X-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.y3 Specifies the Y-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.z3 Specifies the Z-coordinate for the third point that determines the plane in the 

document's default unit of measurement.
.x4 Specifies the X-coordinate for the point that determines the side to be removed in 

the document's default unit of measurement.
.y4 Specifies the Y-coordinate for the point, that determines the side to be removed in 

the document's default unit of measurement.
.z4 Specifies the Z-coordinate for the point that determines the side to be removed in 

the document's default unit of measurement.

Note
A 3D object has to be selected before using this command.
This command corresponds to the 3D Trim command on the Slice flyout of the Transform menu. Click 

Transform, Slice, 3D Trim.

Example
REM units in inches
.Box -1, -111.0, 41.2, -25.9, -73.4, 12.2, -53.7
.ThreeDTrim -92.2, 41.2, -25.9, -92.2, 41.2, -53.7, -73.4, 12.2, -53.7, -73.4, 26.7, -25.9

{button ,AL(`CAD_ThreeDTrim_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Torus (CAD)

.Torus .SaveAsSolid=Boolean, .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=do
uble, .x3=double, .y3=double, .z3=double, .x4=double, .y4=double, .z4=double

This command creates a torus object.

Syntax Description
.SaveAsSolid Specifies whether the torus is saved as a solid or a surface. Set to TRUE (-1) to 

save the torus as a solid; set to FALSE (0) to save the torus as a surface.
.x1 Specifies the X-coordinate for the center of the torus in the document's default 

unit of measurement.
.y1 Specifies the Y-coordinate for the center of the torus in the document's default unit

of measurement.
.z1 Specifies the Z-coordinate for the center of the torus in the document's default 

unit of measurement.
.x2 Specifies the X-coordinate for the center of the torus' tube in the document's 

default unit of measurement.
.y2 Specifies the Y-coordinate for the center of the torus' tube in the document's 

default unit of measurement.
.z2 Specifies the Z-coordinate for the center of the torus' tube in the document's 

default unit of measurement.
.x3 Specifies the X-coordinate for the plane of the torus in the document's default unit 

of measurement.
.y3 Specifies the Y-coordinate for the plane of the torus in the document's default unit 

of measurement.
.z3 Specifies the Z-coordinate for the plane of the torus in the document's default unit 

of measurement.
.x4 Specifies the X-coordinate for the height of the torus' tube in the document's 

default unit of measurement.
.y4 Specifies the Y-coordinate for the height of the torus' tube in the document's 

default unit of measurement.
.z4 Specifies the Z-coordinate for the height of the torus' tube in the document's 

default unit of measurement.

Note
This command corresponds to the Torus, Center and Radius command on the Solids flyout of the Draw 

menu. Click Draw, Solids, Torus, Center and Radius.

Example
REM units in inches
.Torus -1, -82.5, 32.0, -25.9, -58.2, 18.9, -25.9, -75.6, 30.6, -25.9, -62.3, 28.5, -25.9

{button ,AL(`CAD_Torus_Menu;cad_drawmenu;;;;',0,"Defaultoverview",)} Related Topics



.Trim (CAD)

.Trim .bSlice=Boolean, .X=double, .Y=double, .Z=double

This command trims one line from another selected line.

Syntax Description
.bSlice Specifies the trim type. Set to TRUE (-1) to choose slice (Keep Segments on the 

dialog box); set to FALSE (0) to choose TRIM (Remove Segments on the dialog 
box).

.X Specifies the X-coordinate for the point located on the line to be trimmed in the 
document's default unit of measurement.

.Y Specifies the Y-coordinate for the point located on the line to be trimmed in the 
document's default unit of measurement.

.Z Specifies the Z-coordinate for the point located on the line to be trimmed in the 
document's default unit of measurement.

Note
This command corresponds to the Trim command on the Transform menu. Click Transform, Trim.

Example
REM units in inches
.SetPointXYZ -144.311, 150.821, -114.535
.SetPointXYZ -60.0345, 100.522, -114.535
.SetPointXYZ -119.904, 81.3809, -114.535
.LineSegment
.SetPointXYZ -60.0347, 100.522, -114.535
.SetPointXYZ -83.4631, 185.01, -114.535
.LineSegment
.Trim 0, -60.5399, 100.354, -114.535
This example creates two line segments and then trims the second line segment from the first line segment.

{button ,AL(`CAD_Trim_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.TrimBoth (CAD)

.TrimBoth .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command trims two intersecting lines.

Syntax Description
.x1 Specifies the X-coordinate for the point that selects the first line in the document's

default unit of measurement.
.y1 Specifies the Y-coordinate for the point that selects the first line in the document's 

default unit of measurement.
.z1 Specifies the Z-coordinate for the point that selects the first line in the document's

default unit of measurement.
.x2 Specifies the X-coordinate for the point that selects the second line in the 

document's default unit of measurement.
.y2 Specifies the Y-coordinate for the point that selects the second line in the 

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the point that selects the second line in the 

document's default unit of measurement.

Note
This command corresponds to the Trim Both command on the Transform menu. Click Transform, Trim Both.

Example
REM units in inches
.SetPointXYZ -156.394, 154.973, -114.535
.SetPointXYZ -116.512, 125.763, -114.535
.SetPointXYZ -127.596, 64.9594, -114.535
.SetPointXYZ -75.7392, 76.9482, -114.535
.SetPointXYZ -28.5687, 49.116, -114.535
.LineSegment
.SetPointXYZ -138.117, 184.39, -114.535
.SetPointXYZ -98.0945, 156.415, -114.535
.SetPointXYZ -59.3899, 182.809, -114.535
.SetPointXYZ -75.7392, 76.9482, -114.535
.SetPointXYZ -29.9464, 125.64, -114.535
.LineSegment
.TrimBoth -52.9764, 101.244, -114.535, -53.3414, 62.8308, -114.535
This example creates two line segments and then trims them both.

{button ,AL(`CAD_TrimBoth_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.Undo (CAD)

.Undo 

This command cancels the last change and returns the document to its former state.

Note
This command corresponds to the Undo command on the Edit menu. Click Edit, Undo.

Example
.Undo

{button ,AL(`CAD_Undo_Menu;cad_editmenu;;;;',0,"Defaultoverview",)} Related Topics



.Ungroup (CAD)

.Ungroup 

This command breaks up the selected group into its individual objects

Note
A grouped object must be created and selected before using this command.
This command corresponds to the Ungroup command on the Transform menu. Click Transform, Ungroup.

Example
REM units in inches
.Box -1, -138.9, 130.5, -114.5, -118.9, 154.6, -137.8
.Box -1, -119.3, 208.0, -137.8, -87.6, 180.5, -172.0
.Box -1, -118.6, 155.4, -172.0, -92.3, 136.4, -199.2
.SelectWithinRegion -198.4, 260.4, -199.2, -34.8, 143.0, -199.2
.Group
.Ungroup
This examples creates three boxes, groups them and then ungroups them.

{button ,AL(`CAD_Ungroup_Menu;cad_transmenu;;;;',0,"Defaultoverview",)} Related Topics



.WireFrame (CAD)

.WireFrame 

This command changes the view to wireframe.

Note
This command corresponds to the Wireframe button on the Standard toolbar.
To change the view to Hidden, use .HideEntireView, .HideSectionView or .HideSelected. To change 

the view to Shade, use .ShadeEntireView, .ShadeSectionView or .ShadeSelected.

Example
.Wireframe

{button ,AL(`CAD_WireFrame_Menu;cad_viewmenu;;;;',0,"Defaultoverview",)} Related Topics



.ZoomToAll (CAD)

.ZoomToAll 

This command adjusts the view to fit all objects on the screen.

Note
This command corresponds to the Zoom To All Objects tool of the Zoom flyout on the toolbox.

Example
.ZoomToAll

{button ,AL(`CAD_ZoomToAll_Menu;cad_zoom;;;;',0,"Defaultoverview",)} Related Topics



.ZoomToSelected (CAD)

.ZoomToSelected

This command adjusts the view to fit all selected objects on the screen.

Note
This command corresponds to the Zoom To Selected tool of the Zoom flyout on the toolbox.
An object must be selected before using this command.

Example
REM units in inches
.Box -1, -110.508, 24.7329, 0.0, -95.6924, 9.78302, -20.3729
.Box -1, -75.1914, 72.2257, -20.3729, -24.6292, 11.3801, -44.1854
.SelectPointAt -121.157, 68.7571, -44.1854, 0
.ZoomToSelected
This example creates two boxes, selects the first box created (The second is already selected because it has just 
been created.) and then zooms in to the selected boxes.

{button ,AL(`CAD_ZoomToSelected_Menu;cad_zoom;;;;',0,"Defaultoverview",)} Related Topics



.ZoomPrevious (CAD)

.ZoomPrevious

This command zooms to the previous zoom level.

Note
This command corresponds to the Zoom Previous tool of the Zoom flyout on the toolbox.

Example
.ZoomPrevious

{button ,AL(`CAD_ZoomPrevious_Menu;cad_zoom;;;;',0,"Defaultoverview",)} Related Topics



.ZoomIn (CAD)

.ZoomIn .x1=double, .y1=double, .z1=double, .x2=double, .y2=double, .z2=double

This command zooms in to a region determined by two points.

Syntax Description
.x1 Specifies the X-coordinate for the first of two points that define the region in the 

document's default unit of measurement.
.y1 Specifies the Y-coordinate for the first of two points that define the region in the 

document's default unit of measurement.
.z1 Specifies the Z-coordinate for the first of two points that define the region in the 

document's default unit of measurement.
.x2 Specifies the X-coordinate for the second of two points that define the region in 

the document's default unit of measurement.
.y2 Specifies the Y-coordinate for the second of two points that define the region in the

document's default unit of measurement.
.z2 Specifies the Z-coordinate for the second of two points that define the region in 

the document's default unit of measurement.

Note
This command corresponds to the Zoom In tool of the Zoom flyout on the toolbox.

Example
REM units in inches
.Box -1, -110.508, 24.7329, 0.0, -95.6924, 9.78302, -20.3729
.Box -1, -75.1914, 72.2257, -20.3729, -24.6292, 11.3801, -44.1854
.ZoomIn -143.619, 75.7336, -44.1854, -92.0959, 30.6536, -44.1854

{button ,AL(`CAD_ZoomIn_Menu;cad_zoom;;;;',0,"Defaultoverview",)} Related Topics



.ZoomOut (CAD)

.ZoomOut

This command decreases the magnification of the current view by 30%.

Note
This command corresponds to the Zoom Out tool of the Zoom flyout on the toolbox.

Example
.ZoomOut

{button ,AL(`CAD_ZoomOut_Menu;cad_zoom;;;;',0,"Defaultoverview",)} Related Topics



Crystal Blue
Crystal Clear
Crystal Green
Crystal Red
Glass Blocks
Glass Clear
Glass Frosted
Glass Green
Glass Orange
Glass Red
Glass Tinted
Glass Violet
Glass Yellow
Mirror



Ambrite
Amethyst
Diamond
Emerald
Mother of Pearl
Opal
Pearl
Rhine Stone
Ruby
Sapphire
Tiger's eye



Aluminum Anodized
Aluminum Brushed
Aluminum Polished
Brass
Bronze
Bronze Wrought
Chrome
Copper
Copper Wrought
Gold
Gold Wrought
Iron
Iron Cast
Iron Rusty
Silver
Steel
Steel No Skid



Blue Marble
Bricks
Cement Rough
Cement Smooth
Coal
Granite
Gravel
Marble
Pavement
Sand
Slate
Stone



None



Banded Malachite
Checkers
Cherry
Cubes
Fabric
Felt
Insulation
Leather
Rubber
Sky



Bumpy Black
Bumpy Blue
Bumpy Gray
Bumpy Green
Bumpy Orange
Bumpy Red
Bumpy White
Bumpy Yellow
Clear Black
Clear Blue
Clear Gray
Clear Green
Clear Orange
Clear Red
Clear White
Clear Yellow
Matte Black
Matte Blue
Matte Gray
Matte Green
Matte Orange
Matte Red
Matte White
Matte Yellow
Shiny Black
Shiny Blue
Shiny Gray
Shiny Green
Shiny Orange
Shiny Red
Shiny White
Shiny Yellow



Cedar
Dark Grain
Heavy Grain
Lacquered
Light Grain
Low Grain
Mahogany
Oak
Pine
Rosewood




